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About the
Documentation

This manual is part of a set of Fiery EX3535 Color Server™ documentation that
includes the following manuals for users and system administrators:

* The Quick Start Guide summarizes the steps for configuring the Fiery EX3535
Color Server and printing. It also describes how to access the online documentation.

* The User Software Installation Guide describes how to install software from the
User Software CD to enable users to print to the Fiery EX3535 Color Server, and
also describes setting up printing connections to the Fiery EX3535 Color Server.

* The Configuration Guide explains basic configuration and administration of the
Fiery EX3535 Color Server for the supported platforms and network environments.
It also includes guidelines for setting up UNIX, Windows N'T 4.0/2000, and Novell

NetWare servers to provide printingservices to users.

* The Printing Guide describes the ptinting features of the Fiery EX3535 Color Server
for users who send jobs fro computers.

information on managing the color output of the
Fiery EX3535 ColorServer. It explains how to calibrate your Fiery EX3535 Color

well as feat orWise Pro Tools™
e The Fi ence addresses concepts and issues associated with managing
color output of the Fiery EX3535 Color Server and outlines key workflow scenarios.

In addition;\it offers information on printing color documents from popular
Microsoft Windows and Apple Mac OS applications.

* The Job Management Guide explains the functions of job management utilities,
including Command WorkStation™, Command WorkStation LE™, and Fiery
DocBuilder Pro™, and how you can use them to monitor and manage jobs on the
Fiery EX3535 Color Server. This manual is intended for an operator, administrator,
or a user with the necessary access privileges, who monitors and manages job flow,
and troubleshoots problems that may arise.

o Customer Release Notes provide last-minute product information and workarounds
for some of the problems you may encounter.
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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void
the user’s authority to operate this equipment.

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the
approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe B de I'Industrie Canada

Cet appareil numérique de la Classe B est conforme a la norme NMB-003 du Can

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI p. tior requirements both individually and on system level (to simulate normal

operation conditions). However, it is possible that these RFI Requirements are n et under certain unfavorable conditions in other installations. It is the user

who is responsible for compliance of his particular installatio

Compliance with applicable regulations depends on the use of5hielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hingt davon ab, dass geschirmte Ausfithrungen beniitzt werden. Fiir die Beschaffung richtiger Ausfithrungen ist der
Betreiber verantwortlich.



Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE.

License

EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with the Product. The Software is
licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend the Software
or use the Software in any time sharing, service bureau, or similar arrangement.

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for backup or archive purposes in
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to localize, translate, disassemble,
decompile, decrypt, reverse engineer, discover the source code of, modify, create derivative works of, or in any way change any part of the Software.

The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates, and upgrades related to the
Software.

Proprietary Rights
You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the Software, Documentation and all
modifications and derivative works thereof are solely owned by and shall remain with EFI and its suppliers. Except for the express limited license granted above
to use the Software, no right or license of any kind is granted. You receive no rights or license ufider any patents, copyrights, trade secrets, or trademarks (whether
registered or unregistered). You agree not to adopt, register, or attempt to register any EFI trddefnark or trade name (“EFI Mark”) or any confusingly similar mark,
URL, internet domain name, or symbol as your own name or the name of your affiliates.or prod
the trademark rights of EFI or its suppliers.

and not to take any other action which impairs or reduces

Confidentiality

The Software is confidential, proprietary information of EFI and you may'nof distribute or disclose the Software. You may, however, permanently transfer all of
your rights under this Agreement to another person or legal entity provided that
including the U.S. Export Administration Regulations, (2) you transfer to the pe
updates, upgrades, prior versions, component parts, the media a
Documentation, including copies stored on a computer; and/(4

1) suck’a transfer is authorized under all applicable export laws and regulations,
n or entity all of the Software and Documentation (including all copies,
d printed materials, and this Agreement); (3) you retain no copies of the Software and

p ent agrees to the terms and conditions of this Agreement.

afy breach of this Agreement will result in automatic termination of this license and will make
ion, you must destroy all copies of the Software, Documentation, and all component parts thereof.

Remedies and Termination
Unauthorized use, copying, or disclosure of the Softwa
available to EFI other legal remedies. In the event of term
All provisions of this Agreement relating to disclaimers of wa
proprietary rights shall survive termination.

anties, limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI’s

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements,
that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no
warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or hardware. THE INSTALLATION OF ANY
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION,
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD
PARTY RIGHTS.



Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this agreement to the extent that this agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or
trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE
WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls

EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as foreign export laws and regulations.
You agree that you will not use, distribute, transfer, export, or re-export any portion of the Product or the Software in any form in violation of any applicable laws
or regulations of the United States or the country in which you obtained them.

U.S. Government Restricted Rights:

Use, duplication, or disclosure of the Software by the United States Government is subject to re
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights4s s
Alternate ITI(g) (3) (June 1987) or FAR 52.227-19 (June 1987). To the extent any technical dae4 i

FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. G
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that

ictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
out in FAR 52.227-14, Restricted Rights Notice (June 1987)
ovided pursuant to the Agreement, such data is protected per

General

The rights and obligations of the parties related to this Agreement will be
apply to contracts between California residents performed entirely within Califo

respects by the laws of the State of California exclusively, as such laws
The United Nations Convention on Contracts for the International Sale of

essafy fo be enforceable and the other provisions in this Agreement shall continue in full force

and effect.
If you have any questions, please see EFI’s web site at www.efi.com.
Electronics for Imaging

303 Velocity Way
Foster City, CA 94404
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Introduction

xiii

About this manual

This manual is intended for Fiery EX3535 Color Server operators and administrators,
or users with the necessary access privileges, who monitor and manage job flow,
manipulate jobs, and troubleshoot problems that may arise. It describes the functions
and features of the Fiery® job management utilities—Command
WorkStation,Command WorkStation LE, and Fiery Spooler—for the purposes of job
management and quality control.

Note: The term “Fiery EX3535” is used to refer to the Fiery EX3535 Color Server.
The name “Aero” is used in illustrations to represent the Fiery EX3535. The term
“copier” is used to refer to the DocuColor 3535. The term “Windows 9x” is used to
refer to Windows 95 and Windows
Windows 95, Windows 98, Wi
Windows XP, wherever appr t

he term “Windows” is used to refer to

Windows NT 4.0, Windows 2000, and

About this ma

This manual is o

es theFiery® job management utilities. It explains how to set up an
ontrolled print environment and discusses job workflows that commonly
occur on the Fiery EX3535.

* Chapter 2 introduces the Command WorkStation and Command WorkStation LE
user interfaces. It also provides information on basic Command WorkStation and
Command WorkStation LE functions, such as printing Fiery EX3535 information
pages and setting preferences.

* Chapter 3 provides instructions on how to monitor and manage job flow using
Command WorkStation and Command WorkStation LE. It explains how to hold,
process, print, and cancel selected jobs, and how to track and archive printed jobs.

* Chapter 4 describes how to preview, edit, and merge jobs using the Preview windows
of Command WorkStation and Command WorkStation LE.

¢ Chapter 5 describes how to use the Imposition feature of DocBuilder Pro to arrange
the pages of your print job in special layouts for folding, binding, or cutting after
printing. The Imposition feature is available only if you have installed the
DocBuilder Pro option for Command WorkStation.
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* Chapter 6 provides instructions on using advanced aspects of DocBuilder Pro to
create custom layouts and take full advantage of Imposition features.

* Chapter 7 describes Fiery Spooler, which you can use to view and manage
Fiery EX3535 job activity.

* Chapter 8 describes FieryBar. It explains the various messages and icons you might
see and also explains how to start up and shut down the Fiery EX3535 if you have
the Fiery Advanced Controller Interface kit installed.

* Appendix A provides an overview of the terms and concepts of imposition,
including various folding, binding, and cutting methods.

* Appendix B describes the built-in templates available from the Imposition feature of

DocBuilder Pro.
* Appendix A provides basic tr?@ ing information.
Terminology

Specific terms are explained\as they are introduced. However, the following general

terms are used throughout:

* PostScript(PS omputer language designed as a page description language.
ses this language to image the page and communicate with
applications and the copier.

The term “PostScript” can also be used to refer to PDF data jobs. PDF is a
structured form of PostScript that provides the ability to preview, scale, and reorder
pages. Where applicable, the term “PDF” is specifically used to refer to PDF data

or jobs.

* Printer Control Language (PCL)—A computer language designed as a page
description language. The Fiery EX3535 uses this language to image the page, and
communicate with applications and the copier.

* Job—A file consisting of PostScript or PCL commands and comments that describe
the graphics, sampled images, and text that should appear on each page of a
document, and the printer options that should be used in printing, such as media or
finishing options.



xv | About this manual

* Spool—Write to a disk. Used in this manual to refer to a PostScript or PCL print job
saved to the Fiery EX3535 hard disk drive in preparation for processing and
printing.

* RIP—Acronym for raster image processing, which changes PostScript or PCL
commands into descriptions of each mark on a page. In common use as a noun, a
“raster image processor” (RIP) is the computer processor that performs this function.

The Fiery EX3535 RIP changes text and graphics commands in PostScript or PCL

into specifications for each dot of toner deposited on a page by the copier.

* Process—The term “process” is used interchangeably with the term “RIP” in this
manual to refer to raster image processing.

* Print—The task of rendering, or i

These concepts explain how e%l
powerful printing system,

ing, a page or job on a print device.

35 and the copier work together as a






Chapter 1:
About Job
Management

1-1 | Job environments

This chapter explains the basic principles of job management in an operator-controlled
print environment and provides an overview of the Fiery EX3535 job management
utilities.

Job environments

The Fiery EX3535 supports several control levels of printing, job management, and
Setup, and gives you the flexibility to choose a configuration that corresponds to the
requirements of your site.

Levels of job control
The following descriptions o%l%ﬂa\ée of levels of job control that may exist in

your environment:

¢ At one extreme, an r 1n> hlgh volume prmtmg environment controls the

print the

are res 1¢‘Operator.

* At the other extreme, anyone on the local network can control all printing and
Fiery EX3535 functions; operator intervention is not required. Users can print from
their workstations to any of the published print connections. Anyone can use the job
management utilities to control any print job.

You can implement intermediate levels of job control in your environment. However,

the job management utilities are best suited for an operator-controlled environment.
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Setting up an operator-controlled environment

This manual assumes you are working in an operator-controlled environment with
responsibility for managing job flow. To establish an operator-controlled environment,
you or the administrator must complete the following tasks:

Set up password privileges—The administrator must set up separate passwords for
operator access and administrator access to the Fiery EX3535. For instructions on
setting up passwords, see the Configuration Guide.

Publish the Hold queue only—The administrator must enable only the Hold queue,
not the Direct connection or the Print queue, in Setup. (For more information, see the
Configuration Guide.) This ensures that all jobs sent by remote users are spooled and
held on the Fiery EX3535, in prep4rdtion for job management by the operator.

Establish communication between u and the operator—The operator and remote

users must agree on a communicating print needs, such as FreeForm™

masters. Users can attach instructions to jobs using print option and notes fields (see

In an operator-controlled printing environment, remote users send jobs to the Hold
queue of the Fiery EX3535. Using a job management utility, the operator views the list

of held jobs and decides when to release each job for processing and printing.

The operator may also intervene during the workflow, stopping jobs as they are
processed or printed, placing jobs on hold for future action, or overriding the
user-defined print settings for a job. In some cases, the operator may even modify a
job, duplicating or removing pages, or merging it with pages from another job before
releasing it for printing.



1-3 | Understanding job flow

Spooling

Processing

Printing

Spooling, processing, and printing

To understand job flow through the Fiery EX3535, it is helpful to consider the three
main stages of printing.

Spooling—When a job file is sent over the network by a remote user or imported from
disk, it arrives at the Fiery EX3535 and spools to a location on the hard disk drive.
After spooling completely, the job is held on the hard disk drive, where it awaits further

instructions from the operator.

Processing (RIPping)—When the operator releases the job file, it undergoes raster
image processing (RIPping) at the Fiery EX3535. During processing, the job file is

interpreted as a raster image. This raster image contains the data required by the copier

to print the job the way its originator'intended. In the raster image, data associated
with each dot is rendered on the)copier.
to apply toner to each position ‘on the page.

Printing—After processing,

raster data tells the copier whether or not

¢ job typically moves on to the printing stage. During

this stage, the ra; ell | 2

While originaljob files are saved to the Fiery EX3535 hard disk drive, raster images are

ge associated with the job is transferred from the Fiery EX3535

to the copier peed. The raster image is then rendered onto paper, and the job

is printe

typically deleted after printing. The operator can issue commands to save and hold the
raster image on the hard disk drive along with the original job file. Saving the raster
image to the hard disk drive offers two advantages: raster files are already processed, so
they print quickly, and each part of the raster file is still identified with a page in the

original document, so you can access individual pages of a saved raster file.
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Visualizing job flow

As the operator, your job management tools permit holding and releasing a job at any
stage of the job flow. In the following illustration, solid boxes indicate the types of job
status flags you may see in the Command WorkStation or Command WorkStation LE
Active Jobs window. Boldface items represent commands you can issue from a job
management utility to release held jobs.

Spooling
PostScript and Spooled/Held
PCL data
Print Process (RIP) and Hold Print and Hold
Processing (RIPping) Processing (RIPping) Processing (RIPping)
PostScript, PCL, v
and raster data Processed/Held

Pn“nt 4‘
* /N
_ N
\\

Printing Printing — Printing

Printed
L _ _ 4
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Each command initiates a job workflow:

Print—When you issue the Print command for a held job, the job is released for
immediate processing and printing on the Fiery EX3535.

Print and Hold—When you issue the Print and Hold command for a held job, the job
is released for immediate processing and printing. However, a raster copy of the
original job remains in processed/held status, even after the original job has finished
printing.

Process (RIP) and Hold—When you issue the Process and Hold command (Command
WorkStation or Command WorkStatioh LE) or RIP and Hold command (Fiery
Spooler) for a held job, the job is released for processing and then held in processed/

held status indefinitely. To release the job for immediate printing, you must issue the
t
ishe

Print command. A raster cop iginal job remains in processed/held status,

even after the original jo s printing.

with users

use the job management tools to communicate with users

jobs by supplyirg the following information:

Fiery EX3535 device information

* The name of the Fiery EX3535 on the network and the names of the network

servers sharing it

* The IP address or DNS name of the Fiery EX3535, to allow users access to Fiery
WebTools™

e List of default copier settings and other settings
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¢ List of installed fonts

If their applications do not download fonts automatically, can users download fonts
to the Fiery EX3535? Should users embed fonts in documents or supply them for

you to download?
* Resident calibration target and date of current measurements
¢ Custom simulations

Are custom simulations available? If so, what type of targets do they represent?
Although users see these print options, they should not select them if there are no

custom targets on the Fiery EX3535.
* List of installable options for the copjer

* Available media, alternative choices, and standard tray/media configurations

Printing information

¢ Duration for jobs to Be held o’ the Fiery EX3535 before deletion
6 ing up the printer on client computers
’ c:> printer drivers, PPDs, color reference files, and additional

* Recommendéd PPD settings

¢ Instructions

¢ Sources

inform

* Conflicting settings and common PostScript errors

* FreeForm information regarding use of master and variable data

* Imposition information regarding use of the DocBuilder Pro option

* Characteristics of commonly used output color profiles

* Requirements for Notes fields (information that appears in the Job Log)

For example, department name, account code, phone number, or extension.

Is particular information mandatory at your site?

* Suggestions for what to enter in the Instructions field
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What the operator should check

Users specify print options with jobs they send to the printer. They can also use the
Instructions and Notes fields to communicate special print requirements and
accounting information. Together, this user-specified information that accompanies

the job is called a job ticket.

As the operator, we recommend you tell remote users which job ticket information you
check when receiving a print job, and the information you require in order to print
jobs they send.

Job ticket information

You can view and potentially override the print options specified by users by checking

lefined print options, choose Properties in

job ticket information. To display user-d
Command WorkStation or VorkStation LE (see page 3-14), or Override
Print Settings in Fiery Spooler\(see page 7-0).

Notes fields

phone number

Users can ente

ng information in the Notes fields, such as:

e User €
* Billing in ation

¢ Job cost information

Instructions field

Users can also enter information in the Instructions field to communicate special print
requirements, such as:

* Priority, due date, and request for notification

* Number of copies

* Type and quantity of paper

* Request for color check by the operator

* Request to hold job for future printing or reprinting, and future job instructions

* Instructions to merge job with another job
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* Fiery FreeForm information regarding the use of master and variable data

* Imposition instructions

Overview of the job management utilities
The Fiery EX3535 includes the following job management utilities:

¢ Command WorkStation
¢ Command WorkStation LE

* Fiery Spooler

N
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These utilities are designed for use by operators who must track and manage jobs and
oversee general job flow through the Fiery EX3535. All the utilities offer the following

job management features:

* Monitoring activity on the Fiery EX3535 and controlling job flow
* Viewing and overriding user-defined print option settings

* Editing and merging job files

* Tracking job activity through the Job Log

Command WorkStation

The most powerful of the job management utilities, Command WorkStation can be
installed on a Microsoft Windows ter that has a network connection to the
Fiery EX3535. In addition to théjob management functions previously outlined,
Command WorkStation offe izable user interface for monitoring and
managing jobs on multi iery EX3535 servers simultaneously.

For an introduction-to the mand WorkStation user interface, see Chapter 2.
For informatio onitoring, managing, and archiving jobs with Command
WorkStation, see er 3.

Comman rkStation LE

Command WorkStation LE allows operators and users to manage jobs from a Mac OS
computer with a network connection to the Fiery EX3535.

The features of Command WorkStation LE are similar to those of Command
WorkStation. For information on Command WorkStation LE, see Chapter 2 and

Chapter 3.

Fiery Spooler
Fiery Spooler must be installed on a networked Mac OS computer and can only be
used on that computer.



Fiery Spooler offers job management functions similar to those of Command

WorkStation. The default Fiery Spooler user interface is shown in the following

illustration.

Fiery Spooler
| Time:

Spool Status Bar

Spool Area

RIP Status Bar

RIP Area

Print Status Bar

WedinGanm ps 08:51:0
Yiolin B ps 08:50:52

Print Area

Times ps 02:40:46
tailor Bw.ps 024043
SOUTH.TAB.RGE ps 02:49:14
NORTH.Cvr RGE ps 02:48:57
Iarket BY ps 08:48:50

For information‘on using Fiery Spooler, see Chapter 7.

201103
201103
201103
201103
201103
2101103

device
device
device
device
device
device

Thumbnail B

Thumbnail A
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Chapter 2: This chapter provides an introduction to the Command WorkStation and
Introduction Command WorkStation LE graphical user interfaces. To follow along in the software
as you read the chapter, log in to the application with an Operator or Administrator
.‘I;\(; Clc("snmand password, as described on page 3-2.
orkStation
and Command Once you are logged in, you can tour the application. Your exploration will be more

WorkStation LE complete if you have some jobs in the Active Jobs window (jobs in the Hold queue),

and can send more jobs from a nearby computer.

The chapter also describes Setup fu%s such as printing Fiery EX3535 information
pages, setting application preferg%rl managing Fiery EX3535 fonts.

Note: Unless otherwise specig\é , information in this chapter applies to both
Command WorkStatio CQ mand WorkStation LE. Sections that apply
exclusively to Comman kStation are denoted by an asterisk (*). Sections that
apply exclusively to €ommand WorkStation LE are denoted by a dagger (). In cases
where the two @ins are nearly identical, only Command WorkStation
e.sho

illustratio

The graphical interface

Command WorkStation and Command WorkStation LE provide graphical means to
monitor, preview, and manage jobs on one or more Fiery EX3535 servers. You can
hide or rearrange the components in the interface to create custom layouts that meet

your job management needs.
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The following illustrations show the components of Command WorkStation and
Command WorkStation LE.

Command WorkStation

File Edit Actions Server Window Help 1

|I:|5pao\ing [ | spooledteld [ walting to process [ processing || processedineld [ |waiting to print [ printing 2
=

Archive Previsw Impose Propetties

6

Fiory

Job Status | Job Title User DateiTime ~ SERVER-2

Held [ test2000.pdr mark 1/14i03 7.:58:56 PM 28766 KB ] =pooling: Idie
Held [ 2Pletter PDF dbp Administrator  1/8/03 11:28:50 AM 1 40296 KB [ Fracessing: [die
Held [§ 2Plstter PDF Administrator  1/9/03 11:24:31 AM 1 28766 KB [ Frinting: Idle
Held [ B pdr Administrator  1/9/03 11.08:39 AM 1 40298 KB

Held [ simplex.pdr Administrator  1/9/03 10:18:39 AM 1 19996 KB ] =pooling: Idie
Held [ Black_Hole pdf.dhp Administrator 17803 10:16:15 AM 1 33487 KB [ 1 Fracessing: simplex.pdf
\Waiting [ Black_Hale.pdf Administrator  1/9/03 1016215 AM 3 33287 KB [ Frinting: testPage
Processing  [Y simplex pdf Administrator - 1710003 5:50:30 A 1 199896 KB

Held % Bighuma32 pdf dbp Administrator  1/8/03 4:54:14 P 1596 KB

Held £ 508368 Shoprite 5 Administrator  1/9/03 2:24:31 PM 1 33447 KB

Held £ 508378 Shoprite FS Administrator  1/9/03 2:24:30 PM 1 1686 KB

Held % 508381 Shoprite C Administrator  1/8/03 2:24:28 PM 1 37T KB

Held % portrait_200 eps Administrator  1/15/03 3:43:08 PM 1 18954 KB

Held % Man RGB eps Administrator  1/15/03 3:42:09 PM 1 33447 KB

YWaiting & 12yroas pdf Administrator 1115003 12:14:53 PM 18189 KB

Printing & testPane Administrator 171503 10:36:45 AW 816 KB j

m Printed Jobs

Job Title User Date/Time Copi

[ B2BRGBCR.PS Administrator 11703 11:14:53 A 15
[ B34CMYKD.PS Administrator 11703 11:14:52 A 15
[ Associates-v3 94 pdf Administratar  1/117/03 13:38:09 AM 1
[ Printer Test Page Administrator - 11603 5:29:20 PM 1
[ Printer Test Page Administrator  1MB/03 5:29:14 PM 1
[ Printer Test Page Administrator - 11603 5:29:01 PM 1
[ Test Page Administrator  11B/03 3:29:38 PM 1
[ Test Page Administrator 11603 31613 PM 1
[ EPGuide pdf Administratar - 1A1B/03 12:02:31 PM 3

e

[T

1 Menu bar (see page 2-15)

2 Job status indicators (see page 2-11)
3 Action buttons (see page 2-12)

4 Active Jobs window (see page 2-4)

5 Jobs window (see page 2-6)

6 Activity Monitor (see page 2-8)
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Command WorkStation LE

'E e (8] Command Workstation LE
— o Ay T
g [l . 1
©ecr & L @ S ‘e
Print Process/Hold Delete  Archive Preview Properties

Active Jobs: AERO @) Total Jobs 44

¥ Job Status Job Title User Data/Time Copies
Hald [4 Fa1_TESTps MichaalP 3/13/03 11:22 AM 1
Held B Spanish Ballerin... MichaslP 3/13/03 11:33 AM 1
Held B BrianKillar_NOM... MichaalP 3/13/03 11:13 AM 1
Hald B D45WOP_n1a_... Administrator 3/14/03 B:58 AM 1
Hald B CODB.Cookies.ps MichaalP 3/13/03 11:18 AM 1
Hald B C12.Dirtbike_NO... MichaslP 3/13/03 11:19 AM 1
Hald B BrianKillar.ps MichaelP 3/13/03 11:12 AM 1
Held B C09.Castle ps MichaalP 3/13/03 11:18 AM 1
Hald B C04.GDROP.PS  MichaslP 3/13/03 11:17 AM 1
Hald B CO5.RESOL.PS MichaalP 3/13/03 11:17 AM 1
Held B C15 Hifred .ps MichaalP 3/13/03 11:20 AM 1
Hald B C19.yellowtailps  MichaslP 3/13/03 11:21 AM 1
€ = =) )
Archived Jobs 9 Total Jo

w Job Title | User Date/Time Copies Size

(* General Info

o 25 50 75 100
N

total: 32.3 GE  available: 274 GB

Memory
o 25 50 75 100

" Prinied Jobs I ‘m iE ——— X
b

1 Action buttons (see page 2-12)

2 Active Jobs window (see page 2-4)
3 Jobs window (see page 2-6)

4 Activity Monitor (see page 2-8)

—
'

The following sections describe each component in Command WorkStation and
Command WorkStation LE.



Active Jobs window

The Active Jobs window dynamically displays the status and job ticket information of
jobs that are currently being held, processed, or printed on the Fiery EX3535. The title
bar displays the total number of jobs and the total number of held jobs currently being

monitored.

The Active Jobs window is always displayed. You cannot hide or drag it to a different

location. By issuing job management commands, you release held jobs in the window
for processing and printing, cancel jobs currently processing or printing, and send jobs
back to held status for future action. For more information on the status flags displayed

2-4 | Introduction to Command WorkStation and Command WorkStation LE

in the Active Jobs window, see “Job status indicators” on page 2-11.

Server selection menu

Job ticket information

User

DateiTime

M

Pl Active Jobs A

Job Status | Job Title

Held [4 2Pletter.POF.dhp
Held [4 2Pletter.POF

Held [ By pdf

Held [ simplex

Held [ Black_Hale.pdf.dbp
WWaiting [4 Black_Hale.pdf
Pracessing | [9 simplex verd.2 011 ..
Held & BigMum32.pdf.dbp
Held & 508368 Shoprite &....
Held & 508378 Shoprite FS...
Held & 508381 Shoprite ©...

4

Administratar
Administratar
Administratar
Administratar
Administratar
Administratar
Administratar
Administratar
Administratar
Administratar
Administratar

119703 11:28:50 AM
119703 11:24:31 AM
119403 11:09:39 AM
119703 10:18:39 AM
19703 10:16:15 AM
19703 10:16:15 AM
10003 5:50:30 AM
19703 4:54:14 PM
19703 2:24:31 PM
19703 2:24:30 PM
19703 2:24:28 PM

Command WorkStation

Active Jobs: AERO

w Job Status

Job ticket information

Hald

Job Title
[ F31_TEST.ps

[ Spanish Ballerin...
[ Briankilar_NOM...
[ 045WOP_nta_...

[ co8.Cookies.ps

[ C12.Dirtbike_NO...

BrianKiller.ps

O p
C09.Castle ps

O p

[ co4.GOROP.PS

[ CO5.RESOL.PS
C15 Hifrad .ps

O p

[ C19.yedowtai.ps

User
MichaelP
MichaelP
MichaelP
Administrator
MichaelP
MichaelP
MichaelP
MichaelP
MichaelP
MichaelP
MichaelP
MichaelP

Total Jobs 44

Date/Time

3/13/03 11:22 AM
3/13/03 11:33 AM
3/13/03 11:13 AM
3/14/03 B:58 AM
3/13/03 11:18 AM
3/13/03 11:19 AM
3/13/03 11:12 AM
3/13/03 11:18 AM
3/13/03 11:17 AM
3/13/03 11:17 AM
3/13/03 11:20 AM
3/13/03 11:21 AM

J

Command WorkStation LE

Held Jobs 44

Copies

(3
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In the Active Jobs window, you can:
* Monitor and manage jobs on the Fiery EX3535 (see page 3-6)
* Customize job ticket information (see page 3-8)

* Monitor jobs on multiple Fiery EX3535 servers* (see page 2-12)

AT
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Jobs window

The Jobs window displays information about jobs that have printed successfully
through a connected Fiery EX3535. The window is divided into four layered panels.
Click the selection tabs at the bottom of the window to move between different panels.

The following illustration shows the Jobs window for Command WorkStation, which
is nearly identical to the Jobs Window for Command WorkStation LE.

Printed Jobs tab

Y |
||| Printed Johs

Jab Title User DatelTime Copi... Size [~
[§ 2543.P5 Adrministrator  1/10/03 11:26:55 AM 1 126931 KB

[4 Black_Hale.pdf Administrator 100003 11:26:50 AM 1 5108 KB __
[ Anglefish.pdf Administrator 10003 11:26:27 AM 1 439 KB

[ Bhvy pdf Adrministrator — 110/03 11:26:27 AM 1 52317 KB

[ 4poLetterPiGs. pdf Administrator 10003 11:24:21 AM 1 77 kB

[4 Black_Hole.ps Administrator 10003 11:24:21 AM 1 I7TE3IBI KB

[ J.Brahms.ps Administrator 1A 0/03 11:23:44 AM 1 161932 KB

[ pm021tabsipdfps Administrator 1A 0/03 10:07:41 AM 1 935 KB

[ pm021tabsipdf pdf Administrator 1A 0/03 10:07:40 A 1 522 KB =
Printed Johs

In each panek't ar displays the name of the panel and the total number of jobs

displayed:

All panels of the Jobs window allow you to customize the job ticket information
(see page 3-8).

Printed Jobs panel

The Printed Jobs panel lists all jobs that have been printed from the Fiery EX3535.
Newly printed jobs are added to the top of the list. The Printed Jobs panel lists all
printed jobs until the job limit (determined by the administrator in Fiery EX3535
Setup) is reached. When the first job over the limit is printed, the oldest job is deleted
from the Printed Jobs list.

Note: The Printed Jobs panel doesn’t list the following types of jobs: jobs printed
though the Direct queue and jobs printed with the Print Pages command.
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Archive panel

The Archive panel lists all files and jobs stored in the job archive.

| | | Archived Jobs

Jab Title User DatelTime Copi...
[ Documentt Administrator 153503 6:13:44 PM 1
[ Documentt Administrator 153503 5:27:35 PM 1

For information 6n using theArchive panel, see “Archiving jobs” on page 3-25.

FreeFor

The FreeForm panel lists the names of all master files used for Fiery FreeForm variable
data printing. Jobs listed in the FreeForm panel represent master files that have already

been RIPped and stored on the Fiery EX3535.

| | | Freeform Masters

Joh Title

1 1
£ 508378 Shoprite FS... Administrator 159003 2:24:29 PM
£ 508381 Shoprite .. Administrator 159003 2:24:28 PM 1




2-8 | Introduction to Command WorkStation and Command WorkStation LE

The FreeForm panel is not available if you logged in as Guest. For information on
working with FreeForm jobs and the FreeForm panel, see page 3-22.

Job Log panel

The Job Log panel lists all processed and printed jobs and includes the date and time
the jobs were printed.

| | | Job Log

Frint Status | Job Title DateiTime

[s]%¢ [ hittp:ifwenee raman... PAT 312003 5:18:20 PM 311 KB
[s]%¢ [ hittp:ifwenee raman... PAT 3200351752 PM 256 KB —
[s]%¢ [ hittp:ifwenee raman... PAT 320351721 PM 253 KB
[s]%¢ [ hittp:ifwenee raman... PAT 312003 5:16:37 PM 343 KB
[s]%¢ [ Dsfinaloutput? pdf Leslie 312003 4:51:43 PM 4573 KB
o]'4 [4 start Page Operator 312103 44311 PM 1201 KB
o]'4 [4 start Page Operator 31203 41525 PM 1201 KB
o]'4 [ Online Membership... sam 3112103 4:05:06 PM 46 KB
o]'4 [4 start Page Operator 312103 4:03:35 PM 1201 KB =

Job Log

The Job Log p4 0 available if you logged in as Guest. For information on using
o' panel, see’page 3-26.

The Activity Monitor displays a summary of the job activity on all Fiery EX3535
servers or a selected Fiery EX3535. The activity shown can include jobs released for
spooling, processing (RIPping), or printing. Held jobs do not appear in the Activity
Monitor.

Display the Activity Monitor by choosing Activity Monitor from the Windows menu.
In Command WorkStation, you can use the server selection menu in the Active Jobs
window to display job activity for an individual Fiery EX3535, or for all servers (see
page 2-12).
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All Servers view*

In Command WorkStation, the All Servers view of the Activity Monitor summarizes
the activity on all connected Fiery EX3535 servers.

Il activity
~ AERO

[ Spooling: Idle
[ Processing: [dle
[ Printing:

Mo fuser oil

fwer ]
[ Spooling: Idle

[ Processing: [dle

[ Printing: Idle

¢ Server Name—Each Fiery EX3535appears in a Server Name bar. Click the bar to
expand or collapse activity information for a particular Fiery EX3535.

* Spooling, processing, and, printingjobs—When you expand the Server Name bar
for an Fiery EX3535 urrent job activity on that Fiery EX3535 appears next to
a corresponding status box (spooling, processing, or printing). If the Command

Workstation for-the Fiery EX3535 is connected to more than one copier, the copier
"sed under the job name. When no activity occurs on the

the status boxes read Idle.

handling
Fiery 5

¢ Error con s—When an error occurs, the Server Name bar for the affected

Fiery EX3535 appears highlighted in red. Details of the error appear under the
expanded bar.

Selected Server view

When you select an individual Fiery EX3535 in Command WorkStation, the Activity
Monitor provides a more detailed summary of the current activity on that
Fiery EX3535. In Command WorkStation LE, the Activity Monitor always displays

the current activity on the connected Fiery EX3535. Animated images provide visual
indications of the job activity.



2-10 | Introduction to Command WorkStation and Command WorkStation LE

Jobs being held, waiting to process, or waiting to print are not displayed.

The following illustration shows the Selected Server view of the Activity Monitor for

Command WorkStation, which is nearly identical to the Activity Monitor for
Command WorkStation LE.

Spooling

Processing

Printing

General Info

~ General Info

Hard Drive

0 25 50 75 100
————

Total: 17.5 GB_Available: 17.5 6B
Mernory
0 25 50 75 100

Total:_21.0 MB_Available: 310 M8
Info

Server Name: AERO

System 1

SupportE:

Device =clevice_names=

Four sections appear for a selected server. You can click the title bar for each section to
expand or collapse the display of each section.

Spooling—Displays the file name of the job spooling to the Fiery EX3535 disk.

Processing—Displays the file name of the job currently being processed (RIPped),
along with an animated preview of the page currently being processed.

Printing—Displays the file name of the job currently being printed, and the page
number currently printing. With multiple copies, the copy number is also displayed.

General Info—Displays the total and available hard disk drive space, and the total and
available memory of the Fiery EX3535. This section also provides the Fiery EX3535

name, system software version, technical support number, and copier name.
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Job status indicators

Job status indicators define the color in the Active Jobs window and Activity Monitor
to indicate the current status of jobs. For information on how each indicator relates to
job flow on the Fiery EX3535, see “Understanding job flow” on page 1-2.

In Command WorkStation, a key for the job status indicators is displayed below the
menu bar:

[ Ispooling [_|spoolediheld [ | waiting to process [ processing || processediheld [ | waiting to print [ printing

The color-coded job status indicators identify:
spooling (white)—The job file is b opied to the Fiery EX3535 hard disk drive.
spooled/held (light yellow) %a een downloaded to the Fiery EX3535 hard
disk drive and requires job-management instructions from the operator.
waiting to process (lig@g he job is queued to be processed (RIPped).

e

processing (med

% )—The job is currently being processed (RIPped).

processed/held ellow)—The job has been processed (RIPped) and requires job
managem structions from the operator.

waiting to print’(light green)—The job is queued to be printed on a copier connected
to the Fiery EX3535.

printing (bright green)—The job has been received by a copier connected to the
Fiery EX3535.
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Action buttons

Action buttons provide convenient access to frequently used job management
commands. You can also issue these commands by choosing them from the menu bar
or the context-sensitive menus. For a detailed description of each Action button
command, see the table on page 2-15.

Print

| Hald | Process/Hold | Delete | Archive | Prewigw | Inmpoze | Properties

Command WorkStation

L=

Print

Precé;sa'Hold Delete  Archive Pf;view Properties

Command WorkStation LE é\\

To ISSUE AN ACTION BUTTON COMMAND

1.

2.

Select a job in the Acti s window or the Jobs window.

Preview ows

The Preview windows allow you to view thumbnail previews of selected jobs. You can
also use the Preview windows to reorder and delete pages of a job, and to merge pages
from several jobs into a single, merged job.

Monitoring single or multiple Fiery EX3535 servers*

In Command WorkStation, you can set the Active Jobs window, Jobs window, and
Activity Monitor to display job information for a single Fiery EX3535 or all connected
Fiery EX3535 servers.

To SPECIFY THE FIERY EX3535 BEING MONITORED

1.

Click the arrow in the server selection menu of the Active Jobs window, Jobs window,
or Activity Monitor.

A menu appears, listing the names of all connected Fiery EX3535 servers.
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2.

To display jobs for an individual Fiery EX3535, choose the Fiery EX3535 from the list.
To monitor jobs for all connected Fiery EX3535 servers, choose All Servers.

Print jobs on the specified Fiery EX3535 servers appear.

Customizing the graphical interface

Command WorkStation and Command WorkStation LE offer you the flexibility of
showing, hiding, rearranging, and docking user interface components to fit your
workflow needs. For example, you may only need a few components, or you may
prefer to arrange components side by side for ease of use. In Command WorkStation
you can also choose one of three preset layouts.

You can also customize the appearance of job ticket information in the Active Jobs and
Jobs windows. For more information, see\page 3-8.

Using layout styles*

Command WorkStatiofy provides\three preset and three customizable layout styles.
When you choose the command corresponding to a layout style, the display updates to

show a specific arrangement of components.

To SELECT A LAYOUT STYLE

Choose Layouts from the Window menu, and then choose a layout style from the
submenu that appears.

You can choose one of three preset layouts (Default, Style 1, or Style 2) and three
custom layouts. For a description of the components included with each of the preset
layouts, see page 2-23.

You can define and change the configurations associated with the three custom layout
styles. For details, see the following section.

Showing, hiding, and arranging components

Use Window menu commands to show or hide window components. You can also
drag components to different locations in the window, and dock components side by
side.
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NoTe: You cannot hide or drag the menu bar and Active Jobs window to different
locations. These components always appear in the Command WorkStation or
Command WorkStation LE window.

To SHOW OR HIDE A COMPONENT

Choose the command associated with the component from the Window menu.

When a component is displayed, a check mark appears next to it in the Window

menu.

To MOVE A COMPONENT TO ANOTHER LOCATION

Click the window grip (three vertical lines) on the left side of the component'’s title
bar (Command WorkStation) or click the component’s title bar
(Command WorkStation LE), and drag the window to the desired location.

Undocked components float in\front of other components and appear with standard
window frames. You can’drag the blank title bar of the window to move the
component, or drag-the edges of the window to resize the component. You can also
click the windew/Close'box to hide the component.

Note: When the Jobs window is docked, you can resize it vertically by clicking and
dragging its.top edge.

TO DOCK OR UNDOCK A COMPONENT

Double-click the window grip in the component'’s title bar.

TO SAVE THE CURRENT DISPLAY CONFIGURATION AS A
LAYOUT STYLE IN COMMAND WORKSTATION*

1.

2.

Choose Save Layout from the Window menu.

In the dialog box that appears, choose the style you want to update, and, if desired,
rename the style.

Click OK to save the new layout style.
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Using commands

You can perform a wide variety of functions using Command WorkStation and
Command WorkStation LE commands. The commands are accessed from menus in
the menu bar at the top of the Command WorkStation or Command WorkStation LE
window. When one or more jobs are selected, you can choose job management
commands from context-sensitive menus. In addition, you can issue some job

management commands by clicking their Action buttons (see page 2-12).

Menu bar

The menu bar contains commands for Command WorkStation or Command
WorkStation LE. When a command is unavailable in the current context, it appears
dimmed in the menu. When a com appears with a check mark, choosing it again

toggles the command, turning itoff:
The menu bar always appe the &mmand WorkStation window, and cannot be

dragged to a different loeat

»

an asterisk (*) indicates that the command or menu is
orkStation only. A dagger (T) indicates that the command or
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Menu Command Submenu command Description
CWS LEf | About Fiery Displays information about the current version of

Command Command WorkStation LE

WorkStation LEt

Preferencest Allows you to change the Command WorkStation LE
preference settings.

ServicesT The commands under this submenu are disabled for
Command WorkStation LE.

Hide CWS LET Minimizes and hides the Command WorkStation LE
application window. The application will continue to run in
the background.

Hide Others? Minimizes'and hides all currently running applications other
thaf Command WorkStation LE. The hidden applications
will contihue to run in the background.

Show Allt Maximizes and brings to the foreground all applications that

are currently running on the computer.

Quit CWS LE}

Exits the Command WorkStation LE application.
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Menu Command Submenu command Description
File Import Job Imports a job file into the Direct, Hold, or Print queue of
the Fiery EX3535.
Archived Job Imports an archived job file into the Hold queue of the
Fiery EX3535.
Export Active Window* Exports the contents of the current window to a
tab-delimited text file.
Printed Jobs Window* Exports the contents of the Printed Jobs panel to a
tab-delimited text file.
Job Listt Exports the contents of the Active Jobs window to a tab-
delimifed|text file.
Job Logt Exports the\contents of the Job Log panel to a tab-delimited
text file.
Print* Job Log* Prints the current Job Log on a local printer.
Active Window* Prints the contents of the current window on a local printer.
Exit* Closes the Command WorkStation application window.
Closet Closes the Command WorkStation LE application window.
Edit Find Allows you to search selected Fiery EX3535 servers for jobs
that match certain search criteria.
Preferences* Allows you to change the Command WorkStation

preference settings.

Undo, Cut, Copy,
Pastef

Applies the specified action on the selection. For more
information, see Mac OS Help.
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Menu

Command

Submenu command

Description

Actions

Print

Prints the selected job in the Active Jobs window, Printed
Jobs panel or Archive panel.

Delete

Deletes the selected job in the Active Jobs window, Printed
Jobs panel, FreeForm panel, or Archive panel.

You cannot delete jobs currently spooling, processing, or
waiting to print.

Duplicate

Duplicates the selected held job in the Active Jobs window.

Rename

Allows you to rename the selected held job in the Active Jobs
window, or the selected job in the Printed Jobs panel or

Archl%ﬁ?el.

Hold

Holds the kékcted job waiting to process in the Active Jobs
Wi . or the selected job in the Printed Jobs or Archive
\\;\mnel, nd marks the job with either the spooled/held flag or

t\h\e\ processed/held flag.

Process and Hold

%
Processes the selected job in the Active Jobs window, Printed
Jobs panel, or Archive panel, and holds a copy of the job.
The copied job is marked with the processed/held flag.

Print and Hold

Prints the selected job in the Active Jobs window, Printed
Jobs panel, or Archive panel, and holds a copy of the job.
The copied job is marked with the processed/held flag.

Remove Raster
Data

Removes the raster data associated with the selected
processed/held job in the Active Jobs window, or the selected
raster job in the Printed Jobs or Archive panel; leaves the
original PostScript job in place.

Properties Allows you to view and override print settings for the
selected job in the Active Jobs window or Printed Jobs panel,
or view print settings for the selected job in the FreeForm
panel or Archive panel.

Preview Opens the selected job in a Preview window. You can

preview held jobs that reside in the Active Jobs window, as
well as jobs that reside in the Printed Jobs panel, FreeForm
panel, or Archive panel.
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Menu Command Submenu command Description
Actions Archive Archives the selected held job in the Active Jobs window,
(cont.) moving it to the Archive panel.
Send To* Sends the selected held job in the Active Jobs window to

another Fiery EX3535.

Cancel Processing

Cancels processing of the selected job in the Active Jobs
window. This command is available only for jobs displaying
the processing status flag.

Cancel Printing

Cancels printing of the selected job in the Active Jobs
window. This command is available only for jobs displaying
the prineing status flag.

Impose* Allews you, to apply imposition settings to the selected held
job in'the Active Jobs window.
Mixed Media Allows you to specify different media types for different page

Setup*

ranges in the selected spooled/held job.
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Menu Command Submenu command Description
Server Log In/Log Out Allows you to log in or log out of the Fiery EX3535 and add
or remove Fiery EX3535 servers from the list.
Setup* Opens the Setup options for the Fiery EX3535.
Manage Color* Opens ColorWise Pro Tools. For more information, see the

Color Guide.

Manage Font

Allows you to download fonts to the Fiery EX3535. You can
also delete fonts that you have downloaded to the
Fiery EX3535.

Align Trays*

page rrect for misalignments of the paper tray.

Allows yzi\h to adjust placement of the printed image on the

Printing Groups*

A the ki}ry EX3535 Administrator to set up printing

\

\groups.and passwords. For more information about Printing
g\ ups and Secured Print (Member Printing), see the
Copfiguration Guide.

Reorder Jobs*

Allows you to reorder the priority of jobs that are waiting to
process or print.

Restart Server

Allows you to restart the Fiery EX3535 without shutting
down the Fiery EX3535 hard disk drive. This command is
available only if you are logged in as Administrator.

NoOTE: After you restart the Fiery EX3535, you may need to
log in to the Fiery EX3535 again to reestablish the

connection.

Reboot Server

Allows you to restart the Fiery EX3535, after shutting down
the Fiery EX3535 hard disk drive. This command is
available only if you are logged in as Administrator.

NOTE: After you restart the Fiery EX3535, you may need to
log in to the Fiery EX3535 again to reestablish the
connection.

Job Log* Export* Exports the contents of the Job Log panel to a tab-delimited
text file.
Export and Clear* Exports the contents of the Job Log panel to a tab-delimited

text file, and clears the contents of the job log for the

Fiery EX3535.
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Menu

Command

Submenu command

Description

Clear Job Logt

Clears the contents of the job log for the Fiery EX3535.

Clear Server

Allows the administrator to clear or delete the following file
types from the currently selected server: Held Jobs, Active
Jobs, Printed Jobs, Archived Jobs - Server Internal, Archived
Jobs - Network Links, FreeForm Masters, Job Log, and Scan
Jobs.
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Menu

Command

Submenu command

Description

Server
(cont.)

Print Pages

Allows you to print the following information pages:
* PS Test Page

* Configuration

* Job Log

* Control Panel Map

¢ Color Charts

¢ PS Font List

* PCL Font List

* FTP Log

Command WorkStation also allows you to print the
following information pages about the Fiery EX3535 to the
local ptirter:

* Archive Log

e Queues

Suspend Printing

Suspends or pauses printing on the Fiery EX3535.

Resume Printing

Resumes printing on the Fiery EX3535.
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Menu

Command

Submenu command

Description

Window

Layouts*

Default*

Displays the following Command WorkStation
components:

¢ Menu bar

* Job Status Helper

e Action buttons

¢ Active Jobs window

¢ Jobs window

* Activity Monitor (selected server view)

Style 1*

Displays the following Command WorkStation
components:

¢ Menu bar

* Job status| indicators

¢ Action buttons

e Active Jobs window

Style 2*

Displays-the following Command WorkStation
components:

¢ Menu bar

* Job status indicators

* Action buttons

¢ Active Jobs window

* Activity Monitor (all servers view)

Custom 1,-Custom 2, or
Custom 3*

Sets the Command WorkStation window to a custom layout
previously defined and named using the Save Layout
command.
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Menu Command Submenu command Description
Window Save Layout* Allows you to save and name the current Command
(cont.) WorkStation display as a custom layout. Saved layouts
appear as commands in the Window>Layouts submenu.
You can save up to three custom layouts.
Jobs Window Switches the Jobs window (including the Printed Jobs,
Archive, FreeForm, and Job Log panels) on or off. A check
mark next to the command indicates that the Printed Jobs
window is displayed.
Activity Monitor Switches the Activity Monitor on or off. A check mark next
to the co;n\mand indicates the Activity Monitor is displayed.
. . \ .
Action Buttons* Swltc;és/t\l\jf; Action buttons on or off. A check mark next to
\;. 1 .
thmépKi indicates the buttons are displayed.
Job Status Helper* \Switéh%he Job Status Helper on or off. A check mark next
\ \\ . . . .
A\\ tg the command indicates the helper is displayed.
\ \
. . \ v\\/ . . . . . .
Tile Preview \| \Displays active Preview windows in tiled formation so that
Windows¥ //\\ the windows are simultaneously visible.
\
Cascade Preview \/ Displays active Preview windows in cascading formation so
WindowsT that the windows are stacked with their title bars visible.
Preview— <Job Activates the open Preview window of the named job. This
Name>* menu option appears for each open Preview window.
<Job Name>t Activates the open Preview window of the named job. This
menu option appears for each open Preview window.
More Previews* Opens a Previews window, where you can activate, close,
cascade, and minimize the open Preview windows.
Help* About Command Displays information about the current version of

WorkStation*

Command WorkStation.
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Context-sensitive menus

When you select one or more jobs in the Active Jobs or Jobs window, you can display
context-sensitive menus containing job management commands for selected jobs.

To DISPLAY A CONTEXT-SENSITIVE MENU

1.

Select one or more jobs in the Active Jobs or Jobs window.

For details on how to select jobs, see page 3-7.

Right-click the selected job (Command WorkStation), or Control-click the selected job
(Command WorkStation LE).

When multiple jobs are selected, you ean right-click or Control-click any of the

selected jobs.

Choose the desired command {from-.the context-sensitive menu.

Preparing to work with Command WorkStation or
Command WorkStation LE

This section déscribes'the setup and administrative tasks required to begin working
with Command WorkStation or Command WorkStation LE.

Connecting. to the Fiery EX3535

In Command WorkStation, you can maintain connections to multiple Fiery EX3535
servers simultaneously. In Command WorkStation LE, you can maintain a connection
to one Fiery EX3535 server at a time.

To CONNECT T0 THE FIERY EX3535

1.

From the Server menu, choose Log in/Log out.

The server list appears.

Select the Fiery EX3535 from the list of Fiery EX3535 servers you have connected to
before.
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The server list displays the Fiery EX3535 servers you can monitor and manage from
Command WorkStation or Command WorkStation LE. You can add and remove
Fiery EX3535 servers from the list of Fiery EX3535 servers you frequently monitor.

#: Login Server [<]

Name
; LLICY (255.255.255 255)

@ AERD (104112.13)

Key icon

Remove

Command WorkStation

Server List

| Name

s -, | 101114773 (10.11.147.73)

_ < RUSWG (10.10587)
Key icon |

=

£ cose )

Command WorkStation LE

|

Each row in the server list displays the name of a Fiery EX3535, the name of the copier
associated with that Fiery EX3535, and a Login button (represented by a key icon).

3. Click the Login button next to the Fiery EX3535 name to establish the connection.
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4. In Command WorkStation, click the Administrator, Operator, or Guest button, enter
your password and click Log In. In Command WorkStation LE, enter your password and

click the administrator, operator, or guest button.

Login : AERD E

e Administrator

Operator

ﬁ \ Guest

Command WorkStation

Login...

administralor

e, | Operator

guast

T

Pemtonmiemd

Command WorkStation LE

Printing Fiery EX3535 information pages

Use the Print Pages command to print information about the Fiery EX3535.
The pages provide useful reference information for setting up or troubleshooting the

Fiery EX3535.
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To PRINT FIERY EX3535 INFORMATION PAGES

1.

2.

In the Active Jobs window, select the Fiery EX3535 for which you want to print
information pages.

Note: To print information pages, you must be logged in to the Fiery EX3535 as

Administrator.

Choose Print Pages from the Server menu.

A dialog box containing the information page options appears.

Note: Local Printer options are available in Command WorkStation only.

Print Pages - AERD

Select Printer

% Server
 Local Prirker

Select Pages

[(PS Test Page

[ IConfiguration
[JJob Log
[CIControl Panel Map
[ IColor Charts
[|PS Fort List

[ |PCL Font List
[CIFTP Log

Print Pages - AERD

— Select Printer

" Server
& Local Prinker

Select Pages

[ larchive Log
[1Queues

Eriit... |

Eritif... | Cancel |

Server options

For Command WorkStation, in the Select Printer area, specify where you want to print

the pages.

Local Printer options

Server—The pages you specify are printed to the Fiery EX3535.

Local Printer—Allows you to print the Archive Log and Queues to any printer
installed on your Windows computer.
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4.,

In the Select Pages area, specify the pages you want to print.
Each set of pages contains specific information about the Fiery EX3535.
You can print the following pages from the Fiery EX3535:

PS Test Page—Allows you to confirm that the Fiery EX3535 is properly connected to
the copier, and provides color and grayscale samples to troubleshoot problems with the
copier or the Fiery EX3535. The following settings are among those listed on the Test
Page: Server Name, Printer Model, color settings, calibration information, and date
and time the Test Page was printed.

Configuration—Provides the current Fiery EX3535 and copier configuration. This
page lists general information about the hardware and software configuration of the
Fiery EX3535, current settings for all Setup options, information about the current
calibration, and the network addres the Fiery EX3535.

Job Log—Lists a log of the last 55\jobs essed or printed. For information on the
fields in the Job Log and prin itin.other forms, see “Using the Job Log” on
page 3-20.

Control Panel Map—Provides an overview of the screens you can access from the
Control Panel. Fot information on using these screens to set up the Fiery EX3535, see

ides samples of the RGB, CMY, and PANTONE colors available

PS Font List—Lists all PostScript fonts currently resident on the Fiery EX3535 hard
disk drive.

PCL Font List—Lists all PCL fonts currently resident on the Fiery EX3535 hard disk.

FTP Log—Lists a log of the last 55 scanned jobs that have been sent over the network
using the Scan to FTP feature. The FTP scanning feature must be enabled in Setup
before the FTP Log can be printed. For more information, see the Printing Guide.

When you select the Local Printer option in Command WorkStation, you can print
the following pages:

Archive Log—Lists all jobs displayed in the Archive panel.
Queues—Lists all jobs displayed in the Active Jobs window.
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5. Click Print.

Fiery EX3535 information pages printed with the Print Pages command appear in the
Fiery EX3535 Job Log with the user name Operator, even if you logged in as
Administrator.

Setting preferences

The Preferences dialog box controls application settings.

TOo SET PREFERENCES FOR COMMAND WORKSTATION*

1. Choose Preferences from the Edit menu.

The Preferences dialog box is displaﬁ\\
x4

—E |
General

[T Enable Arimation
¥ Autologin [ Enable ToolTips

Temporary path: ID\TEMP Browse... |
r— Impogition
Units: IPoints 'l

Template Path: IE:\Program Files\Common Files‘Ele  Browse... |

— Search
Template Paths: I Browse... |
—Job Log
Riecords Limit (min 500, max 99939) 500

Export File Format:
' Comma Separated
' Tab Delimited

()8 I Cancel
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Specify the desired preference settings, and click OK to save your settings.
The following preferences can be specified:

Enable Animation—Enables the display of animated graphics in the Selected Server
view of the Activity Monitor (see page 2-9).

Autologin—Instructs Command WorkStation to remember the last access level and
password used to log in to each Fiery EX3535. When you log in to the Fiery EX3535
again, Command WorkStation automatically populates the Login dialog box with the
previous access level and password.

Enable ToolTips—Enables the display of ToolTips, or context-sensitive text which
appears when you move the mouse pointer over particular buttons and options in
Command WorkStation.

Temporary path—Specifies the fold e Command WorkStation temporarily stores

copies of the jobs you edit or change. Change the temporary path by clicking Browse
and specifying a folder. <\\
\

thb gmts of measurement used to display attributes, such

Imposition: Units—Sp

as page sizes and custom siz

in'the Job Properties dialog box and Imposition

window.

Imposition: h—Specifies the folder where template files for imposition are
stored for ange the template path by clicking Browse and specifying a
folder.

Search: Template Paths—Specifies the folder where Find/Search templates are stored
for later use. Change the template path by clicking Browse and specifying a folder.

TO SET PREFERENCES FOR COMMAND WORKSTATION LE¥

1.

Choose Preferences from the CWS LE menu.

The Preferences dialog box is displayed.
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(@] Preferences

[ show Import Options Dialog

] Use Metric Units

g Show Animations

Come ) (@

2. Specify the desired preference settings, and click OK to save your settings.

LE to display values that you'enter manually in the Job Properties dialog box.

jon %a bles the display of animated graphics in the Activity Monitor

Correcting tray alignment*

The Tray Alignment feature in Command WorkStation allows you to adjust the
placement of text and images on the page so they are correctly aligned on the sheet of
paper, or both sides of a duplex sheet have exactly the same alignment.

You can perform tray alignment from the Fiery EX3535 Control Panel by choosing
Tray Alignment from the Functions menu.

Note: To perform tray alignment, you must be logged in to the Fiery EX3535 with
Administrator privileges.
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TO ALIGN TEXT AND IMAGES FOR PRINTING*

1.

3.

4.

In the Active Jobs window of Command WorkStation, select the connected
Fiery EX3535 for which you want to perform Tray alignment.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to
display it.
Choose Align Trays from the Server menu.

A dialog box containing the Tray Alignment options appears.

Paper Tray Alignment - AERD x|

1. Select trays

Tray Media
<tray sekection> j ILetter j

Last Alignment 171403

2. Print Alignment Page

IV Prirt duplex Frirt |

3. Enter alignment values

Side 1 Side 2
& B © & B ©
If IE If If IE 25 Defaults |

4. Apply alignment values

Apply | Check alignment |

Done

Choose the tray you want to align from the Tray menu.

Choose the paper size loaded in the tray from the Media menu.

Note: The Tray Alignment is specific to the combination of tray and paper size
specified. If you align a given tray with Letter paper, and load Legal paper in that tray,
the alignment will be invalid. You must perform a new Paper Tray Alignment for each
combination of tray and paper size.

In the Print Alignment Page section, select the Print Duplex option to print a duplex
page, or clear the option to print a simplex page.
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10.

11.

Click Print to print the alignment page.

Once the page has printed, follow the directions on the alignment page.

Fold the page exactly in half horizontally, unfold it, and then fold it in half vertically.
When you unfold the sheet again, you will see that the fold lines cross three scales on
three sides of the page. Determine which number on the scale each fold line crosses.

In the Enter alignment values section, enter the value where the fold crosses each of
the three scales, marked A, B, and C, for Side 1. If you choose to align for duplex
printing, enter the values for the three scales on Side 2 of the page, as well.

Note: If you enter different values in A and C, the image will rotate, leading to uneven
areas on printed output. If this occurs, enter the same value in A and C.

When you have entered all of the alighment values, click Apply, and then click Check
Alignment to print the new alignment page.

To remove the alignments, select a tray and click Defaults in the Enter alignment
values section.

Click Done.

Managing Fiery EX3535 fonts

The Fiery EX3535 includes a number of built-in printer fonts. You can download
additional fonts’to the Fiery EX3535 using the Manage Font command in Command
WorkStation. Users on the network can also download fonts to the Fiery EX3535
using Fiery Downloader (see the Printing Guide).

Note: To manage fonts, you must be logged in to the Fiery EX3535 with
Administrator privileges.

Downloading fonts, either from Command WorkStation or with Fiery Downloader,
requires that the Direct connection be published in Setup (see the Configuration
Guide).

Note: You cannot download TrueType fonts. If you use TrueType fonts in Windows,
you can print them by converting them to Adobe Type 1 fonts. To convert TrueType
fonts with the Adobe PS printer driver, click the Fonts tab and set up the Font
Substitution Table, as necessary.
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To print a list of fonts currently resident on the Fiery EX3535, use the Print Pages
command (see page 2-27).

TO MANAGE FONTS

1. In Command WorkStation, in the Active Jobs window, select the connected
Fiery EX3535 for which you want to manage fonts.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to
display it.

Note: To manage fonts, you must be logged in as Administrator to the Fiery EX3535.



2-36 | Introduction to Command WorkStation and Command WorkStation LE

Click to update the Font List display

Click to download additional fonts

Click to delete font(s)

Click to print the Font List

Click to delete font

Click to download
additional fonts

2. Choose Manage Font from the Server menu.
ServerFonts x|
& Postscript & PCL
Marme
Sy Helvetica-Oblique a Update f
Locked fonts B Symbol :’ —I
S Timez-Bold Add...
5 Timez-Bolditalic .
5 Timez-talic Delste
& Timez-Roman —!
AvantlGarde-Book Frint... I
AvantGarde-BookOblique
Downloaded fonts Avant arde-Demi
Avantl arde-Demillhlinge: LI
ak. |
Command WorkStation
@06 Font List [
| |
. - " Print List ) ote Add... )
Click to print the Font List T e — ' { /
Typa Locked MNama
Both trua AdobaSansMM
Both trua AdobeaSanfMM m
Both trua AlbartusMT
Both trua AlbartusMT-Nalic
Both trua AlbartusMT-Light
Both trua AntiquaOinve-Bold
Both trua AntiquaOive-Compact
Both trua AntiqueOlive-italic
| Both trua AntiquaOiive-Roman
| Both trua Apple-Chancery
| Bath true AnakBold ItalicMT
Both trua Arial-BoldMT
||Bath true AriakitaicMT
| Bath trus ArialMT
Both trua AvaniGarde-Book
Both trua AvantGarde-BookOblique
Both trua AvantGarde-Dami
Both trua AvantGarde-DemiOblique
|4
Command WorkStation LE
3. Select the PostScript or PCL option to specify the type of fonts displayed.
4. To download additional fonts to the Fiery EX3535, click Add. For Command
WorkStation, refer to the procedure on page 2-37. For Command WorkStation LE, refer
to the procedure on page 2-38.
5. To delete a font, select it in the Font List and click Delete.
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6.

7.

To select multiple sequential fonts in Command WorkStation, select the first font and

Shift-click the last font; Cerl-click to select multiple non-sequential fonts.

Note: The printer fonts included with the Fiery EX3535 (built-in fonts) are locked.
These fonts appear with a lock icon next to the name (Command WorkStation) or
with “True” in the Locked column (Command WorkStation LE) and cannot be

deleted.

In Command WorkStation, to refresh the Font List, click Update.

To print the Font List, click Print (Command WorkStation) or Print List (Command

WorkStation LE).

To ADD FONTS IN COMMAND WORKSTATION*

1.

2.

In the Select Files to Import dialog box, choose the file types to display from the File

of type menu.

All Known Formats lists all files\in supported formats; All Files lists all files.

Select Files to Import E

Look in: I SAFonts j | &

lucar. i outlook. t . times. tf

mapsym. it raman.fon =1 10.tmp timeshd. tf

moder. fon Schibk.ttf sr1F.tmp time:shi.

msgothic. i Schibkb.tf symbal i tirnesi. tf

mtestra tf Schibkbi ti tahama.tf Timnreb. ttf

mtsorts Schlbki tf tahomabd tf 100001 _tf
(—] i

Filename: I"script.fon"

File of type: |4l Files (7] =l Cancel |

Filez to be imported:

CAWANNT YFontshmodern. fon

Add

Eemoye

[Hptions..

Logical Printer: IAero direct

il

j Import

In the Look in menu, browse to the folder containing the font(s) to download.

The Filename field displays the name of the selected file.
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3. Select the font name and click Add.
You can navigate to different drives and folders to select fonts to download.

To select multiple sequential fonts, select the first font and Shift-click the last font.
Ctrl-click to select multiple non-sequential fonts.

To remove a font from the Files to be imported list, select the font name and click
Remove.

4. When all the desired fonts appear in the Files to be imported list, click Import.

To ADD FONTS IN COMMAND WORKSTATION LE}

1. In the Open dialog box, navigate to the folder containing the font(s) you want to

download.
’ —
Open
| Select file
| From: | [ Fonts I ]
[ E.;p;;y:L . ™ 4 Apple LiGot...dium.dfont
L"Z. iy B m A AppleGothic.dfont m
L . ) Al AguaKanaBold.otf
4]

| Extensions.kextcache Aqua.KanaRegular,otf
) Courier.dfont
Extensions.mkext

Geneva.dfont

|7 Filesystems P :

[---- Find » = |4 Hei.dfont -
= Y rY
|..- Fanie g _\ r—fel\:'.etlcal,d‘r'?nt- +
Go to:

T 7 Ty :

’: Add to Favorites . Cancel | Open

2. Select the font name and click Open.
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3-1 | Starting up and logging in

This chapter describes how to use Command WorkStation and Command
WorkStation LE to monitor and manage job flow on the Fiery EX3535. Once you log
in to the Fiery EX3535 with Operator privileges, you can view jobs held on the

Fiery EX3535 and issue commands to release the jobs for processing or printing. You
can also modify job properties, such as FreeForm variable data printing requirements,
paper settings, finishing options, and other print option settings. After a job has
printed successfully, you can store it in the job archive, and view a record of its activity
in the Job Log.

For background information on jo% and job management, see Chapter 1. For an
introduction to the Command Wo Sta;ign and Command WorkStation LE user

O

interfaces, see Chapter 2.~ ,

Note: Unless otherwis%%ﬁ\e&,\ infofmation in this chapter applies to both
Command WorkStation ang \Command WorkStation LE. Sections that apply
exclusively to Co nd \WS{}Station are denoted by an asterisk (*). Sections that
apply exclusiv

yfo Gommand WorkStation LE are denoted by a dagger (1). In cases
ications are nearly identical, only Command WorkStation

where the

illustrati

Starting up and logging in

To begin working with Command WorkStation or Command WorkStation LE, start
the application and log in to the Fiery EX3535.

To START COMMAND WORKSTATION *

Click Start on the Windows taskbar, choose Programs >Fiery or All Programs >Fiery
(Windows XP only), and then choose Command WorkStation 4.

When you start Command WorkStation for the first time, the Login Server list does
not display any Fiery EX3535 servers. For instructions on configuring and adding
Fiery EX3535 servers to the Login Server list, see the User Software Installation Guide.
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To START COMMAND WORKSTATION LET

1.

Open the Command WorkStation LE folder, located inside the Applications folder on
the Mac 0S X hard disk.

Double-click the CWS LE file to start the application.

When you start Command WorkStation LE for the first time, the server list does not
display any Fiery EX3535 servers. For instructions on configuring and adding
Fiery EX3535 servers to the server list, see the User Software Installation Guide.

Logging in to the Fiery EX3535

To establish a connection to the Fiery EX3535 listed in the server list, log in to
the Fiery EX3535. ﬁ
\\\\\
In Command WorkStation you%k\?in\tjain connections to more than one
Fiery EX3535 ata tlme{f/é\z\-n qury EX3535 connection requires an average of 4MB of
RAM. The maximum faumber of;%lmultaneous Fiery EX3535 connections is limited
only by the amou RAM@allable on the system running Command WorkStation.
ti.sytem has 128MB of RAM and is running Command
ﬁ\@ you can log in to approximately 25 Fiery EX3535 servers at

For example, i
WorkStatio

one times

To LOG IN TO THE FIERY EX3535

1.

From the Server menu, choose Log in/Log out.

The server list appears.

Click the key icon for the desired Fiery EX3535.

The Fiery EX3535 must appear in the server list before you can log in to it. A white
key icon indicates the Fiery EX3535 has never been connected to Command

WorkStation or Command WorkStation LE.
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4 Login Server [x]

Niame

./; LUCY (255.255.255 255)

@ AERO (101112.13)
Key icon

Remove

Command WorkStation

| Name

s -, | 101114773 (10.11.147.73)

_ <@ | RUSWG (10.10587)
Key icon |

Remove button EI

Command WorkStation LE

|

If the Fiery EX3535 is already connected, the color of the key icon indicates the level
of access granted:

* Purple indicates Administrator access.
* Orange indicates Operator access.

* Cyan indicates Guest access.



3-4 | Using Command WorkStation and Command WorkStation LE

The Login dialog box appears.

Login : AERD E

Administrator

|

— Operator
m. Guest

Command WorkStation

Login... %

administralor

@ | Operator

guast

T

—t——

Command WorkStation LE

3. In Command WorkStation, click the Administrator, Operator, or Guest button, enter
your password and click Log In. In Command WorkStation LE, enter your password and
click the administrator, operator, or guest button.

This manual assumes you are logged into the Fiery EX3535 as Operator. The
following section discusses the three different access levels in greater detail.
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Access levels

The three possible levels of access to Command WorkStation or Command
WorkStation LE are Administrator, Operator, and Guest. To enable maximum
password protection, Administrator and Operator passwords must be specified in
Setup (see the Configuration Guide).

When both Administrator and Operator passwords have been specified, the access

levels are as follows:

Access level Privileges and password requirements

Administrator Has full access to all Command WorkStation and Command
WorkStation LE ions, as well as Fiery EX3535 Control Panel
function; Administrator password required. For a description of the full
range of tasks an administrator can implement, see the Configuration

Guide.

Operator H s t\ﬁﬂ Command WorkStation functions, except Setup,
entent, reordering job priority, restarting the Fiery EX3535,

caring the Fiery EX3535 hard disk drive, and clearing the Job Log.
perator password required.

Guest \Qa/n view job status, but cannot make changes to jobs or Setup, and

cannot access the Job Log; no password required.

NoTe: In Command WorkStation, a user may be logged in as Administrator on one
Fiery EX3535, as Operator on a second Fiery EX3535, and as Guest on a third
Fiery EX3535. In these instances, the levels of access are dependent either on the
Fiery EX3535 currently selected in the Active Jobs window or on the Fiery EX3535
that holds the currently selected job.

By default, no passwords are set on the Fiery EX3535—in this default state, anyone
can perform Setup and use all Command WorkStation and Command WorkStation
LE functions. Until an Administrator password is defined in Fiery EX3535 Setup, you
can log in to the Fiery EX3535 as an Administrator without entering a password, and

you are given full privileges.

After the administrator has performed Setup and specified passwords, Command
WorkStation and Command WorkStation LE user options depend on your login level.
This manual assumes that you are logged in to the Fiery EX3535 as Operator.
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Logging out
Logging out from the Fiery EX3535 terminates the connection between the
Fiery EX3535 and Command WorkStation or Command WorkStation LE.

TO LOG OUT FROM A CONNECTED FIERY EX3535

1.

2.

From the Server menu, select Log in/Log out.
Click the Login button for the connected Fiery EX3535 in the server list.
In Command WorkStation, click Yes to log out from and disconnect the Fiery EX3535.

Removing the Fiery EX3535 from the server list

You can clear unused Fiery EX3535 servers from the server list.

To REMOVE THE FIERY EX3535 FROM THE SERVER LIST

1.

2.

From the Server menu, select Log in/Log out.
Select the Fiery EX3535)\in the server list.

Click the‘Rémoyve button (trash can icon in Command WorkStation LE) to remove the
Fiery EX3535 from the list.

The Remove button is available only for disconnected Fiery EX3535 servers.

Monitoring jobs

The Active Jobs window and the Printed Jobs panel of the Jobs window provide a
visual way of monitoring the flow of print jobs through connected servers. In
Command WorkStation you can use the server selection menu in the title bar of each
window to monitor a single Fiery EX3535 or multiple Fiery EX3535 servers at once
(see page 2-12). You can also sort the job lists and customize the job ticket information

that is displayed.

The Active Jobs window displays jobs as they pass through the various stages of
spooling, holding, processing, and printing. Flag colors indicate the status of each job,
and job ticket columns provide additional job information. Jobs that contain raster
data as a result of processing are marked with a halo around their file icons.
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NotEe: If a job is paused during printing (by issuing the Suspend Printing command),
the job will continue to be marked with a dark green status flag in the Active Jobs
window. However, the job will be displayed as “Paused.”

When a job has completed printing (or has failed to print), it drops from the Active
Jobs window and is added to the Printed Jobs panel. The Printed Jobs panel displays
jobs that have printed successfully, along with failed jobs that have dropped from the
print queue as a result of an error. A failed job appears highlighted in red; you can
double-click the job to display a more detailed error report.

Selecting jobs

TO SELECT A JOB

Selecting a job allows you to apply %anagement commands (from the Actions
L
A\

menu) to it. s
\
\

\\
in \ahy panel of the Jobs window, click a job to select it.

In the Active Jobs window

To select multipl¢ jobs.in Comnmand WorkStation LE, hold down Shift and click

tiple jobs, the jobs must be located in the same window and panel.

Sorting job displays
You can sort jobs in the Active Jobs or Jobs windows by clicking the job ticket column

headings.

To SORT JOBS

In the Active Jobs or Jobs windows, click the heading for the job ticket column that
you want to use to sort jobs.

For example, to sort jobs by status, click the Job Status column heading. The window
sorts jobs according to their status.

To reverse the sorting order, click the column heading again.
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Customizing job ticket information

You can customize the display of job ticket information in the Active Jobs window and
in all panels of the Jobs window by rearranging the column headings. You can tighten
the columns, add new column headings, move columns, and delete column headings.

Job Status | Job Title | |ser | Dake/ Time | opies | Size

You can customize job ticket information according to your workflow needs.
For example, if you are monitoring multiple servers, you can add Fiery and Device
columns to track the Fiery EX3535 location of individual jobs.

In Command WorkStation, the information in the Date/Time column is based on the
date and time settings of the Regio ettings control panel. You can access the

Regional Settings control panel from the Start> Settings>Control Panel menu or
Start>Control Panel menu (Wind P only) in the Windows taskbar.

\
\\
AL

TO CUSTOMIZE JOB TICKET INFORMATION*@? THE ACTIVE JOBS
OR JOBS WINDOWS IN COMM RKSTATION*

1. Right-click of a job ticket column.

2. From the that appears, choose the options to display and the sequence in which
you want to view them.

Add—Adds one of the listed columns to the display at your mouse position. The
submenu lists the headings that are not displayed.

Move Left, Move Right—Moves the selected column left or right.
Delete—Removes the selected column.
The Job Status (Active Jobs window only), Job Title, and User columns are required—
all others are optional.
3. Adjust the column widths.

Adjust the width of a column by clicking the column border in the heading and
dragging to the left or right. You can change the column widths at any time.
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TO CUSTOMIZE JOB TICKET INFORMATION FOR THE ACTIVE JOBS
OR JOBS WINDOWS IN COMMAND WORKSTATION LET

1.

2.

Control-click the heading of a job ticket column.

From the menu that appears, choose Edit Visible Columns.

(@] List Editor

Job Status f << Add ) [Archive Path

Job Title S — Collate

User y Srm—— Create Master

Date/Time \ ! Destinati

Copies Device

Size Document Server
Document Server File Name|
Duplex

EFBindingMarginWd
EFBookletCenterMargin
Group Name

Input Tray

Instructions

Media Type j 1
[ —— — —_ BEIC

i A £

Cancel oK

4

In the List box, specify the job ticket columns that you want displayed.
To add a n, select the column name in the list on the right and click Add. To
remove a co , select the column name in the list on the left and click Remove.

Click OK to apply your changes.

Adjust the placement of columns.

Rearrange the placement of a column by dragging the column to the left or right.

Adjust the column widths.

Adjust the width of a column by clicking the column border in the heading and
dragging to the left or right. You can change the column widths at any time.

Managing job flow

The following sections describe the job management tasks you can perform with
Command WorkStation and Command WorkStation LE.
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Importing jobs

Use the Import command to import jobs into the job flow. You can import jobs
located anywhere in the connected network, or jobs previously archived to

external devices.

For information on archiving jobs, see page 3-25.

TO IMPORT A J0B INTO COMMAND WORKSTATION*
1. Choose Import from the File menu, and then choose Job or Archived Job.
The Select Files to Import dialog box appears.
2. Locate and select the job file to im@nd click Add.
The job appears in the Files tg\lﬂ%r list. To import multiple jobs, select each

additional job and click As .\\\\

\
n qgeue from the Logical Printer menu.

3. Choose the desired des

A destination quete is.available only if the administrator has enabled it in Setup

(see the Configura

S

If you choose H
future action

If you choose Prin, the job is imported into the Active Jobs window and released for
immediate printing.
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If you choose Direct, the job is sent directly to the Fiery EX3535 for printing. The job
does not appear in the Active Jobs window or Printed Jobs panel.

Select Files to Import [ x]
Lookin:— [Sucks =] E3
udit Background. pdf
& Dai epart,

[ Executive Sumary. pdf

Filename: |”Dai\y Mews Repart.pdf**

File of type: IAI\ Known Formats j Cancel

Files to be imported:

DM obshaudit Background. pdf m
Hemove
[ ptins.
Lagical Printer: I j Import

4. Click Import.

TO IMPORT A JOB INTO \w\)h RKSTATION LEft

1. Choose Importfrom the File menu, and then choose Job or Archived Job.

806 Open: CWS LE 3
From: [@EDesktop J :J
[@F Desktop 5 Archive
|+ Documents P E ArchiveAdd
& Library P EditColumns
= Movies P E ImportDialog
& Music > ~] ImportOptions
|z Pictures o JobProp
L& Public I LEJobProp
|1 sites P [ osx [
| € 0sX.sea 4
| T Picture 1 X
Go to:
r : N € Y T
. Add to Favorites Cancel Open

4

2. Locate and select the job file to import and click Open.
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3. If the Import Options dialog box is displayed, specify the desired destination queue
and then click OK.

You can control the display of the Import Options dialog box by specifying the
“Always show this dialog” option or setting the Show Import Options Dialog
preference (see page 2-31).

A destination queue is available only if the administrator has enabled it in Setup

(see the Configuration Guide).

If you choose Hold, the job is imported into the Active Jobs window and held for
future action.

If you choose Print, the job is imported into the Active Jobs window and released for
immediate printing.

If you choose Direct, the job is sen ly to the Fiery EX3535 for printing. The job
does not appear in the Active Jobsswindow: or Printed Jobs panel.
A
(@] Import Options ¥
Import Options

Aero hold Iv]

W Atways show this dialog.

T ———

Using job management commands

As the operator, you can issue the following job management commands from the
Actions menu to release or hold selected jobs in the Active Jobs window and Printed

Jobs panel:

e Print

* Process and Hold

¢ Print and Hold

* Remove Raster Data

¢ Hold
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The availability of each command varies, depending on the context of the selected job.

In addition to choosing these commands from the Actions menu, you can issue them

from context-sensitive menus. Activate the Print, Hold, and Process and Hold

commands using the Action buttons.

The following table describes job management commands in greater detail and

explains how each command affects the raster data associated with a job:

Choose this command

To do this

Raster data is

Print Prints the selected job in the Active Jobs Temporarily held on the Fiery EX3535 until
window, Printed Jobs panel, FreeForm the job completes printing.
panel, or Archive panel.
A
Hold Held on the Fiery EX3535 hard disk drive

Holds the selected job waiting to process i\/
the Active Jobs window, or thc(s? ed.job
in the Printed Jobs or Archi F}ghel, a

marks the job with eithert po\b\l‘%d/held
flag or the processed/held flag. \

indefinitely, if raster data is included with
job.

Process and Hold

held flag.

Held on the Fiery EX3535 hard disk drive
indefinitely.

Print and Hold

Prints the selected job in the Active Jobs
window, Printed Jobs panel, or Archive
panel, and holds a copy of the job. The
copied job is marked with the processed/
held flag.

Held on the Fiery EX3535 hard disk drive
indefinitely.

Remove Raster Data

Removes the raster data associated with the
selected processed/held job in the Active

Jobs window, or with the selected raster job
in the Printed Jobs or Archive panel; leaves

the original PostScript or PCL data in place.

Deleted.
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Viewing and overriding print settings

When logged in as Operator, you can view, override the user print settings, and print
any held job in the Active Jobs window and the Printed Jobs panel. You can view and
override print settings of jobs in the FreeForm panel. You can view print settings, and
print jobs in the Archive panel.

Use the Job Properties dialog box to view the user Notes and Instructions fields

included with jobs.

TO VIEW AND OVERRIDE PRINT SETTINGS

1.

To view and override print settings fora held job, select the job in the Active Jobs
window or Printed Jobs panel.
ive o

You can also select a job in th reeForm panel to view print settings.

Choose Properties from ctions menu.

The Job Properties dialog box appears. This dialog box displays all the job settings
encoded by the PostSeript prirter driver that can be decoded by the Fiery EX3535. If

¢ a e not changed anything, these are the settings a user entered
e JOD

The Job Propérties dialog box is virtually identical to the Fiery Printing tab of the
Fiery EX3535 print driver. For more information on the features in the Job Properties
dialog box, see the online help included with the Fiery EX3535 print driver.

you, as the o

Job Properties - Bighuma.pdf x|
Capie: Job Template: r
1 = Defaultdob Templates | [ @) | [ = Page Size Input Tray
’VI 2 ’VIE Bl =1 LaslLEF  Luto Tiap Select
0 +| | MediaType  Duplex
. Clse Machine  -0ff
~2Page Size Settings
8 5w11 LEF «|  Custom.
All Page:
Input Tray Media Type
IAuln Tray Select j | Use Machine Settings j
@ Mined Wadia
nana salsctod
Defre.
N T .
2 Tray Alignment =l /= XE ROX E

0k | Concel | Pit | Pint Properis |

Command WorkStation
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[§] Job Properties
Shortcuts
" Page Size Input Tray
EgH st L 8.5x11 LEF L Auto Tray Select
Metia Type Duple
L use Machine Settings L Off
Mixed Media In Use No
= Tray Alignment Printer's default
= Scale to Fit Off
Input Tray Auto Tray Select
Media Type Use Machine Settings
Transparency Interleaving |Off
Slip Sheet ‘off
Slip Sheet Paper Source Tray 1
= Slip Sheet Page Size 8.5x11 LEF
= Page Size 8.5x11 LEF

} Destination

b Layout

} Finishing »

A\
Command WorkStation LE N

The user Instructions and Notes\fields also appears in the Job Properties dialog box.

“
i il

OK Cancel
il — i

&

* Instructions fi ¢ intended to be viewed and annotated by the operator, but

their cont sociated with the job and are deleted when the job is deleted
after print
* Notes fiel n be viewed but not changed by the operator; their contents are

transcribed to the Job Log just as the user sent them.

NoTE: Some print options available in the printer driver are not displayed in the Job
Properties dialog box. For information on specific print options and settings, and
where they can be set, see Appendix A of the Printing Guide.
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3. To override a setting, expand the blue bar for that print setting category and specify
the desired setting.
Note: To retain a copy of the job with its original settings, duplicate the job and
rename the duplicate before you change any settings.
Note: For some options, changing the setting requires that the job be reRIPped; these
options appear with an icon to the left of the option name.
E
Copie: Job Template: Sh
= = e Page Size Input Tra;
’Vh E ’VIEDEF&UMDHEMD‘mj Y ES ‘ UBBATLEF Lo Ty Sl
ﬂ Media Type  Duplex
“Use Machine -0
~ Page Size Settings
Indicates reRIPping is required B5:11 LEF | Custom..
—All Page:
Input Tray Media Type
IAutn Tray Select j IUSE Machine Settings j
*@ Mixed Media
Ao s tad
Define... Printer
o B y
2 Tray Alignment ZE XEROX E
0K | Cancel | Pint | Pint Properies |
4. To print th\eﬂgent list of print settings on a local printer, click Print Properties.

5. To apply the print setting overrides to the selected job, click OK.
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Reordering jobs*

If you are logged in to Command WorkStation as an Administrator, you can reorder

the priority of jobs that are waiting to process or print.

To REORDER JOB PRIORITY

1. In Command WorkStation, choose Reorder Jobs from the Server menu.

lalx]
Job .. | Jok Tite | User | Datermime
vyaiting EditCalumns podf pamiu 3025/2003 2:36:59 2 — . . . . e
Wisiting testd puf hazima AIE003 23655 4 e | Click to move job to highest priority
vyaiting testd pof hazima 302602003 3:29:42 2
L
* | Click to move job up in priority
* | Click to move job down in priority
* | Click to move job to lowest priority
e | o
waiting to process
|
Done I Cancel |

2. Click the tab corresponding to the jobs that you want to reorder.
You can only reorder jobs that are waiting to process.

3. Select the desired job in the list, and use the buttons on the right of the dialog box to
reorder the job’s priority.

4. Click Done when you are finished reordering the job priority.

Managing jobs on multiple Fiery EX3535 servers*

Command WorkStation allows you to simultaneously connect to as many

Fiery EX3535 servers as your RAM resources allow. You can view and manage jobs
processed by multiple Fiery EX3535 servers from a single location and balance the job
load between servers of similar capabilities.
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¢ If you connect to multiple servers from Command WorkStation, you can easily
switch between the All Servers view and the Selected Server view in the Active Jobs
window, Jobs window, and Activity monitor. For more information, see

“Monitoring single or multiple Fiery EX3535 servers*” on page 2-12.

* With servers that support the feature, you can use the “Send to” command to
transfer jobs between servers. Note that you can not transfer raster files between
servers. If you attempt to transfer a raster file, the source version of the file is
transferred instead.

For example, by viewing print jobs on all connected servers in the Active Jobs window,
you can monitor the print load on each Fiery EX3535 in your printing environment.
If one Fiery EX3535 has received a disproportionate number of jobs, you can balance
the load by transferring some of thése’jobs to another, less active Fiery EX3535.

NS

TO TRANSFER A JOB BETWEEN SERVERS X
1. In the Active Jobs window, select’any held job.
2. In the Actions r @ lect Send To and select the Fiery EX3535 to which to send the

job.

3. Click Yes firm the transfer of the job.

Canceling jobs

You may need to cancel a job after it has been routed for processing or printing.
You can cancel a selected job only while it is being processed or printed. You cannot
cancel a job that is waiting to be processed or printed.

* Canceling jobs during processing—While a job is processing in the Active Jobs
window, select the job and choose Cancel Processing from the Actions menu or
choose Cancel Job from the Fiery EX3535 Control Panel.

When the job is canceled, a Canceling message appears on the Fiery EX3535
Control Panel. The name of the canceled job is displayed in the Job Log.
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* Canceling jobs during printing—While a job is printing in the Active Jobs window,
select the job and choose Cancel Printing from the Actions menu or choose Cancel
Job from the Fiery EX3535 Control Panel.

When the print job is canceled, a Canceling message appears on the Fiery EX3535
Control Panel. The name of the canceled job is displayed in the Job Log.

Note: Canceled jobs may be partially printed, and may include pages with one or
more missing color plates, or pages that are completely blank.

* Canceling a job at the Control Panel—From the Fiery EX3535, the most direct way
to cancel a job is to press the top button on the Fiery EX3535 Control Panel while
reading the name of the job that is processing or printing. For more information on

the Control Panel, see the Configupition Guide.

* Pausing all jobs on the Fiery 535 hoose Suspend Printing from the Server
menu to suspend the print jobs’on the Fiery EX3535. To continue printing
jobs, choose Resume Printing\from'the Server menu.

Note: Inserted blank media between pages are not charged as printed pages.
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To DEFINE MIXED MEDIA SPECIFICATIONS*

1. In Command WorkStation, select a spooled/held job in the Active Jobs window, and
choose Mixed Media Setup from the Actions menu.

The Mixed Media dialog box appears. This dialog box lists any previously defined

media settings and includes buttons for adding, modifying, and deleting settings.

Mixed Media v1.2

- Chapter
Chapter start

| Define each chapter 2v 2
sepaiate frishing set

—@ Defins Mixed Madia
Page Range

Media Type |Document Default -

Duplex |Document Default -
Input Tray | Document Default -

sl | Wedfy |

Fenove |

X

Selection List

Page Range | Duplex

| Media Type | Input Trap

Bedy oF Usa Machine Senings Auto Tray Setser

Carcel

In the Pagekge field, enter page numbers or page ranges that should be printed on
a distinct type of media.

Pages and page ranges may be entered as comma-separated values
(for example: 3,9-14,18). You can insert blank pages by placing a
caret symbol before a page value (for example: 2,47,9-16).

Choose the desired duplexing option for the page range from the Duplex menu.
Choose the desired options from the Media Coating menu and Coating Type menu.
Choose the desired color of media from the Media Color menu.

To use media that is pre-printed or pre-punched, choose the desired option from the
Pre-Printed Media menu or the Pre-Punched Media menu.

Choose the desired weight of media from the Media Weight menu.

Choose the desired media for the specified page range from the Media Type menu.
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10.

11.

12.

13.

14.

15.

To print pages on tab paper stock, choose True from the Tabs in Page Range(s) menu,
and then choose Tab Stock from the Media Type menu. By default, tab printing is set
to False.

By default, duplexing is set to Off.
Choose the source tray containing the specified media type from the Input Tray menu.

Click Add to add the media specification to the Selection List. To remove a mixed
media specification, select it and click Remove.

Define and add more mixed media specifications as needed. Page ranges not specified
as mixed media will print on the media defined by the Paper Source settings.

In the Chapter Start field, enter page numbers on which to start new chapter sections.

Enter page numbers as comma-separdted\values (for example: 4,9,17) to designate the
start of each new chapter. This feature forces each starting page to use a right-side page,
adding a preceding left-sided blank;if'necessary.

NoTE: It is not necessary to\entex the first page, and page numbers refer to the
numbering of the original decument. If you use the Chapter Start feature, all media
specified in the Paper popup menu per chapter must share the same dimensions (for
example: allletter, all rabloid, or all A4).

To apply finishing options (for example, stapling or sorting) to each chapter section
created using the Chapter Start feature, select “Define each chapter as a separate
finishing set.”

Click OK.
The Job Properties dialog box is displayed.

If you have specified certain page ranges to be printed on tab paper stock, open the
Paper Source drop-down bar in the Job Properties dialog box, and select the Tabs in
Page Range(s) option in the Mixed Media area.

Click OK to close the Job Properties dialog box and apply the Mixed Media settings to
the job.
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Printing Fiery FreeForm variable data documents

The FreeForm printing feature provides a flexible and efficient method of printing
variable data jobs (such as direct-mail advertising pieces). Fiery FreeForm allows users
to preRIP and store the master elements of their variable data jobs on the

Fiery EX3535, and then use that master data as needed, for multiple variable data jobs.

Note: FreeForm is not available for PCL jobs.

The preRIPped master-element jobs are stored on the Fiery EX3535 as FreeForm
masters, and appear in the FreeForm panel of the Jobs window.

The ability to override job settings is cially important for variable data printing
with Fiery FreeForm. Although theﬁlﬁx3535 can store up to 100 FreeForm
masters, users are limited to a range of 1\t0,15 values that they can specify for the
Create Master and Use Masté?\grin tings. To make use of all 100 available

to\r\ ust override the Create Master and Use Master print

Station or Command WorkStation LE.

FreeForm Masters, the ope:

settings from Command

Note: For any n¢
reRIPped.

eate Master or Use Master setting to take effect, the job must be

For background information on using the Fiery FreeForm feature, see the Printing

Guide.

Creating and monitoring FreeForm masters

Users can assign FreeForm master numbers from 1 to 15 using the Create Master
print option when they send a job. These numbers can be changed to a master number
from 1 to 100, with job overrides from the Job Properties dialog box.

When the first 15 FreeForm master numbers have been used, users may inadvertently
overwrite existing FreeForm masters by assigning what they think are new, unused
FreeForm master numbers. When users choose a master number from the Create
Master print option, an existing job using that master number is overwritten (the user
receives a warning message that they are about to replace an existing job).
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For this reason, the Operator should delete existing master jobs or reassign master
numbers 1 through 15 to avoid any overwriting problems. Only the Operator can
assign numbers from 16 to 100, enabling a high level of control over the FreeForm

master numbers in use.

TOo CREATE A FREEFORM MASTER
1. In the Active Jobs window, select the held job comprising the master elements of
the document.
2. Choose Properties from the Actions menu.
3. Scroll to FreeForm in the Job Properties dialog box.
4. For the Create Master print setting, specify the FreeForm master number you want to
assign to the job.
5. Click OK.
6. Choose Process and Hold from\the Actions menu to assign the job a destination.
Choose Print, of Print and Hold from the Actions menu for a hard copy of the
FreeForm master.
After processing, the’master job appears in the FreeForm panel of the Jobs window.
To DELETE A FREEFORM MASTER
1. In the FreeForm panel, select the master job to delete.
2. Choose Delete from the Actions menu.

Using FreeForm masters with variable data jobs

To print a variable data job with a particular FreeForm master, users must specify a
number for the Use Master print setting. Users can only specify master numbers
between 1 and 15. Only the operator can specify master numbers between 16 and 100,
with job overrides from the Job Properties dialog box.
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To OVERRIDE THE USE MASTER PRINT SETTING

1.

In the Active Jobs window, select the held job comprising the variable elements of the
document, and choose Properties from the Actions menu.

Scroll to FreeForm in the Job Properties dialog box.

For the Use Master print setting, specify the FreeForm master job to use as the master
document.

Click Update.
To display a preview of the specified master job, click Preview Master.
Click OK.

Choose Process and Hold, Print, or-Print'and Hold from the Actions menu to assign
the job a destination.

Particularly with a variableidata job, Process and Hold the job so you can preview it
before printing.

Tips for using Fiery FreeForm

At sites whefe 4 small iumber of users print FreeForm jobs, the Operator may want to
assign FreeForm master numbers to specific users, then let them monitor their own
master numbers. Users can choose the Create Master print option to assign new
masters or overwrite existing masters. They can also instruct the Operator to reassign
master numbers (to a number greater than 15) for FreeForm masters they want
available on the Fiery EX3535.

At sites where a large number of users print FreeForm jobs, the Operator may want to
instruct users not to use the Create Master print option at all, but rather to send all
their jobs to the Hold queue. In this case, the Operator can decide which FreeForm
master numbers to assign before printing.

For all jobs sent to the Fiery EX3535, users should specify information (such as the
desired FreeForm master number) to the operator using the Notes and Instructions
fields in the Printer Job Notes dialog box.
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NoTe: When specifying additional print settings for FreeForm jobs, certain print
option settings must match for bozh the master and the variable job. Also, certain
settings in the variable job override corresponding settings in the master job. For
complete information on print settings in FreeForm jobs, see the Printing Guide.

Archiving jobs

You can archive PostScript and raster data jobs internally to the Fiery EX3535 hard
disk drive, or externally to the Command WorkStation or Command WorkStation LE
hard disk drive or network drives. Once a PostScript or raster data job is archived, it
appears in the Archive panel of the Jobs window.

You can issue the following Actions commands, described on page 2-15, for jobs
in the Archive panel:

e Print %
¢ Delete

e Rename

e Hold

¢ Print and H
¢ Remove Raster Data

* Properties

TO ARCHIVE A JOB

1. In the Active Jobs window, select any held job.
2. Choose Archive from the Actions menu.

3. To archive the job internally to the Fiery EX3535 hard disk drive, click OK.

The job is archived internally and appears in the Archive panel of the Jobs window.
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4. To archive the job externally to the Command WorkStation or Command WorkStation

5.

LE hard disk drive or to a device on the network, click Add.

Archive Options E
Directories
|
Add ..
—= Click to add a device

[Velete |

= erctiveiasters

Cancel |

Browse to the device and folder to which you want to archive the job and click OK
(Command WorkStation) or Chogse (Command Workstation LE).

The Archive Options dialog box displays external devices as available archive volumes.
In Command WorkStation, if applicable, select Archive rasters in the Archive Options
dialog box.

The Archivetasters option is not available for PostScript data jobs and jobs archived to

Server Interhal

Note: Large raster data files may take considerable time to archive.

Select an archive volume and click OK.

Archived jobs appear in the Archive panel of the Jobs window.

Using the Job Log

The Job Log panel of the Jobs window displays a list of all the jobs processed or printed
since the Job Log was last cleared.

You can adjust the column widths in the Job Log display by clicking the column
border in the heading and dragging left or right (see “Customizing job ticket
information” on page 3-8). You can also print the Job Log, export it to a tab-delimited
text file, or clear it manually.
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Using the Job Log Setup, the administrator can specify preferences to print the Job Log
automatically every 55 jobs, or print and clear the Job Log automatically every 55 jobs.
Periodically clearing the Job Log can help improve the performance of the

Fiery EX3535. The administrator can also choose the Job Log page size. For more
information, see the Configuration Guide.

Note: If a job was saved from the Imposition window of DocBuilder Pro with a new

name and then printed, it appears in the Job Log with the name of the original job, zor
the new name.

DateiTime
[s]%¢ [ hittp:ifwenee raman... PAT 312003 5:18:20 PM 311 KB
[s]%¢ [ hittp:ifwenee raman... PAT 3200351752 PM 256 KB —
[s]%¢ [ hittp:ifwenee raman... PAT 320351721 PM 253 KB
[s]%¢ [ hittp:ifwenee raman... PAT 312003 5:16:37 PM 343 KB
[s]%¢ [ Dsfinaloutput? pdf Leslie 312003 4:51:43 PM 4573 KB
o]'4 [4 start Page Operator 312103 44311 PM 1201 KB
o]'4 [4 start Page Operator 31203 41525 PM 1201 KB
o]'4 [ Online Membership... sam 3112103 4:05:06 PM 46 KB
o]'4 [4 start Page Operator 312103 4:03:35 PM 1201 KB =
Job Log

To PRINT THE JOB L0G FROM COMMAND WORKSTATION ON A
LOCAL PRINTER*

1. In Command WorkStation, choose Print from the File menu and then choose Job Log.

The Print dialog box appears.

2. Specify your local printer settings, and click OK.

To EXPORT THE JOB L0G

1. If it is not already displayed, click the Job Log tab on the Jobs window to open the
Job Log panel.

2. Click inside the Job Log panel to make it active.

3. In Command WorkStation, choose Job Log from the Server menu, and then choose
Export. In Command WorkStation LE, choose Export from the File menu, and then
choose Job Log.
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Rename the file, if desired (the default name is job.log), specify a destination, and
then click Save.

The Job Log is exported to a tab-delimited text file. You can open the exported file
using a spreadsheet, database, or word processing application.

TO CLEAR THE JOB L0G

In Command WorkStation, choose Job Log from the Server menu and then choose
Export and Clear. In Command WorkStation LE, choose Clear Job Log from the Server
menu.

NoTE: You can clear the job log only if you are logged in to the Fiery EX3535 with
Administrator privileges.

Searching for jobs

The Find command allows'you to search for and locate jobs on connected servers,
using search parameters stich as job file names or dates of creation. Use the Find
command to search for jobs'that appear in the Active Jobs window and in the Printed
Jobs, Archive, BreeForm, and Job Log panels of the Jobs window.

In Command WorkStation you can also perform advanced searches based on the file
sizes and specific print options associated with jobs. You can save any set of general or
advanced search parameters as a Find template, which you can reuse to perform the

search again.

To SEARCH FOR JOBS

1.

Choose Find from the Edit menu.

The Find dialog box appears.

In Command WorkStation, choose a specific Fiery EX3535, or all Fiery EX3535 servers
from the Search Server list.

Select one or more areas where you want to search for jobs.

You can search for jobs in the Active Jobs window and in the Printed Jobs, Archive,
FreeForm, and Job Log panels of the Jobs window.

Click the General tab, and specify parameters for the search.
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Note: To clear all fields in the Find dialog box at any time, click New Search
(Command WorkStation) or New Find (Command WorkStation LE).

You can specify any or all of the following general search parameters. Available search
parameters vary, depending on the areas selected for the search.

Job title—Enter the file name of the job.

User—Enter the name of the user who sent the job.

Notes 1, Notes 2—Enter text that appears in the Notes fields of the job.
Instructions—Enter text that appears in the Instructions field of the job.

Volume*—Specify the archive drive volume you want to search. This option is
available only when you are searching for archived jobs.

Date created*—To search through all jobs, regardless of their creation date, select All.
To restrict your search to jobs cr; ted on a certain date or range of dates, select Range.

) Nee \
Use the From and To menus o $pecify start and end dates.
W\

Click Search (Command&g}St\\aﬁpn) or Find (Command WorkStation LE) to find the
jobs that meet the specifie \?a?@h criteria.

\

The Search Resu /\ihgiow (Command WorkStation) or the Find dialog box
(Command Wo ion LE) lists found jobs.

Station, you can customize the appearance of the Search Results
window in the'same manner as the Active Jobs and Jobs windows. For example, you

can display jobs on all connected Fiery EX3535 servers or on a selected Fiery EX3535
(see page 2-12), and you can customize the job ticket information (see page 3-8).

In Command WorkStation LE, you can customize the display of found jobs by resizing
or rearranging the job ticket columns (see page 3-9).

TO PERFORM AN ADVANCED SEARCH FOR JOBS*

3.

NoTe: The Advanced search feature is available for Command WorkStation only.

Choose Find from the Edit menu.

The Find dialog box appears.

Choose an option from the Search Server menu to search for jobs on a specific
Fiery EX3535, or all connected Fiery EX3535 servers.

Select one or more areas to search for jobs.
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Search for jobs in the Active Jobs window and in the Printed Jobs, Archive, FreeForm,
and Job Log panels of the Jobs window.
Click the Advanced tab.

The Advanced tab of the Find dialog box includes an area for specifying file size search
parameters. The Advanced tab also contains a list of all the print options associated
with jobs on the server or servers specified by the Search Server setting.

To search for jobs that fall within a particular range of file sizes, choose a range option
from the Size (kilobytes) menu. Enter the range values in one or both of the fields.

To search for jobs that have certain print options, click the selection box for each
desired print option in the list.

To specify additional search values fordlselected option, right-click the field next to the
option name and enter the desired values.

If you select multiple print options; Command WorkStation searches for jobs that
include a// the selected options. For example, if you specify a stapling and a punching
option for your search, Command WorkStation only finds jobs that have both stapling
and punching specified.

NoTe: To cleas allfields in the Find dialog box at any time, click New Search.

Click Search tofind the jobs that meet the specified search criteria.

The Search Restlts window lists the found jobs.

TO SAVE THE CURRENT SET OF SEARCH PARAMETERS AS A
FIND TEMPLATE

1.

In the Find dialog box, specify the desired search parameters, as described in previous
procedures.

Click Save As.

A dialog box appears, prompting you to name the template.

Enter a name for the new Find template and click OK.

Saved templates appear in the Queries menu. To remove a template from the menu,
select the template and click Delete.

In Command WorkStation, saved templates are stored in the folder location you
specified in the Preferences dialog box (see page 2-30).
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To REUSE A FIND TEMPLATE
1. In the Find dialog box, choose the desired template from the Queries menu.

The dialog box is automatically populated by the search parameters associated with the
template.

2. Click Search (Command WorkStation) or Find (Command WorkStation LE) to begin
searching for jobs.
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Chapter 4:
Previewing and
Manipulating

Jobs

The Preview windows of Command WorkStation and Command WorkStation LE
allow you to display preview images of jobs and perform edits, such as adding,
deleting, duplicating, and reordering pages. You can also merge pages from two
different jobs into a single, merged job.

Note: The viewing, editing, and merging features of the Preview windows are not
available for PCL files or any job sent with the PCL printer driver.

Note: The DocBuilder Pro option allows you to use additional preview and edit
features. For more information, see page 5-1.

Note: Unless otherwise specified, information in this chapter applies to both
Command WorkStation and Command WorkStation LE. In cases where the two
applications are nearly identical, only Command WorkStation illustrations are shown.

Previewing jobs

Use the Preview windows to preview pages of selected jobs.

Displaying thumbnail previews

When you select a job and choose Preview from the Actions menu, a preview window
opens, displaying thumbnail images of the selected job.

Note: Thumbnail previews are not designed to display color accurately. Do not use
thumbnail previews to soft-proof colors in a job. Instead, open a full-screen preview
and use the Soft-Proof feature described on page 4-4.

To VIEW THUMBNAILS OF A JOB

1.

In Command WorkStation, select a processed/held job in the Active Jobs window, or
select a FreeForm master job in the FreeForm panel. In Command WorkStation LE,
select a spooled/held or processed/held job in the Active Jobs window.

Choose Preview from the Actions menu.

Page thumbnails appear in the Preview window.
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Preview window controls

The following illustrations show the various controls (represented by icons) that are
available in the Preview window. Each control is described in more detail elsewhere in
this chapter.

Command WorkStation

#. Preview - BigNums.doc
Full-screen Preview ‘ ‘ F Undo
Save Delete
Duplicate l 2 3
-01- -02- -03-
1 | 3
Command WorkStation LE %
006 Preview: TabStock-MM
Full-screen Preview 0 i o T Redo
I
S
ave Undo
Delete | l 2 3 A
|
Duplicate | -
e ] )4 i
' .

Displaying full-screen previews
You can open a selected page in the Preview window as a full-screen image for a more
detailed inspection.

Note: Full-screen previews are not supported for FreeForm jobs.

To VIEW A FULL-SCREEN PREVIEW OF A JOB

e Select a page in the Preview window and click the Full-Screen Preview control (see
page 4-2).
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Note: The full-screen preview may take a few moments to open. The full-screen
preview window is independent of Command WorkStation or Command
WorkStation LE and may appear behind the application on the screen. Bring the full-

screen preview window to the front, if necessary.

Command WorkStation

eview - BigNums_doc

View previous and next pages FUT\ r(rf”TA

Return to small preview

Rotate page 90, 180, or 270

degrees
g o
Command WorkStation

Thumbnail

Previous Page

Next Page

Rotate (90, 180, or 270 degrees) 1
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Command WorkStation LE

re 00 Preview: TabStock-MM

Thumbnail ' im @ B = Scroll bar (to view other pages)

Zoom In : ‘ ‘ S Next Page
| 1

Zoom Out Previous Page
|

Rotate (90, 180, or 270 degrees) !

A

Use the controls (represented by icons) in the full-screen preview to change the zoom
level, rotate the page, display other pages, or return to the thumbnail preview.

Viewing soft proofs

If you have the Fiery Graphic Arts Package installed, you can use the Soft-Proof feature
to display an accurate color preview of your print job. The Soft-Proof feature applies a
specified color profile to the preview image to compensate for the unique display
characteristics of your color monitor. As a result, the preview provides a more accurate
representation of how the job will appear when printed on the Fiery EX3535.

NoTE: You can view soft proofs for processed/held jobs only.

To ENABLE SOFT PROOFING

1. Display a full-screen preview of the desired job, as described on page 4-2.

2. Select the Soft-Proof option, located in the top center of the full-screen preview.
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Click Load.

A dialog box appears, prompting you to select a monitor profile.

Locate and select the monitor profile for your monitor.

* If you are using the monitor that is part of the Fiery Advanced Controller Interface
option, select the monitor profile that shipped with the Fiery EX3535.

¢ Ifyou are using a different monitor, be sure to select a profile customized to describe
the characteristics of your particular monitor. Otherwise, the soft proof will not be
accurate.

For best results, use an application like EFI Color Profiler for Monitors to create a
custom profile of your monitor. If you cannot create a custom profile, reset your

monitor settings to factory defaults and use the generic ICC profile for your monitor

type.

Click Open.

The full-screen preview-now displays a soft proof of the original job, as interpreted
through the moniter profile you specified.

Editing and merging jobs
Use the Preview windows to reorder and edit the pages of a job, or merge pages from
several jobs inte’a single job.

Editing jobs

The Preview window includes controls that allow you to make page-level edits to a job.

To EDIT A JOB

1.

In Command WorkStation, select a processed/held job in the Active Jobs window, or
select a FreeForm master job in the FreeForm panel. In Command WorkStation LE,
select a spooled/held or processed/held job in the Active Jobs window.

The Preview window opens, displaying thumbnails of the pages in the job.
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2.

Select the pages you want to edit.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or
Command-click (Command WorkStation LE) to select multiple, non-sequential

pages.
Apply the desired edits.

To apply edits to the selected page, click any of the controls that appear under the title
bar of the Preview window (for an illustration, see page 4-2):

Full-Screen Preview—Opens a full-screen preview of the selected page (see page 4-2).
The full-screen preview allows you to rotate the selected page.

Duplicate—Duplicates the selected page.
Delete—Deletes the currently selec@ge.
Undo—Reverses recently perfor %

ned Cdi
\
Redo—Reapplies recently er£§its. This control is available for Command
\

WorkStation only. \\
\
\

To move pages within the Preview window, click to select the pages, and hold down the
mouse button 3 ag the selected pages to the new location.

Shift-click toselec

Command (Command WorkStation LE) to select multiple, non-sequential

iple, sequential pages; Ctrl-click (Command WorkStation) or

pages. Release the Shift, Command, or Curl key before moving the pages. If you move
the pages on top of existing pages, the pages are overwritten.

In Command WorkStation LE, a blue vertical line indicates the destined location of
the page you are dragging.
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In Command WorkStation, the following icons indicate the result of your action. If
the icon does not have an arrow, existing pages are overwritten and replaced by dragged
pages; if the icon has an arrow, the dragged pages are inserted.

Replace single page Replace multiple pages

% %

Move single page Move multiple pages
between two pages between two pages

[l

<«
Move single page
before first page

ove multiple pages
after last page

making edits, click the Save control (see page 4-2) to save the job.

Enter a new name for the editing job and click Yes (Command WorkStation) or Save
(Command WorkStation LE).

Merging jobs
Merging allows you to combine documents from different sources into a single file. For
example, you can combine covers and chapter head pages created in a page layout

application with text pages created in a word processing application. Or, you can
customize a slide presentation by inserting slides from a different presentation.

To merge pages from two different jobs, both jobs must reside on the same
Fiery EX3535.
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NoTe: When printing a merged job, Command WorkStation or Command
WorkStation LE generally gives priority to the print settings of the original jobs over
those of the merged job. Before merging two jobs, make sure that both jobs have been
processed using the common print settings desired for final output. For example, to
create a merged job that prints to duplexed pages, make sure both original jobs have
been processed with the duplex setting enabled. Overriding the print settings of a
merged job can produce unexpected results and is not recommended.

To MERGE PAGES FROM TWO DIFFERENT JOBS

1. Select a job, and choose Preview from the Actions menu.

2. Select another job, and choose Preview from the Actions menu.

The job is displayed in another Preview\window.
Note: To merge pages, both %%emde on the same Fiery EX3535.

A

#. Preview - BiglLetts doc

Source document preview

Destination document preview
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3.

In the source document Preview window, click to select the pages, and hold down the
mouse button as you drag the selected pages to the new location in the destination
document Preview window.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or

Command-click (Command WorkStation LE) to select multiple, non-sequential
pages. Release the Shift, Command, or Ctrl key before moving the pages.

To replace pages, drag the second preview pages on top of pages in the first Preview
window; to add pages, drag the pages to a new position between pages, before the first
page, or after the last page in the first Preview window.

Moving the selection over an existing page replaces the existing page with the one you
are moving. Moving the selection to the left or right of a page places the selection in
that location and renumbers the pages

In Command WorkStation LE, b@\ ical line indicates the destined location of
the selection you are dragging:] mand WorkStation, the cursor changes to
reflect the result of your a 'or\x:\\

Replace single page

v

eplace multiple pages

\Z

Move single page Move multiple pages
between two pages between two pages
< <«

Move single page Move multiple pages
before first page before first page
> >
Move single page Move multiple pages
after last page after last page

Multiple levels of undo are available; use the Undo control to undo all the way back to
your first edit. There is a Redo control.
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NoTE: After you drag pages from one Preview window to the other, the first window is
designated as the source, and the other window the destination. During a merging
session, you can drag pages only from the source window to the destination window,
not vice versa. To merge pages in the opposite direction, you must save your current
changes to the destination window and begin a new merging session.

To merge additional pages from another source job, open a new job (resident on the
same Fiery EX3535) in a Preview window.

Repeat step 3 to merge pages from the new source job.
When you have finished merging pages, click the Save control (see page 4-2).

Enter a new name for the merged job, and click Yes (Command WorkStation) or Save
(Command WorkStation LE).

\

Note: When multiple users are don ecte@o the Fiery EX3535 via a job management
utility, only one user should make changes at a time. If multiple users make changes in
the same job simultaneo u\m\éi(pected results might occur.

W
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DocBuilder Pro
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The DocBuilder Pro option allows you to apply imposition layouts to jobs for special
printing and binding needs. DocBuilder Pro also provides several enhancements to
the previewing, editing, and merging features of Command WorkStation.

For background information on using imposition, see Appendix A. For information
on customizing imposition settings, see Chapter 6.

Note: DocBuilder Pro is available as an optional upgrade for Command WorkStation.

For more information, contact your authorized service/support technician.

Previewing, editing, a erging jobs

With the DocBuilder Pro optio can-use the Preview windows of Command
WorkStation to preview, edit, ahd merge PostScript and PDF jobs that have been
spooled and held. You ¢an
held jobs and processed/held

: plir\ all of the features discussed in Chapter 4 to spooled/
\J .
obs alike.

Detailed descri @f the DocBuilder Pro enhancements to the Preview windows

follow.

icable, page number references to sections in other chapters are

provided.

Previewing jobs—You can select any PostScript or PDF job showing a spooled/held
(light yellow) status, and open the job in a Preview window (see page 4-1).

When you preview a PostScript job, Adobe Acrobat automatically opens in the
background, generating PDF thumbnails that allow you to preview the job and
perform further edits, including merging. A message prompts you to accept conversion

of the file to PDE



5-2 | Using DocBuilder Pro

When you open the full-screen preview for a spooled/held PostScript or PDF job, you
have access to three additional preview controls, as shown below.

4. Preview - Bighums. pdf [_ O] =]

Move preview around in window

[E53J 0 5 =

Magnify preview
(hold down Ctrl to zoom out)

Click to edit page content

1] | o

dit the contents of a spooled/held page by opening its full-
¢/4-2), and using the Adobe Acrobat and Enfocus PitStop

Editing page co
screen previe

Merging jobs—You can merge pages from several spooled/held jobs together in a new
file (see page 4-7). To merge jobs, both jobs must have the same status; that is, both
jobs must be spooled/held or processed/held.

Inserting blank pages—You can insert blank pages into a spooled/held PostScript or
PDF job. First, open the job in a Preview window. Right-click a page thumbnail, and
choose Blank Page from the menu. A blank page is inserted after the currently selected

page.
Imposition window
NoTe: The imposition feature is not supported for PCL jobs.

From the Imposition window, you can impose the pages of a document in an order
and positioning suitable for printing and binding. If you are connected to more than
one server at once, you can access the Imposition feature from one server only.



5-3 | Imposition window

TO OPEN A JOB IN THE IMPOSITION WINDOW

1.

Send the desired job to the Hold queue.

For information on using Command WorkStation, see Chapters 2 and 3.

Select the spooled/held job in the Active Jobs window, and choose Impose from the
Actions menu. You can also right-click the job and choose Impose from the menu that
appears.

You can open a PostScript or PDF (Portable Document Format) file, but it must show
a spooled/held job status.

Note: If you have installed the DocBuilder Pro option, you must install a dongle on
your workstation. If the dongle is not attached, an error message appears. For more
information, contact your authorized Service/support technician.

To impose a processed/held job, select the job in the Active Jobs window and choose
Remove Raster Data from the Astions menu to put the job in a spooled/held status.
Then select Impose from the‘Actions menu. To impose a printed job, select the job in
the Printed Jobs window and\choose Hold from the Actions menu.

When yow choese th€ Impose command, a page-imaging process generates a PDF
version of the job on which DocBuilder Pro performs imposition.

A status window appears while the job is imaged for the Imposition window.

Prepare selected job for imposition. .. |

Imposition - Print Brochure. pdf

28%

When it opens, the Imposition window displays the job. No layout is applied unless
the job has been previously imposed. Templates for common layouts are provided and
can be invoked from the Imposition window, as described in “Using templates” on

page 5-10.
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Job previews

The Imposition window provides a preview of a job’s pages, allowing you to
manipulate the source PDF.

Pages appear as a printer’s spread; that is, they appear in the order in which they are
printed as an imposed job. In contrast, a reader’s spread shows pages in the order they
are intended to be read. Note that the Preview windows in Command WorkStation
image jobs as reader’s spreads.

¥ el
=

3

-03- -04-

Printer’s spread /(_\\

01 -

Reader’s spread

The paper used to print a printer’s spread is known as a sheet. In duplex printing, each
sheet has two imageable surfaces—one on the front side and one on the back side of
the sheet. Each imageable surface contains one printer’s spread.
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Navigating in the Imposition window

Use the icons and menus at the top and bottom of the Imposition window to perform

the following:

Switch from Preview mode (thumbnails of actual content) to Layout mode
(page numbers only).

Switch between Mixed Page mode (document with varying page sizes) and Fixed
Page mode (document with a single page size). For more information on Mixed Page
and Fixed Page modes, see page 6-1.

Zoom in and out.

Drag the job preview around to make\a particular page or sheet surface visible.

Go directly to a particular paifj or shee

surface.
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The Zoom tool, Pan tool, Preview mode, Layout mode, Mixed Page mode, and Fixed
Page mode buttons are located in the upper-right corner of the window.

Preview mode

Layout mode

Zoom tool

Pan tool

Mixed Page mode 4 Impaosition - Bighum8.pdf

Fixed Page mode

Layaut

Scale

Finishing Sufsce1of8 | Fit Page Kl _’I

Selecting the Pan or Zoom tool changes the appearance of the cursor to indicate you
can use that tool to manipulate the preview. When you choose Preview or Layout
mode, or Mixed Page mode or Fixed Page mode, a blue border appears around the
selected view, and the appearance of the job in the Imposition window changes
immediately.

Imposition settings appear grouped in the Sheet, Layout, Scale, and Finishing panes at
the left of the window. To expand or collapse a pane of settings, click the bar for
that pane.
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The Surface menu, View menu, and scroll bar appear at the bottom of the window.
These menus and controls affect the display in the Imposition window immediately.

Switching between page view and layout view

Use the view mode buttons to switch between a page view and a layout view of the job.

* Preview mode—approximates the appearance of the final printed output very
closely; for this reason, it is sometimes called a WYSIWYG (“what you see is what
you get”) preview.

* Layout mode—displays numbered, generic pages that allow you to determine the
location of source document pages in the imposed job; you can rotate individual

pages in a layout view. %
\

Different viewing modes may d1§p y dlffe\rent sets of printer’s marks; for more

information, see the followmg K

NoTE: Preview mode put re St\ress on your system’s processor than Layout mode.
You can improve performance on slower systems by doing most of your work in

<l=u;/\ng to Preview mode only when you need to see content.

Layout mode, s

In Layo ; youcan rotate individual pages on the sheet. For more information,
see “Rotating pages” on page 6-22.

The following table summarizes the characteristics of the Layout and Preview modes:

Feature Layout mode Preview mode
Shows page content No WYSIWYG content view
Quick redraw on slower computers Yes No
Shows printer’s marks Yes Yes
Enable/disable printer’s marks Yes Yes
Reorder pages Yes No
Rotate pages Yes No
Define gutter Yes No
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Setting magnification levels

Use the Zoom tool to increase or decrease the level of magnification in the Imposition
window from 12% to 800%.

The View menu at the bottom of the window provides several ways to set the level of
magnification to display the contents of the window. The View menu allows you to
choose preset zoom values ranging from 50% to 800%. You can also choose to make
the current preview fit in the window. In addition to preset zoom percents, you can

specify a custom zoom value.

To USE THE ZOOM TOOL

1.

Click the Zoom tool to select it. %\ \\\
The cursor changes to a magmfx%s\s\i}l the preview area of the Imposition

window. \

Position the magnifyin@\s\s cft@sor over a page and click to zoom in.
\

The magnifyin

of page view.

Ifa?x&l\lrsor displays a plus sign (+) to indicate increased magnification

ach time you click, the current magnification doubles, up to a
maximu 800
Hold the Ctrl and click to zoom out.

Each time you click, the current magnification is reduced in half, down to a minimum
of 12%.

Right-click the page in the Imposition window.

Select Zoom In or Zoom Out from the menu that appears. Zoom In doubles the
current magnification, and Zoom Out reduces the current magnification by half.

TOo USE THE VIEW MENU

Click the View menu and choose a zoom percent.

To preview the entire surface, click the View menu and choose Fit Page.

Note: The View menu changes only the appearance of pages, not their actual content.
To change the scaling of pages in finished output, change the Scale area settings.
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To SPECIFY A CUSTOM ZOOM VALUE

1.

Click the View menu at the bottom of the Imposition window.

The current zoom value appears in Zoom dialog box.

Specify a new zoom value.

Enter a new zoom value or select a value from the menu.

Click OK or press Enter to confirm the new value.

The window reflects the change immediately.

Viewing the sheets

Use the Pan tool to drag the entire preview around in the window. For example, if you
are working with many pages onfa‘large sheet, you can use this tool to drag a particular
portion of the sheet into view:

At the bottom of the window, you can manipulate the content view using a standard
scroll bar or the Surface menuThe Surface menu opens the Go To Surface dialog box,
which allows you(to specify numerically the surface to display in the preview area.

To USE THE PAN TOOL

1.

2.

Click the Pan tool to select it.

The cursor changes to a hand in the Preview area of the window.

With the Pan tool cursor positioned over a sheet, click and hold the left mouse button
while moving the mouse.

The page preview moves in the same direction as the cursor. Repeat this step as
necessary to make a particular portion of the preview visible.
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TO USE THE SURFACE MENU

1.

Click the Surface menu at the bottom of the window.

When the Go To Surface dialog box appears, the entry box indicates the number of the
sheet surface currently displayed.

Go To Surface E
Surface: I of B

()8 I Cancel |

Enter the number of the sheet surface to display.
Click OK or press Enter to go to the'specified sheet surface.

Using templates
A saved group of imposition 'settings is known as a template. A template saves all

current imposition-settings, exeept custom rotations of individual pages on a finished

sheet and the '% 3
ana\pr

nting settings quickly and efficiently.

ecting. You can apply any template to any job, making it easy
to apply lay6ut

DocBuilder Prosupplies built-in templates that define settings for commonly used
layouts, such as 2-Up Saddle, 3-Up Trifold Brochure, 4-Up Gatefold, and so on.
You can also create your own templates. For a complete listing of built-in templates,
see Appendix B. For information on creating your own templates, see “Managing
templates” on page 6-24.

Both built-in templates and your own custom templates appear in the Template menu.
You can apply a template by choosing its name from the Template menu, in the upper
left of the Imposition window. The new settings take effect immediately.

Save template

1 Imposition - BigLetts. pdf

ate

up full bleed Delete template

Name of current template
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Saving your work

To close the Imposition window, click the Close box in the upper-right corner.

TO SAVE THE IMPOSED JOB

1.

Click the Close box in the upper-right corner of the Imposition window.

Close box

If the job has changed since it was épéned in the Imposition window, you are

prompted to save it. %
In the Save As dialog box, type a name for the job and its settings.

Save As E

The job haz been changed. Do you want to save it?

0ld name: BiglLetts. pdf

Mews name: IBigLetts.pdf.dbp

es Mo Cancel

Click Yes.

In the Save As dialog box, the name of the original spooled source file appears with a
new extension (.dbp). If you mistakenly close the Imposition window when you intend
to keep working, click Cancel in the Save As dialog box. The original PostScript or
PDF file remains intact, even after the converted file has been edited and saved in the

Imposition window.

Note: When you rename an imposed file, you must include the .dbp extension.
The extension is required to reopen the file with DocBuilder Pro.

For more information on how files are saved to the server, see “Saving imposed jobs”

on page 6-26.
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Chapter 6:
Advanced
Features of
DocBuilder Pro

This chapter provides information about the advanced imposition and editing features
of DocBuilder Pro. You can use imposition settings to alter various aspects of a job and
create custom templates.

Mixed Page mode and Fixed Page mode

DocBuilder Pro allows you to perform impositions in two different page modes.
You can switch between page modes by clicking the corresponding icons at the top
of the main imposition window.

Fixed Page mode—allows you to impese|documents that contain pages that
are all the same size. \

Mixed Page mode—allows yoi@ i se%ocuments that contain pages of
different sizes. A\

mode. Whe
page size, you ean select either Mixed Page or Fixed Page mode.
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Some imposition settings are available only for Mixed Page mode, and some only

for Fixed Page mode. The following table notes the settings that are exclusive to

either mode.

Settings Settin Available in Available in
panel 9 Fixed Page mode Mixed Page mode
Sheet Size Yes Yes
Creep Adjustment Yes Yes
Orientation Yes Yes
Duplex Yes Yes
Layout Rows/Columns Yes Yes
Printer’s Marks Yes Yes
Printer’s Marks Rull No Yes
into Pagé Edge
Bleeds Yes No
Scale Apply To Not editable; always Editable
set to All Slots on
All Surfaces
Scale Mode Available options: Available options:
* Scale to Fit * Scale to Fit
* Custom * Custom
Alignment/Offsets No Yes, unless Scale to Fit
is specified
Finishing Binding Yes Yes
Gang Up Yes Yes
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Imposition settings

Imposition settings apply only to the job currently displayed in the main window.
Because these settings usually affect the job’s printed layout, they are saved with the job
and used whenever the job is opened. For example, as you open jobs saved with
different layouts, you see the display change accordingly. Changes to imposition
settings are applied to the current job immediately, but are not saved permanently until
you save the job itself.

You can specify imposition settings using controls in the Sheet, Layout, Scale, and
Finishing panes on the left side of the main window. To view or hide a settings pane,
click the bar for that settings group.

Click to view or hide
the settings panel

Rows H Columns H
& Frinter's s
& Bleeds

NoTe: You can change the default unit of measurement for all input fields in the
Command WorkStation Preferences dialog box. You can also specify any unit of
measurement in any field that accepts input by adding one of the following
abbreviations to the new value:

s M o

* “L,” “in,” or the inch symbol (") specifies inches, for example: 8.5 i, 8.5 in, 8.5"
* “mm” specifies millimeters, for example: 8.5 mm

* “pt” or “pts” specifies points, for example: 8.5 pts
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Sheet settings

Sheet settings allow you to specify characteristics of the paper on which the job is to be
printed, such as dimensions, thickness, orientation, and whether it will be printed on

one or both sides.

y other aspect of the imposition process, you
should specify sheet settings immediately‘after opening a job in the main window.
If necessary, you can change %gs ater; the job is revised accordingly.

In general, experimenta job settings does not cause permanent changes
(o1, potentially, loss of original\job data), until the job is printed or saved with the

new settings.

Size

You can choosean item from the Size menu to specify the dimensions of a sheet of
paper and see the change reflected in the main window preview immediately. The Size
menu includes items representing all page sizes defined by the currently selected
copier’s PostScript printer description (PPD) file. To choose a custom size, enter the
width and height of the custom page. If you do not specify units for your custom

size values, DocBuilder Pro uses the default units specified in the Edit > Preferences

dialog box.

When specifying a sheet size setting, consider the size of the final output. During
imposition, DocBuilder Pro automatically scales pages, if needed, to fit the sheet’s
maximum imageable area. The area does not necessarily extend to the edges of the
sheet. For example, if you perform 1-Up imposition of 8.5x11 pages onto 8.5x11
sheets, the final pages will be scaled smaller than 8.5x11. To retain your original page
sizes, specify a sheet size large enough to accommodate the imposed pages

without scaling.
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Creep Adjustment

Choose either Plain or Thick from the Creep Adjustment menu, or enter a value

(between 0 and 2 inches, or the equivalent in another measurement unit) to specify the
thickness of the sheet. When saddle-stitched binding is specified, DocBuilder Pro uses
this value to compensate automatically for binder’s creep (see “Shingling and creep” on

page A-8).

Note: Even if you select Thick from the Creep Adjustment menu, your job will still
print on Plain paper, unless you specified Thick paper in the job properties. For more
information on changing job properties from Command WorkStation, see “Viewing
and overriding print settings” on page 3-14.

Orientation

Use the Orientation menu to spécify the orientation of a sheet. As an alternative to
rotating the sheet, you can petfdriricuistom rotations on any page in the main window,
as described in “Rotating/pages.\on page 6-22.

Duplex

Use the Duplex menuto specify the relationship of content areas on opposing sides of

duplex (two-sided) printing or Off for simplex (one-sided)
printing.

When you choose On, the job is printed as duplex using a Top-Top setting, meaning
that the tops of pages on opposing sides of a sheet are located on the same edge (usually
the preferred choice for imposed book layouts).
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Layout settings

A layout is a plan that specifies the number, ordering, and rotation of page images on
the sheet. DocBuilder Pro supports layouts of up to 25 pages per sheet, in a matrix of
up to 5 rows by 5 columns (50 pages duplex). All combinations of rows and columns
allow gang printing; however, only Gang Up layouts in the 5x5 matrix support
imposition.

Note: If the number of pagesi job\does not divide evenly into the number of
rows and columns in the layout'you select, you may see some sheets with blank spaces.
The layout you select should, correspond to the number of pages in your job.

Rows
Click the down arrows to specify the number of rows (up to five) in a
layout, o [y the'number of rows in the layout by typing a value in the Rows field.

Changes to the'Rows value are reflected immediately in the main window, whether you

are in Layout or Preview mode.

The Rows value interacts with the Columns and Scale settings. When you choose a
value that causes content to extend beyond the edge of the sheet, DocBuilder Pro
provides a visual warning. For more information, see “Clipping indicators” on

page 6-12.

When you change the Rows value, you are prompted with a message that all custom

page edits (Add, Delete, or Duplicate) applied to the job are canceled.

Columns

Click the Columns up and down arrows to specify the number of columns (up to five)
in a layout, or specify the number of columns in the layout by typing a value in the
Columns field. Changes to the Columns value are reflected immediately in the main
window, whether you are in Layout or Preview mode.
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The Columns value interacts with the Rows and Scale settings. When you choose a
value that causes content to extend beyond the edge of the sheet, DocBuilder Pro
provides a visual warning. For more information, see “Clipping indicators” on

page 6-12.

When you change the Columns value, you are prompted with a message that all
custom page edits (Add, Delete, or Duplicate) applied to the job will be canceled.
Printer’s Marks

Select Printer’s Marks to add trim, fold, and job information to all sheets in a job.
For background information on printer’s marks, see page A-4.

Note: Not all layouts display all of inter’s Marks. For example, if the layout you
select does not require that the sheet be folded, fold marks are not displayed, even if
you selected them in the De dialog box.

A

Job label

Trim marks

Fold mark
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Because the set of marks required varies according to the job, DocBuilder Pro allows
you to define the set of printer’s marks displayed. For example, ganged-up business
cards do not require fold marks, while a 4x4 book layout does. To specify which marks
are shown, click Define and choose options in the Define Marks dialog box.

Define Marks E

¥ Trim Marks Froperties... | _|
[+ Fold Marks Froperties... |

Horizontal Qffszet IU-UUUIZ't
Wertical Offset IU.DDDpt

Job Label
¥ Job Mame
¥ Sheet Irfo
¥ Diate & Time

™ Pullin to page edge

Cancel |

The Define Mdrks dialog box allows you to enable or disable trim marks, fold marks,
and the indiyidual elements of the job label. The job label stores descriptive text used
for the job name, shéet information, and date and time. You can also enter values
(from —72 t0+72 points, —1.0 to 1.0 inch, or =25.4 to 25.4 mm) in the Horizontal
Offset and Vertical Offset fields, to fine-tune the placement of trim marks and fold
marks. In Mixed Page mode, you can select Pull in to Page Edge to align trim marks
and fold marks with page boundaries.

Offset—The Horizontal Offset and Vertical Offset fields determine the gap between
the printer’s marks and the trim lines on the page. This allows you to move the printer’s
marks away from the final trimmed area of the page. A positive offset moves the
printer’s marks out from the center of the page, and a negative offset moves the
printer’s marks closer to the center of the page.

10 point vertical offset

10 point horizontal offset
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Properties—Click Properties to customize the appearance of trim marks and fold
marks. You can specify the horizontal and vertical lengths of marks (from 1 to
216 points), type (dotted or solid), width (from 1 to 3 points), and color.

Mark Properties E

Harizontal Length: I‘I 6.000pt
‘ertical Length: I‘I £.000pt

Type I Solid - l
Width : I 1pt. = l
Color.  [R] |~

Cancel |

Note: The Printer’s Marks option.enables.marks globally throughout a job. To disable
or enable an individual mark, ‘press the>Ctrl key and click the mark directly in the
imposition window. Disabled matks are indicated by an “X”.

—¥ L

Ctrl-click to disable/enable mark
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Bleeds

The Bleeds option moves the trim marks into the image by the amount you specify to
ensure that the printed area extends beyond the edge of the trimmed sheet.

Non-imageable area

Trim marks

Image

To specify horizontal and vertical bleed amounts for a job, click Define in the Layout
panel and enter values (from 0 to 72 paints, 0 to 1 inch, or 0 to 25.4 mm) in the
Define Bleeds dialog box. \

\ \
\
AL v
Define Bleeds [X]
Harizantal |5.000pt \
‘ertical  |5.000pt

Cancel |

The Bleeds\opgn is not available in Mixed Page mode.

Note: When you specify a bleed, you move the trim marks into the page by the bleed
value on both the top and the bottom of the page, and on both sides of the page.
Therefore, you reduce the size of your finished page by twice the bleed amount. If you
plan on using bleeds, design your image to be slightly larger than the size of the final,
trimmed page and select a larger paper size to accommodate trimming.
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Scale settings

Use Scale settings to enlarge or shrink the page by a specified amount.

slots on a sheet'depends on the Rows and Columns values. The slot size is determined

by dividing the maximum imageable area of the sheet by the number of slots.
Current Slot—Applies scaling to the currently selected page.

Row on All Surfaces—Applies scaling to all pages on all sheets that are located in the
same row as the currently selected page.

Columns on All Surfaces—Applies scaling to all pages on all sheets that are located in
the same column as the currently selected page.

All Slots on All Surfaces—Applies scaling to all pages in the job.
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Scale Mode

Choose a scaling option from the Scale Mode menu:

Scale to Fit—Scales page(s) to best fill the slot without printing past its edge. Scale to
fit is the default mode.

Custom—Enables the Scale Factor and Finished Height and Width fields, so that you
can specify new scaling values. The original height and width values are displayed for
your reference. When you specify a value, DocBuilder Pro automatically updates the
other fields to preserve the height-to-width aspect ratio of the page.

Clipping indicators

If you supply scaling values that would cause the page to print past the edge of the
sheet, DocBuilder Pro provides a visdal warning. When the window is in Layout
mode, any clipped page edge i ighted in yellow. When the window is in Preview
mode, the Clipping icon appeats to the left of the Scale Factor field. In addition, the

0 elf makes scaling problems obvious—content

Clipping icon

Clipped page edge

Alignment and Offsets

The Alignment and Offsets settings are enabled when you choose Custom from the
Scale Mode menu in Mixed Page mode. You cannot change Alignment and Offsets
settings in Fixed Page mode.
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The Alignment controls allow you to specify the placement of a page within its
predefined slot on the sheet. For example, if the page has been scaled smaller than the
slot, you can align the page to the top left corner of the slot by clicking the Alignment
control corresponding to that position.

Alignment af

Click to specify :
0,000,
upper-left alignment

Page is aligned in slot

You can fine-tune the placement further by entering values (from —5184 to +5184
points) in the Offsets fields. Offset values are calculated in reference to the alignment
position, and reset to zero when you specify a new alignment.
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Finishing settings

In the Finishing pane, you can specify binding and gang printing settings.

Finizhing

Q Gang Up

Binding

To enable binding settings and disable printing, select Binding. When binding
settings are enabled, you can i e binding method, the binding edge of each
page (left or right), and thé number of pages per saddle group. DocBuilder Pro

compensates automatically for binder’s creep according to the specified binding

method, the number of pages in a saddle group, the layout in use, and the size of
the job.

Note: If a layout with more than two columns or rows, the Binding
selection 1 vailable.

You can specify the following binding edge options:

Left Edge—Specifies binding across the left edge of the booklet. The booklet reads
from left to right.

Right Edge—Specifies binding across the right edge of the booklet. The booklet reads
from right to left.

You can specify any of the following binding methods:

Saddle—Specifies a group of folded sheets stitched or stapled on a common, centered
fold line. Saddle-stitched binding is the most common type of binding, and is usually
used for booklets.
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Perfect—Specifies signatures folded and stacked for binding. The spine edges are
trimmed and glued together.

Nested Saddle—Specifies a combination of saddle and perfect binding methods.
As with saddle stitching, pages are grouped together and stapled or stitched across a
common center fold. The saddle groups are then stacked one on top of another and

glued, as with perfect binding.

When imposing a book for nested saddle binding, specify the number of pages in each
saddle group by entering a value in the Groups of field. As the number of pages in a
saddle group increases, the effect known as binder’s creep becomes more prevalent
(see page A-8). DocBuilder Pro shifts images on the page to compensate automatically
for creep, according to the value in the’Groups of field, the value in the paper thickness
field, the specified binding type, an rdering and orientation of pages specified by
the current layout.

Gang Up
To enable gang printing and\disable binding settings, select Gang Up. In gang

printing, you pla u
than havin c

binding

tiple pages on a sheet for “collate and cut” finishing, rather

1/ Pro impose them in the order required by a particular

A collate and cut layout reorders pages in a manner that causes them to fall into easily
collated stacks when the sheets in the job are cut into individual pages. The use of such
a layout may allow multiple small jobs to be printed on a single sheet; thus, gang
printing is commonly used as a means of saving paper when printing small jobs on
copiers that use large sheets, and when printing jobs such as business cards or labels.

To disable gang printing and enable binding settings, select the Binding setting. When
gang printing is disabled, DocBuilder Pro imposes pages in the order defined by the
current layout.
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You can specify any of the following Gang Up methods:

Repeat—DPlaces multiple copies of a page until the sheet is filled; for example, when
printing both sides of a sheet, the front side of the first sheet is filled with images of
page one, and the back side is filled with images of page two; the front side of the
second sheet is filled with images of page three, and the back side is filled with images
of page four; and so on, until all pages in the job are imaged.

N

“step-and-repéat” printing. Step and repeat is most often used when printing multiple
copies of a single document; for example, when printing business cards, you would

print multiple copies of the same image to fill a larger sheet.

Unique—Places pages in an arrangement that is often more appropriate for printing a
single copy of a job. This option does not fully collate itself (hand collating is
necessary), but optimizes the sheet size while limiting the run to a single copy.
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Unique-Collate Cut—Places pages in an arrangement that allows the pages to fall into
the correct order when the sheets are stacked and cut. This option minimizes the need
for collating by hand and is most appropriate for printing single copies of a document.

12-page document

1112(13(|4([5]||6]||7]|8]|9]([10][11]|12

2 x 2 Unique-Collate Cut, Duplex off

1 4 2 5 3 6 Collate sheets
>
7 (10(| 8 |11 9 |12

Sheet 1 Sheet 2 Sheet 3

2l

) L

7 H

=]y

—
o

Collate pages

v
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Modifying the layout manually

Whether you apply a predefined layout or specify custom settings, you can manually
modify a job’s layout in the following ways:

* Reorder pages.

* Add, duplicate, and delete pages.
* Rotate pages.

* Set gutter sizes.

Note: Specify the following settings before making any manual changes to the layout:
Orientation, Duplex, Rows, Columns, and Binding. If you specify any of these settings
after making manual changes, you will be prompted with a message informing you

that the manual changes will be can ella@\\
%% M

Reordering pages in-Layout mode
LN

When you impose a joﬁﬁag\é@are automatically arranged in a particular order,
a%you select. Each page number in Layout mode represents the
ce

according to the ]

page from the s6urce-document that DocBuilder Pro images in a designated position

on the finis wever, to reorder individual pages manually, arrange them in
the main assign a different page to a particular location in the layout, use

the following procedure.

TOo REORDER PAGES

1.

2.

Verify that Layout mode is selected.

Select the location’s current page number.

You can also press Tab to move to the next slot in the layout, or press Shift + Tab to
move to the previous slot in the layout.

Type the new page value and press Enter.

You can add a blank cover page by typing 0 (zero) for any page number. Page 0 will be
printed as a blank page.
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NoTe: When you use this procedure to reorder pages, the page number you enter
overwrites the original. For example, if you typed Page 3 in place of Page 5, you will
now have two of Page 3 and no Page 5. Also, you cannot enter a page number that
does not already exist in your job. For example, if your job has 10 pages, you cannot

type 12.

Adding, duplicating, and deleting sheets

You can add, duplicate, or delete sheets by right-clicking any sheet in either Preview or
Layout mode.

To ADD OR DUPLICATE SHEETS

1. Right-click a sheet in Preview or Layout mode, and then choose Add Sheet(s) or
Duplicate Sheet from the menu that appears.

Zoom |n
Zoom out

Add Sheet(z]...
Duplicate Sheet...
Delete Sheet(z]...
Edit Fage ...

2. If you are‘adding sheets, specify the number of sheets to add.

Add Sheet|s] E

Dwuplex iz Off : Each Sheet has 1 Surface

MNumber of Sheet(z] to add: |1
' Add After Sheet |1

& add at end
' #dd at beginning

Cancel
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3. If you are duplicating sheets, specify the number of the sheet to duplicate.

Duplicate Sheet E
Dwuplex iz Off : Each Sheet has 1 Surface
Duplicate Sheet I‘I
5 Add After Sheet |1

 add toend
" dd to beginning

Cancel |

4. Select the location to insert added or duplicated sheets, and click OK.

TO DELETE SHEETS

1. Right-click a sheet in Preview, or'Layout mode and choose Delete Sheet(s) from the
menu that appears.

The Delete Sheet(s) dialog box appears.

Dwuplex iz Off : Each Sheet has 1 Surface

' Delete Sheet I‘I
€ Delete &1l Shests After |1

 From |1 to |1

Cancel |

2. To delete a single sheet, select Delete Sheet and specify the number of the sheet you
want to delete.

To delete a range of sheets, select Delete All Sheets After and specify the starting
number of the sheet range to delete, or select From and enter values for the start and
end numbers of the sheets to delete.

A single sheet or range of sheets is deleted, depending on what you have specified.

3. Click OK.



6-21 | Modifying the layout manually

Editing page content

You can use the Enfocus PitStop software (installation instructions included with the
DocBuilder Pro option) to edit the content of pages in a job. PitStop functions as a

plug-in that adds enhanced PDF editing tools to Adobe Acrobat.

Note: For best results, make edits to page content before performing sheet-level
operations such as adding, duplicating, or deleting sheets. Editing page content causes
the cancellation of all previous sheet-level operations.

To use P1TSTOoP WITH DOCBUILDER PRO

Right-click a sheet in Preview or Layout mode and choose Edit Page from the
menu that appears.

Or, display the full-screen preview-for the spooled/held PostScript or PDF job in
3 and click the Edit Page icon.

[iuf

Edit Page icon
(in full-screen preview)

Adobe Acroba d displays the document. The standard Acrobat tools are
for ell as the PitStop tools, which display with purple lines.

Adobe Acrobat - [00000000.000]
T File Edit Documsnt Tools View window Help

‘
MeaBa(E 1M« D0E6&6PEED A

PitStop
editing tools

|

PitStop editing tools

Phrslvnpdesnhmgs 25

] 109k [+ 4]

1 of 6 85 11in | E.]| < 1A
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3. Use the PitStop editing tools to edit the document content.
For instructions on using PitStop, see your online PitStop documentation. To access
this documentation, choose Help>Plug-In Help>Enfocus PitStop Professional from
the Acrobat menu.

4. When you have finished editing, click Close in the Acrobat window.

You are prompted to save the changes.
5. Click Yes.

6. Click the Command WorkStation window to bring it to the foreground.

The edited file appears in the full-screen preview window.

Rotating pages é\\ \>

To manually rotate individua{gé%e of pages in a job, display the job in Layout
mode and click the Rotate/ o\n\i\n thedipper-right corner of a page. Rotation is

performed in 90° cloc c}t\ﬁnents for Mixed Page mode, or in 180° increments
for Fixed Page mode.
If you appl 0 on to a page in Mixed Page mode and then switch to Fixed

Page modethe rotation will be canceled.

Rotate icon

=/}
ol

16 1
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TO ROTATE PAGES

1.

2.

To rotate a single page, click the Rotate icon on that page.

To rotate all pages in the job, press the Shift and Ctrl keys and click the Rotate icon on
any page.

6 8 L | ot 11| 9 ¢ | u

16 | 1 2 5 14 | 3 4 13
Sheet 1, Sheet 1, Sheet 2, Sheet 2,
front side back side front side back side

To rotate all pages in a certain'\location on the front side of each duplex sheet, press
the Shift key and click the Rotate icon on any page in that location on any sheet.

For example, in the preceding graphic, if you press the Shift key and click the Rotate
icon on Page 8, Page 6 rotates-as well, because both pages are in the same location on
the front side 6f the sheet.

To rotate‘alt.pages in‘a certain location on the front and back sides of each duplex
sheet, press-the Ctrl key and click the Rotate icon on any page in that location on
any sheet.

For example, in the preceding graphic, if you press the Ctrl key and click the Rotate
icon on Page 1, then Pages 2, 3, and 4 rotate as well, because they are in the same
location on the front and back sides of the sheet.

Setting gutter sizes

DocBuilder Pro defines the locations of gutters for you according to the layout and
sheet size governing the imposition of the job. In Layout mode, you can specify the size
of a gutter by entering a value in the gutter size field and pressing Enter. For example,
perfect-bound jobs typically require larger gutters than saddle-stitched jobs, in order to
provide room for grinding off the spines and gluing signatures together when the book
is bound.
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You can also specify a negative gutter value—for example, to join together two pages
located in adjacent slots, or to offset the effect of an excess bleed value.

Vertical gutter size field i
T
& &
8 g Margin
0.00Mm &
Horizontal gutter size field ¢ ¢
16 1
L
\\\

Note: The size and location of th} margin (the area between the outside edge of a
group of imposed pages and the edge of the sheet) is a function of the particular copier

associated wit t@.

Mana emplates

You can name'and save the current combination of Sheet, Layout, Scale, and Finishing
settings as a custom template. Choose Preferences from the File menu to set the folder
or directory in which Command WorkStation saves templates (see “Setting

You cannot define custom margins.

preferences” on page 2-30).
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You can save all imposition settings in custom templates, except the following:
* Sheet size setting

* Custom printer’s marks properties

* The Pull into Page Edge setting and custom offset settings for printer’s marks
* The Apply To setting in the Scale pane

* Settings made in Custom scale mode in the Scale pane

* Offsets settings in the Scale pane

* Fixed Page Mode or Mixed Page Mode settings

* Added, duplicated, or deleted sh%
To SAVE IMPOSITION SETTINGS AS A TEMP N

1. Click the Save template@\
[

i Imposition - BiglLetts_pdf

Save template

Delete template

Name of current template

2. Type a name for the settings file in the Save Template As dialog box.

When saving a template, choose a descriptive name, such as “4-Up Nested Saddle.”
If you plan to use the same template for a particular document, name the template
after the document type, for example, “Status Report.”

Save Template As E

|4-up nested

()8 I Cancel |

3. Click OK or press Enter.

Apply the template in the same manner as built-in templates, by choosing the template
from the Template menu.
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TO DELETE A SAVED TEMPLATE

1.

2.

Select the template you want to delete from the Template menu.
Click the Delete template icon.

Click OK or press Enter to delete the specified template.

Tips for using the Imposition feature of DocBuilder Pro

This section provides information that will help you get the most out of the imposition
features of DocBuilder Pro.

Page-level operations

Consider the following when edijting pages of a job:

Adding a binding offset

You can set gutters on each| page independently to allow extra room for binding.
For more information, see “Sétting gutter sizes” on page 6-23.
g8 g

Perform all page<level\edits in the Preview window

For best results; perform all desired page editing operations in the Preview window
before applying imposition settings to a file. Although you can perform page edits, such
as adding, deleting, and duplicating pages, within the main Imposition window, these
edits will be lost when you apply imposition settings that alter the page layout.

Saving imposed jobs
When you save an imposed job, DocBuilder Pro does the following:

If new data has been added to the temporary PDF file, it is saved to the Fiery EX3535
under the name you specify in the Save As dialog box.

The default name that appears in the Save As dialog box is that of the original
spool file, with a new extension (.dbp). If you do not intend to overwrite the
source file, you must enter a new name for the imposed job. The original
PostScript or PDF remains intact, even after the converted file has been edited and

saved in the Imposition window.

If imposition data has changed, the data is saved to the Fiery EX3535 and associated
with the new PDF.
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Maintaining associated imposition data separately from the job’s PDF data allows
DocBuilder Pro to impose in-RIP without modifying the PDF data, and allows you to
reuse PDF data that has been modified in the imposition process.

To SAVE AN IMPOSED JOB

1. Click the Close Window icon in the upper right corner of the DocBuilder Pro window.

2. Enter a name for the imposed job in the Save As dialog box.

Save As E

The job haz been changed. Do you want to save it?

0ld name:  BigMume. pdf

Mews name: IBigN umsz.pdf.dbp

es | Mo

3. Click Yes.
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Ch apter 7: Fiery Spooler duplicates many of the functions and features of Command
Fi ery Sp ooler WorkStation. It provides additional flexibility by allowing job tracking and

management from multiple platforms over the Internet or an intranet.

Fiery Spooler is installed from the User Software CD, and is available for Mac OS
computers only. To use Fiery Spooler, users need only a network connection to the

Fiery EX3535.

Tracking and managing jobs with Fiery Spooler

Use Fiery Spooler to perform the fa ing functions from your workstation:
* Override current job option

O

\
* Delete jobs and cance Ce\§

\§1

n

\\ &
V

* Duplicate or rename jobs

old.the raster data
e spooled area or the RIPped area

¢ Remove r data from RIPped files

* RIP a job and
* Hold jobsi

* Change the priority of jobs
* Edit and merge raster data jobs

* Display, print, export, or delete the Job Log

Most of these functions require an Administrator or Operator password. However,
even without a password, you can log in to Fiery Spooler as Guest with view-only

privileges.

Note: Most Fiery Spooler commands are identical to those of Command WorkStation.
For more information on specific commands, see Chapters 2 and 3.
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To START FIERY SPOOLER ON A MAC OS COMPUTER

Jury

.

Double-click the Fiery Spooler icon.

Select the Fiery EX3535 in the Chooser window.

For information on setting up the connection to the server, see the User Soffware
Installation Guide.

Click OK.

Log in to the Fiery EX3535.

* To log in as Administrator, enter the Administrator password and click OK.

* To log in as Operator, enter the tor password and click OK.
* To log in as Guest, click O out ring a password.
The Fiery Spooler mai%o ppears.

O=—————fierySpooler =—————— [H
| Time

08'51:0
Yiolin BW ps icli 08:50:52 201103 device
Times ps icli 02:40:46 201102 device
tailor B ps icli 024043 201102 device
SOUTHTAB RGEps iddi 02:49:14 201103 device
NORTH.Cvr.RGB ps iddi 02:48:57 201103 device
Market BYW ps idi 02:48:50 2101103 device
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About the Fiery Spooler window

Similar to Command WorkStation, Fiery Spooler allows you to view Fiery EX3535
and copier functions, and acts as an interface from which you can control those
functions.

The Fiery Spooler window is divided into three areas by Spool, RIP, and Print status
bars. When the Fiery EX3535 receives print jobs, the Fiery Spooler window becomes a
dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery Spooler window represent the stages of
printing a job. Jobs come in at the top level (Spool) and drop down to the Print level,

unless they are held along the way. ﬁ
The job icons displayed in th l}%o window are explained on page 7-8.

The RAM status bar i s the amount of memory in use. The Drive status bar
indicates the amount of hard disk drive space in use.

er window, the background color for the yellow and white

Note: In the Fi \‘@
printer icons s the same.

Spooled jobs bs listed in the area below the Spool status bar are PostScript or PCL
files stored on the Fiery EX3535 hard disk drive. These jobs were sent to either the
Print queue (white icons) or the Hold queue (yellow icons).

RIPped jobs—TJobs listed in the area below the RIP status bar are ready to print. They
have been rasterized (RIPped, or processed for printing) and are waiting, in order, for
access to the printer. Rasterized jobs can also be held; held jobs are indicated by a

yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been
printed. Printed jobs can be stored on the Fiery EX3535 hard disk drive. The number
of jobs you can store (from 1 to 99) is defined in Setup.
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If you are logged in as Administrator or Operator, you can interact with a job wherever
it appears in the window by selecting it and choosing a command from the Job menu,
or by double-clicking the job and setting override options. For more information, see
“Manipulating job options and job flow” on page 7-4.

Errors—Jobs with an error are shown in red. To display the error, double-click the job.
Note that you cannot check the job properties or hold a job with an error.

Note: If your job does not appear anywhere in the Fiery Spooler window, it may have
already printed; if so, it appears in the Job Log. To view the Job Log, choose Show Job
Log from the Window menu. For more information on the Job Log, see page 7-18.

If the job does not appear in the Job Log, it may have been moved to the Archive
window by the operator. The Archi dow cannot be viewed with Fiery Spooler;
you must contact the operator, ot go.to the'Command WorkStation screen to check
this.

Manipulating job options and job flow

Using the comn in the Job menu, you can alter the destinations, priorities, and

characteristi at appear in the Fiery Spooler window.

Delete Job(s]
Cancel Printing
Cancel RIPping
Duplicate Job(g]
Rename

Hold

RIP and Hold
Frint

Frint and Hold
Frocess Mest
Remave Raster

Override Print Settings. ..

Thumbrail &
Thumbnail B
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To understand the effect each of these commands has on a job, you must understand
the way the Fiery EX3535 handles PostScript, PCL, and raster data, and how jobs are
activated or held in the various stages of processing. For this background information,

see Chapter 1 before manipulating jobs with Fiery Spooler.

Choose this command
from the Job menu

To do this

Raster data is

Delete Job(s) Delete the job(s) from the list. Deleted

Cancel Printing Cancel the currently printing job. Deleted

Cancel RIPping Cancel the currently processing job. Deleted

Duplicate Job(s) Duplicate one or more selected PostS%?Vgr\ n/a
PCL data jobs in the Spool or Printaréas \ \ | (Duplicate is not available for raster jobs.)
(creates a reference to the origipgljob, with\
the same name). \\

Rename Rename the job (PostScri r\\{’CI\)ﬁle with | Unaffected, but associated with the new
or without raster). \ > v name

Hold Hold the j \ogy} t place (except for | Held in RIP area indefinitely, if included
a printed’j ich is'moved to the Spool with job
or RIP area).

RIP and Hold

RIP the job and hold it in the RIP area.

Held in RIP area indefinitely

Print Print the job in its turn (RIP the job first if it | Temporarily held on the server until the job
does not have raster data). Keep the printed | has completed printing
job in the Print area until the job limit is
reached.
Print and Hold Print the job in its turn (RIP the job firstif it | Held in the RIP area indefinitely (saved to
(like the PPD option does not have raster data). disk)

Save Fast Reprint)

After printing, hold the PostScript or PCL
data and the raster in the RIP area.

Process Next

Give top priority to this job.

Print the job (or RIP and print) as soon as
the processor and copier are free, before
other waiting jobs.

Held in RAM after printing (can be selected
in the Print area while it remains there), or
held in RIP area (saved to disk) if
destination was RIP and Hold
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Choose this command
from the Job menu

To do this

Raster data is

Remove Raster

Remove the raster from a job that has raster
data; leave the PostScript or PCL job in
place.

Deleted

Override Print Settings

Change the print options for the job
(see page 7-0).

Deleted and regenerated, if the newly
selected options require reRIPping, or
reprinted with the new settings, if none

require reRIPping
Thumbnail A Open the selected held raster data job in the | Changed if job is edited, unaffected if job is
Thumbnail A window, where you can viewa | only viewed
full-screen preview of the job, edit the j \
or merge it with raster data from othérjobs.\
Thumbnail B Open the selected raster data job, Unchanged

necessarily a held job) in ¢ H\%\h}bna'
window for viewing or fot erging into a

job in the Thumbnail A win o\\& %
\
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Override Print Settings

Job | Paper Source | Layout | ColorWise | Image Quality | Rnishin FreeFom | Owner Information
P! Y ag Y g

Job Duchy tif

Copes  E——]

NoTe: For s options, changing the setting requires that the job be reRIPped;
these options are displayed with an icon to the left of the option name.

The options set here are the same ones you set from the Print dialog box when you
print from an application. For information about setting and overriding these print

options, see Appendix A of the Printing Guide.
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Job icons

Three types of icons are used for both active jobs and jobs on hold.

Icon

(white icons and rows)

Active jobs

Jobs on hold
(vellow icons and rows)

Printer icons

PostScript, PCL, or raster
data headed for printing
(top) or after printing
(bottom)

PostScript or PCL data headed for
Print and Hold or job on Hold
after printing (Hold)

Raster icon

PostScript, PCL, an
data after printing;

fast reprint ~N

aster
y for

PostScript or PCL data already
rasterized and held

Spool area
The job icons in the Spool

a are as follows:

What it indicates

How long you see the job

)
Jiss

PostScript or PCL data from a
user on the network; no
destination is defined

Until a destination is chosen

PostScript or PCL data
headed for Print

Until the RIP is free

PostScript or PCL data
headed for RIP and Hold

PostScript or PCL data
headed for Print and Hold
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The Spool area is both the receiving area for jobs from users on the network (Hold
queue) and the waiting area for jobs that will be RIPped.

Hold queue jobs—When printing requires an operator (because the Print queue and
Direct connection are disabled), the operator must assign a destination to all jobs
received from users on the network (Icon 1). Once assigned, jobs move down the
Spool queue for processing (Icons 2, 3, and 4). All jobs printed to the Hold queue
require routing by an operator.

Print queue jobs—When printing does not require an operator, network jobs sent to
the Print queue appear in the Spool area, where they are displayed with a white printer
icon (Icon 2). When jobs reach the head of the queue, they are RIPped and printed
without operator intervention.

Direct Connection—Jobs printed to'the Direct connection are not displayed in the job
lists. They are displayed briefly in thest
are included in the Job

atus bars (where they cannot be selected) and

RIP area
The job %@\ P area are as follows:

RIP area‘icon What it indicates How long you see the job
1 Raster data, no destination Until it is deleted, moved to
E defined; may have been the Archive window, or
printed before and held stripped of its raster data and

sent to the Spool area

2 Raster data headed for Print Until copier is free to print
E in its turn; no hold defined the job
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After a job is rasterized, it goes into the RIP area. The RIP area holds only jobs with
raster data. Jobs in the RIP area are either waiting for the copier to be free (Print queue
jobs, Icon 2), or they are being held (Icon 1). Held jobs in the RIP area have already
been rasterized (RIP and Hold), or they have been printed and their raster data has
been routed back to the RIP area (Print and Hold).

NoTe: Raster jobs in the RIP area that are waiting to print (Icon 2) cannot be
manipulated by job commands.

Print area

The job icon in the Print area is as follows:

Print area icon WQa)//iﬁndicates How long you see the job
1 PostScript or ﬁéL data Until the job limit is reached
n o%ra er.data has been
deléred

printing the job. To see the error, double-click anywhere in the row.

While it is printing, a job consists of PostScript or PCL and raster data. The raster data
in RAM is not cleared until memory is needed to rasterize the next job. As long as the
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs are
represented by a white PostScript icon (Icon 1). If the job was printed from a held
raster job (in the RIP area), the raster data in the RIP area remains and can be used to
reprint the job after the raster data has been cleared from the Printed queue.

Previewing, editing, and merging jobs

Fiery Spooler includes two thumbnail windows that allow you to preview and edit
raster data. You can use the thumbnail windows in the following ways:

* In Thumbnail A, you can view the currently printing job as it is RIPping, or any
raster data job.
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* From Thumbnail A, you can open a full-screen preview of a raster file.

* Using Thumbnail A and Thumbnail B together, you can merge raster data from
more than one file, even if the files were printed from different applications on
different computer platforms.

The job merge features eliminates the limitations of certain software applications.
You can merge raster pages of documents of different types, and from different
computer operating systems. You can merge color pages from graphics programs with
text pages from a word processor.

Previewing raster jobs

You can use Thumbnail A to previe es of the currently RIPping job. You can
also use Thumbnail A and Thumbnil preview any held raster data job in the

RIP area.
The thumbnail windows-al %«/ you to open a thumbnail view of any held raster
data job in the RIP area and\perform electronic collation or document merging,.

For more inforn about this feature, see page 7-14.

Previewi éntly rasterizing job

To see the progtess of jobs as they are RIPped, leave Thumbnail A open in RIP

Preview mode.
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TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE
1. Click the Thumbnail A tab at the right of the Fiery Spoolerwindow.

2. Click the RIP preview icon at the left side of the Thumbnail A window.

In this mode, Thumbnail A displays each page of the currently processing job after it

has been RIPped.
o
Click to display the
currently rasterizing job O

Click to close the
thumbnail window

O]

3. Choose a PostScript file in t\éSpool or Print area and select RIP and Hold, Print,
or Print and Hold
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TO VIEW THUMBNAILS OF ANY RASTER DATA FILE

1.

2.

Select any raster data job in the RIP area.

Choose Thumbnail A or Thumbnail B from the Job menu.

Note: Wait until all pages have been displayed before opening another raster file with
Thumbnail A. If the job contains many pages, it may take some time for the entire job
to be displayed.

Click to open a
full-screen preview

- Click to close the
D 1 2 3 thumbnail window

Kl C

Displaying full-screen previews

You can open a full-screen preview of any page in the Thumbnail A window.
The full-screen preview is a view-only display, and it takes time to retrieve the data.

TO OPEN A FULL-SCREEN PREVIEW

1.

In Thumbnail A, select a page and click the Full Preview icon at the left of the window.

You can also display full-screen previews by double-clicking the page in Thumbnail A.

Note: If you have edited a job using the thumbnail windows, you must save the edited
file before you can view full-screen previews of all its pages.
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2.

To close the full-screen preview, click the “X” button above the preview.

]

Fiery Spooler

Click to close the
full-screen preview

If scroll bar appears,
click arrows or empty
spaces, or move bar to
scroll up or down

~[4D]

Editing and
The abili k wit

document
covers and ch

ing raster files

If scroll bar appears,
click arrows or empty
spaces, or move bar to
scroll left or right

raster files gives you new opportunities to combine
different sources into a single file. For example, you can combine

er head pages created in a page layout application with text pages

created in a word processing application, or customize a slide presentation by inserting

slides from a different presentation graphics application.

You can display two raster files at once: a source file and a target file. The target file

appears in Thumbnail A, and the source file appears in Thumbnail B.

NoTE: You cannot create a new PostScript file in this process; you must print the

merged file, which has references to the original PostScript files. Before editing or

merging raster files with the thumbnail windows, make sure the source files were

RIPped using the print option settings you want for the final output.
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To VIEW AND EDIT RASTER DATA JOBS

1. Select a raster data job in the RIP area, and choose Thumbnail A from the Job menu.
2. Open the Page menu to see the commands available for pages in Thumbnail A.
You can also access most of these commands by clicking the icons along the left side of
Thumbnail A.
You can use the slider bar at the bottom of the window to scroll through pages in
the job.
E Joh ‘Bighums.pdf' [6 pa
=
Click t full | L
1CK 10 open a Tull-screen =
preview of the page 1 2 3
Click to duplicat
ick to duplicate a page E
Click to delete a page 7 =
Ka :
Delete—D gﬂﬁ\@)ﬁ:ntly selected pages.
Duplicate plicates the currently selected pages.
Preview—Opens a full-screen preview of the currently selected page (see “Displaying
full-screen previews” on page 4-2).
Undo—Reverses the action of recently performed page edits.
3. To move pages within Thumbnail A, click to select the pages and hold down the mouse
button as you drag the selected pages to the new location.
Shift-click to select multiple, sequential pages; Ctrl-click to select multiple,
non-sequential pages.
To move pages to a new position, drag until a blue highlight appears in the desired
position, and then release the mouse button.
If you move the pages on top of existing pages, the pages will be overwritten.
4. When you are finished editing, click the Thumbnail A tab.

If you have edited the job, you are prompted to save the job.
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5.

Enter a new name and click OK.

The new file is now located in the RIP area, ready to print. If you saved the edited file
with a new name, the original source file remains held in the RIP area.

TOo MERGE TWO RASTER DATA JOBS

1.

In Thumbnail A, display the job you want to edit.
The file must be a held raster data job in the RIP area.

In Thumbnail B, display another held raster job from the RIP area.

The Thumbnail B tab opens a second thumbnail view, which cannot be edited but can

be used as a source for pages added ?ﬂi\e document in Thumbnail A.

Note: To merge documents, the pagé sizes of the source document and the target
document must be the same. (B\ diting or merging raster files with the thumbnail
I\i\les

windows, make sure the source, RIPped using the print option settings for the

final output. \\
p \)

In Thumbnail B, k-to select'the pages and hold down the mouse button as you drag
the selected

g@ e new location in Thumbnail A.
Shift-click to"select mu

non-seque pages.

tiple, sequential pages; Ctrl-click to select multiple,

To scroll through the pages in Thumbnail A and Thumbnail B, you can drag the slider
bar at the bottom of the screen, click the empty area to the left or right of the slider bar,
or click the arrows.

To replace pages, drag Thumbnail B pages on top of pages in Thumbnail A. To add
pages, drag the pages to a new position in Thumbnail A; a blue highlight appears in the
new position when the pages are ready to be added.
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Thumbnail B

Job ‘BigLetts.pdf' [7 page(s)

Page 1 copied from the
document in Thumbnail B

create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the
Thumbnail A job, such as the document and user name.

To close a thumbnail window, click the same tab you used to open it (the Thumbnail A
or Thumbnail B tab).

If you have edited Thumbnail A, you are prompted to save the job.

Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print, together with the original
source and target files.

Note: When multiple users are connected to the Fiery EX3535 via Command
WorkStation, Command WorkStation LE, or Fiery Spooler, and one user makes
changes to a Thumbnail A job, not all users may see the results of those changes. If you
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are unable to view changes in a job, or if selecting a thumbnail window results in a
message indicating zero pages, close and restart Command WorkStation, Command
WorkStation LE, or Fiery Spooler.

Using the Job Log

From Fiery Spooler, you can view and print a log of all jobs printed by the
Fiery EX3535, including jobs downloaded with Fiery Downloader.

Note: If you logged in as Administrator, you can delete the Job Log from Fiery Spooler
(see page 7-20). The Job Log is not available if you logged in as Guest.

TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE/E RT THE JOB LOG

1. Choose Show Job Log from the Fiery'Spooler Window menu.

2. Select All or specify a date ra
A

Job Log Range

SelectJob Log Range

& Al

() Date Month  Day Year

rom  f] [io ] for ] [« |
e

3. Click OK.

The Job Log appears in a new browser window.

Note: The Delete button appears only if you logged in as Administrator.
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Update
Print
O==—————FierySpooler
Delete
Export
tah Dono el el Date tal =} d =} Proce!
OK Startup Operator 08A103 17:56:32 110312 170640 289
OK Configuration Operator 08A303 122222 122241 0000189 12
OK Microsoit Word - p2 doc jzhao 08A303 12:40:13 12:4022 00:00.02 394
OK Configuration Operator 08A303 141230 14:12.35 000005 129
OK Printer Test Page ying 08A303 141420 14:1424 000001 GOH

il KD Z

2 ( h job and information about the job, including status,

, user name, date, start time, end time, process time, page description

language, file size, device, paper size, media, number of originals, total number of
guag pap g
pages, and Notes.

The Status column provides the following information about jobs:
OK The job printed normally.
ERROR An error occurred during processing or printing,

CANCEL The job was canceled before printing was completed.

To update the Job Log, click the Update button.

To print the Job Log, choose Print Job Log from the File menu or click the
Print button.

The information displayed in the Job Log window prints to the current Fiery EX3535.
When you print the Job Log, totals are printed for all appropriate columns.
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6. If you logged in as Administrator, you can choose Delete Job Log from the File menu
or click the Delete button to clear the Job Log.

7. To save the Job Log, choose Export Job Log from the File menu or click the Export
button.

8. In the File name area, enter a name for the Job Log.

9. Browse to the location where you want to save the file, and click Save.
The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are
separated by tabs.

To return to the job list, choose ShowJob List from the Window menu.

Connecting to a different Fiery EX3535 from
Fiery Spooler

With Fiery Spooler, you can\connect to a different Fiery EX3535 using the following
procedure.

TO CONNECT TO A DIFFERENT FIERY EX3535
1. Choose Open Fiery from the File menu.

2. Select the Fiery EX3535 in the Chooser window.

For information on setting up the connection to the server, see the User Soffware
Installation Guide.

3. Click OK.

The Fiery Spooler main window appears.



8-1 | Introduction to FieryBar

Chapter 8: With the Fiery Advanced Controller Interface kit installed, you can use FieryBar
. . iew Fiery EX3535 status information, start software, set up and restart the
ing FieryBar ro view ety ’ ’
Us g neryba Fiery EX3535, delete stored jobs, cancel active jobs, and log off from Windows. While
most elements in FieryBar have counterparts in Command WorkStation, you can view

current functions on FieryBar when Command WorkStation is not running,.

Note: FieryBar is available as part of the Fiery Advanced Controller Interface kit,
which is an optional upgrade. For more information, contact your authorized
service/support technician.

Introduction to FieryB

FieryBar, located at the top ofit onitopscreen, includes the following:

RIPping area A nting area Activity light
\

N

Click to expand or collapse FieryBar

Message area

Status

FieryBar displays the following status information for the Fiery EX3535:
RIPping area Name of the job currently processing

RIP status area Amount of the job that has processed

v RIPping Printing

) Test Page M Idle 4

Printing area Name of the job currently printing

v RIPping Printing

n [+ ][] 4 Test Page 4

Message area Error messages and other Fiery EX3535 information

~ RIPping Printing

. Idle 4 Test Page 4
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Activity light
The activity light in the upper-right corner of FieryBar indicates current Fiery EX3535
activity. If the light is:

Solid red An error has occurred, causing the Fiery EX3535 to be
disabled. Check the message area for details of the error.

Flashing red An error has occurred, causing printing to be disabled, but
the Fiery EX3535 is capable of processing. Check the

message area for details of the error.
Solid green The Fiery EX3535 is idle.

Flashing green The Fiery EX3535 is processing or printing a job, or
communicating a remote computer. Check the RIPping
area, the RIP status area, and the printing area for details.

No light The Fie % is.starting up.

Commands
Right-clicking FieryBar or the Fiery icon in the Windows taskbar enables you to access
many Fiery EX @ tures. You can choose the following commands from the menu

that appez

Command kStation Starts Command WorkStation. For more information
on connecting to and using the features of Command
WorkStation, see Chapters 2 and 3.

ColorWise Pro Tools Starts ColorWise Pro Tools. For more information on
connecting to and using the features of ColorWise Pro
Tools, see the User Software Installation Guide and the
Color Guide.

Setup Fiery Opens the Fiery EX3535 Setup dialog box.
For more information about the Setup options, see

the Configuration Guide.

Scan Scan documents directly to Fiery Scan™ from the
copier glass or Automatic Document Feeder (ADF).
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Restart Fiery Shuts down all Fiery EX3535 activity in the correct
manner before restarting. Use this option instead of
the power switch on the back of the Fiery EX3535 (see
“Starting and shutting down the Fiery EX3535” on
page 8-5).

Clear Server Clears all jobs in all server queues, all jobs archived on
the Fiery EX3535 hard disk, all FreeForm masters,
index of FreeForm masters (in the FreeForm window),
and the index of archived jobs (in the Archive
window). Consult your administrator before choosing
Clear Server.

Cancel Processing Cancels t b currently processing on the
Fiery E
Cancel Print C job’currently printing on the
iery EX3535.
Suspend Print spends communication between the Fiery EX3535

and the copier. You must suspend printing if you want
to interrupt the current Fiery EX3535 job so you can
use the copier to make copies or print another job first.
Jobs continue to process on the Fiery EX3535. After
you make the copies, choose Resume Print to continue
printing jobs from the Fiery EX3535.

Resume Print Resumes communication between the copier and the
Fiery EX3535 after you have finished making copies or
printing other jobs.

Run Diagnostics

e Test Email Sends a test e-mail to the system administrator’s
account specified during Setup. Check the e-mail log
to verify that the e-mail was sent successfully. The
E-mail printing feature must be enabled in Setup
before this option can be used.

Log Off Windows Closes all open programs, enabling you to log on as a
different user.
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Hide FieryBar

Hides FieryBar. To show FieryBar after hiding it,
right-click the Fiery icon on the right side of the
Windows taskbar and choose Show FieryBar from the
menu that appears.
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Starting and shutting down the Fiery EX3535

Generally, you can leave the Fiery EX3535 running all the time. This section describes
how to shut down and restart the Fiery EX3535 when necessary.

To START THE FIERY EX3535

1.

Press the power button on the front of the Fiery EX3535. If the copier is also turned
off, turn it on before turning on the Fiery EX3535.

At the Log On to Windows prompt on the monitor, keep Administrator in the user
name field, enter Fiery.1 in the password field, and press Enter.

Allow FieryBar to appear and reach Idle on the monitor.

When FieryBar displays Idle, you can enter Fiery EX3535 Setup by right-clicking
FieryBar and choosing Set Up\Fiery from the menu that appears.

The Setup dialog box includes. the following tabs:

Click To do this
General Setup Configure the General Setup options.
Network Setup Configure the Network Setup options.
Printer Setup Configure the Printer Setup options.

For information about the Setup options, see the Configuration Guide.

Restarting the Fiery EX3535

Use the following procedure to restart the Fiery EX3535 rather than using the power
button on the front of the Fiery EX3535.
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To RESTART THE FIERY EX3535

1.

Make sure the Fiery EX3535 is not receiving, processing, or printing a job.

Make sure that both the RIPping and Printing areas on FieryBar read Idle.

NoTEe: If a job from the Print queue is processing, it will continue processing and print
after the Fiery EX3535 is restarted; if a job sent to the Direct connection is processing,
it will not finish processing or printing.

Right-click FieryBar and choose Restart Fiery from the menu that appears.

A Warning dialog box appears.

Click OK to restart the Fiery EX3535.
Allow the Fiery EX3535 to start upt

At the Log On to Windows prompt on-the monitor, keep Administrator in the user
name field, enter Fiery.1 in'the password field, and press Enter.

Allow FieryBar to appear and reach Idle on the monitor.

Shutting down the Fiery EX3535

You mayeed to shurdown the Fiery EX3535 for service. When you do so, fonts that
have been downloaded to the hard disk are not deleted. Print jobs in the Hold and
Printed queues‘and jobs that have been processed but not printed are not deleted and
are available for printing when you restart the Fiery EX3535.

To SHUT DOWN THE FIERY EX3535

1.

Make sure the Fiery EX3535 is not receiving, processing, or printing a job.

Make sure that both the RIPping and Printing areas on FieryBar read Idle. If a job
has just finished processing or printing, wait at least five seconds after the RIPping and
Printing areas switch to Idle before proceeding to the next step.

Note: If a job from the Print queue is processing, it will continue processing and print
after the Fiery EX3535 is restarted; if a job sent to the Direct connection is processing,
it will not finish processing or printing,.
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2. Click Start on the Windows taskbar, and then choose Shut Down.

3. Select Shut Down and click Yes.
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Appendix A: This chapter introduces the basic concepts of imposition and can be used as an

Basics of
Imposition

introductory tutorial for imposing a document that will be printed as a book or
booklet. For more detailed information on the Imposition main window and its
components, see Chapters 5 and 6.

Printing books with the Imposition feature of
DocBuilder Pro

This section describes the process of transforming an application-specific file into a

bound book; along the way, conce% terminology are introduced to help you take

advantage of all the features of Do er Pro.
I\
A /) (4 .
Printers and copiers that 1mage\ ents on standard Letter- or Legal-sized paper at

high speeds are common/i fﬁcc environments. Although the image quality and
output efficiency of such'd vl\ces \is adequate for correspondence and office memos,
s with' mplex document layouts, or those that require higher

/e}umber of copies.

they cannot ima;

resolution or

Until recen e only way around these limitations was to use traditional printing

systems to impose your document—that is, to arrange its pages in the correct order
and orientation for printing and a variety of binding styles. You might have used a
service bureau to access high-volume, high-resolution color printers. However,
DocBuilder Pro, teamed with digital color copiers, now makes it cost-effective to

produce short-run, fully-imposed (also called “ganged-up”) documents.

Basics of imposition layout

Commercial offset printers and web presses use wide rolls of paper and large printing
plates capable of imaging numerous pages on a single sheet. For example, it is common
for such printers to image up to 32 full-size pages on a single press sheet, a process
inherently faster than printing a single page at a time. DocBuilder Pro allows you to
image multiple pages on a single sheet, but the output devices it supports are digital
color copiers, rather than traditional printing presses. In this manual, the paper on
which a job is imaged is referred to as the sheet.
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The printed sheet is folded into something resembling a booklet with connected pages.
The folded sheet, called a signature, is then trimmed to the finished size.

For pages to appear in normal reading order and position in the final booklet, their
ordering and positioning on the sheet must differ from the normal book-reading order.
You can demonstrate this for yourself using an ordinary sheet of paper.

To MODEL AN EIGHT-PAGE BOOKLET

1.

Fold the paper in half horizontally.

Fold the top edge of the sheet down to meet the bottom edge.
/N

,,,,,,,,,,,,,,,

Fold the pa @ ically.

Fold the e of the sheet over to the right edge. Now you have a miniature version
of a signatur




A-3 | Basics of Imposition

3. Position the signature with the vertically folded edge to the left and the horizontally
folded edges across the top.

The paper should now resemble a small eight-page booklet (with the tops of pages
joined at the fold).

4. Page through the booklet as if you were reading it, and number each page
sequentially.

Number the front and back of eac in general, books have content on both
sides of each page. The front co f the booklet should be page 1 and the back cover
of the booklet should be page\8."You can also underline each number to highlight the

page orientation.

Note: Printing on both sides of the sheet is called duplex printing; printing on only
one side of the sheet.is called simplex printing. Not all copiers support duplex printing;
and of those taiations in implementation exist. DocBuilder Pro supports

hat corresponds to the print options of the output device.

When you unfsld the signature, the page numbering should look something like the
following illustration.

L8 L\ ¢

A\ 9 S\ 3

Front Back
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Notice that:
* The folds subdivide the sheet into areas representing pages in the final booklet.
* Page numbers do not appear in book-reading order.

* Some page numbers are upside down.

Some pages must be printed upside down on the sheet in order for them to appear
right-side up in the final booklet, and pages must also be printed out of numerical
sequence on the sheet in order for them to appear in numerical sequence in the final

booklet.

This process of folding paper and nu

ring pages to approximate the finished piece
is called making a folding model, andit\is a common first step in planning a print job.
ation about page placement, which you

The folding model provides val e infa
can use to create a plan, or sketch, of how pages are placed on the sheet. This plan is
called a layout.

ree O

2

the source file to be imposed and specify how many rows and

DocBuilder Pro
physical mo

you simply op
columns o es to image on a sheet. DocBuilder Pro simplifies this process even

u from the tedious and error-prone process of creating accurate

posed book in order to lay out pages. With DocBuilder Pro,

further by providing predefined layouts for common impositions such as booklets and
brochures. You can also save your own custom layouts for easy reuse.

Printer’'s marks

In addition to specifying the placement of pages on a sheet, the layout also specifies
how the finished sheet will be cut and folded. For example, the layout specifies whether
the large finished sheet is folded and cut to create a booklet, or simply folded (and not
cut) like a map.
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A DocBuilder Pro layout designates the location of folds, cuts, and other elements by
means of markings called printer’s marks, which appear on the printed sheet outside
the main content area of the job.

* The job label comprises descriptive text such as the name of the job, a sheet
identifier, and the date and time the sheet was printed.

¢ The location of a fold is defined by a dotted line called a fold mark; similarly, the
location of a cut is defined by a solid line called a trim mark.

* Specialized marks also define the size and locations of margins (space surrounding
the page’s content area), gutters (space between pages), and bleeds (extensions of
content beyond a trim mark; used to ensure that the printed area extends to the very
edge of a trimmed page).

DocBuilder Pro makes it easy tm ers and specify a set of printer’s marks to
0

image on the finished s%% in the following illustration.
pd

Thursday, February 20, 2003,14:00:01 PM
\

Job label

Trim marks ‘

Fold mark

Gutter

Margin
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Additional sheets

A book layout must also adjust the placement of pages according to the total number
of pages in the job. For example, a book is often composed of more pages than can be
printed on a single sheet. When the number of pages in the book is a multiple of the

number of pages on a sheet, the same layout plan is used to place pages on additional
sheets, until all of the pages in the book are printed. However, if the total page count is
not an even multiple of the number of pages in the layout, one signature may be laid

out to accommodate the discrepancy.

For example, if your layout places 8 pages on a sheet and the total page count in the
book is 12, one of its signatures holds only 4 content pages, with the rest of the space
on the sheet blank. If you do not wangblank pages in the middle of the finished book,
insert blank pages intentionally, foriexample after the cover page, after the table of
contents, or between chapters, To insert k pages, open the job in the Thumbnail A
window, right-click the page want.to add the blank to (or pull down the Page
menu), and select Insert blank page.

DocBuilder Pro allow
multiple source

ou toddd blank pages or add, delete, and rearrange pages from
ents easily, so you can quickly preview the results of page
manipulations,
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Binding methods

A book layout also specifies the means by which sheets are gathered and bound.
Stitching or stapling finished pages across a common center fold, or spine, is called
saddle stitch binding, and the stitched pages are called a saddle. Multiple folded sheets
can be stitched into the same saddle as a group. Stacking signatures, grinding the
spines off, and then gluing them together is called perfect binding. You can combine
saddle stitch and perfect binding methods by stacking two or more groups one on top
of another on a common fold line and gluing them together; this is called a nested

saddle.

Saddle @ Perfect Nested Saddle

The bindi ethod you use affects the order in which pages are placed on the sheet;
for example, the’page ordering used to perfect bind a book must be different from that
used to saddle stitch the same job. Thus, your layout must specify the method by
which the finished job will be bound.

The choice of a binding method is determined by the job’s size, complexity, and
budget. Saddle stitch binding is very cost-efficient, but is more suitable for small
booklets than for large jobs. (A rule of thumb is that saddle stitch binding works best
for booklets or brochures with a maximum of 88 pages.) Conversely, perfect binding is
more expensive but more suitable for larger jobs.
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DocBuilder Pro reorders imposed pages automatically according to your choice of
binding method, which can save a significant amount of time and effort. Consider, for
example, what must be done when a book that was to be saddle stitched exceeds the
bindery’s maximum page count and must be reimposed as a perfect-bound book. To
redo the imposition by traditional means would be labor-intensive; with

DocBuilder Pro, it takes only moments.

Shingling and creep

All books and brochures use a sheet that is folded to create separate page areas. Because
the sheet itself has some thickness, each fold causes a very small incremental shift in the
location of the edge of each page relative to the others. The result is that the edges of
pages furthest from the saddle’s innermost fold seem to move away from the edges of

pages closest to the innermost fold.As the number of pages in the saddle increases, so

does the amount of this shift, w n as shingling. To counteract the effects of

shingling (illustrated in an exa d manner in the following figure), the bindery

trims the edges of the finished

goCra

book t6'a common edge.

Shingling

Trimming the bound pages resolves only half of the problem, however—as the edges of
pages move, so do the content areas imaged on them. The apparent shift of content
area caused by folding a sheet multiple times is known as creep or binder’s creep.

The effect of creep is that the content area of pages closer to the innermost fold in a
saddle appear to move towards the outer margins of the page.
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Creep becomes more noticeable as the number of groups in a saddle increases, and its
effect is most noticeable on pages farthest from the center fold of the saddle.
Consequently, a book layout must also specify the number of groups in each saddle
because the number of groups in each saddle affects the amount of creep that needs to
be accounted for.

Creep

N

is tedious, exacting work that DocBuilder Pro does for you

change any aspect of the imposed job that is affected by creep.

Layout is essential for defining the elements of complex print jobs such as booklets and
books, but it can also be useful for smaller jobs. Consider, for example, how you might
approach the task of printing business cards. It is slow, wasteful, and expensive to print
a single business card per sheet, when you can repeat the image of the business card
until the entire sheet is filled. This printing technique is known as Gang Up Repeat
because the image is repeated in each page area, or step, on the sheet. After printing,
the sheet is cut apart to produce individual cards.

Gang Up Repeat layout
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This job can be made even more efficient by eliminating the gutters between cards,
allowing you to reduce significantly the number of cuts required to separate each card
from its neighbor. Defining zero-width gutters on a shared cut line in this manner is
called using a common blade for those cuts.

If you need to print business cards for several different clients, you could perform a
Gang Up Repeat printing job for each, but you might still wind up wasting paper
and time if the jobs do not fit easily into a simple multiple of sheets. A more efficient
approach is to print several jobs on a single sheet, and then print that sheet as many
times as required. The technique of printing multiple jobs on the same sheet is known
as Gang Up Unique. DocBuilder Pro provides both Gang Up Repeat and Gang Up
Unique.

F The Marble Group F The Marbte Group

Gang Up Unique layout
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Appendix B: This appendix gives descriptions of the built-in templates provided with
Templates DocBuilder Pro.

1-Up Full Bleed

The 1-Up Full Bleed layout is used to print one page per sheet. The printer’s marks
indicate where to cut the paper so that the color content extends to the edge of the

paper.
The following settings are applied for this layout:
* Bleeds

¢ Printer’s Marks (trim mark %abel only)
* Scale to Fit

* Gang Up Uni

Builder

Scale

Firishing Suface10f30 | Fit Page el | [0

Note: There are no page number restrictions for the 1-Up Full Bleed layout.
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2-Up Perfect

The 2-Up Perfect layout is used to create signatures for a perfect bound book.
Each sheet is folded once and stacked on top of one another. For more information
on binding methods, see page A-7.

The following settings are applied for this layout:

* Duplex

* Bleeds

* Printer’s Marks (fold marks, trim marks, and job label)

¢ Scale to Fit

* Binding Perfect

on - Arithmetic.pdF

Builder

Finishing Suface2of16 | FitPage « |
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The 2-Up Perfect layout should be used with jobs that have multiples of four pages,
but it can be used with jobs that have any number of pages. Additional blank pages will
be added if necessary. Pages will be ordered in groups of four so that when folded each
sheet has four sequential pages. For example:

* 4 pages
4 1 2 3
Sheet 1, Sheet 1,
front side back side
* 8 pages ﬂ
4 1 2 3 8 5 6 7
Sheet 1, Sheet \V Sheet 2, Sheet 2,
front side back si front side back side
NoTe: The Cree s tment option has no effect on this template.
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2-Up Saddle
The 2-Up Saddle layout is used to create sheets for a saddle bound book. All of

the sheets are folded together, one inside the other. For more information on binding
methods, see page A-7.

The following settings are applied for this layout:

* Duplex

* Bleeds

* Printer’s Marks (fold marks, trim marks, and job label)
* Scale to Fit

* Binding Saddle

on - Arithmetic.pdF

Builder

1

Finishing Suface2of16 | FitPage « |
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The 2-Up Saddle layout should be used with jobs that have multiples of four pages,
but it can be used with jobs that have any number of pages. Additional blank pages will
be added if necessary. Pages will be ordered so that when sheets are folded and stitched
together, the pages will be sequential. For example:

* 4 pages
4 1 2 3
Sheet 1, Sheet 1,
front side back side
* 8 pages
8 1 2 7 6 3 4 5
Sheet 1, Sl% Sheet 2, Sheet 2,

front side back si front side back side
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3-Up Trifold Brochure

The 3-Up Trifold Brochure layout consists of a single sheet folded into three sections.
Although the three sections are the same width, the space between each section varies
so that the leftmost panel can be folded over the other two panels.

The following settings are applied for this layout:
* Duplex
* Printer’s Marks (fold marks, trim marks and job label only)

¢ Scale to Fit

* Gang Up Unique

Builder

Firisking Sulace2of2 | FiPege ‘ 1]
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The 3-Up Trifold Brochure layout can be used only with jobs that have six pages. If the
job contains more or less than six pages, an error message appears. The pages will be

ordered as follows:

3 6 1 2 4 5
Sheet 1, Sheet 1,
front side back side

The 3-Up Trifold Brochure is usually folded as shown in the following illustration.

N
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4-Up Gate Fold

The 4-Up Gate Fold layout is used most often in the case of a four-panel brochure.
The finished brochure unfolds to double, then four times the original size.

The following settings are applied for this layout:

* Duplex

e Printer’s Marks (fold marks, trim marks and job label only)
* Scale to Fit

* Gang Up Unique

Arithmetic.pdf

Builder

Finishing Suface1of2 | Fit Page 4] i
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The 4-Up Gate Fold layout can be used only with jobs that have eight pages. If the job
contains more or less than eight pages, an error message appears. The pages will be
ordered as follows:

3 8 1 2 4 5 6 7
Sheet 1, Sheet 1,
front side back side

The 4-Up Gate Fold is usually folded as shown in the following illustration.

N
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4-Up Head to Head

The 4-Up Head to Head layout is used to create booklets from a layout of four pages
on each side of the printed sheet. By rotating the two topmost pages, the signature can
be folded both horizontally and vertically, and trimmed. The finished booklet will have
all pages in the correct order and rotation.

The following settings are applied for this layout:
* Duplex

¢ Bleeds

* Printer’s Marks (fold marks, trim marks, and job label)

¢ Scale to Fit
Binding Saddle

Builder

Finishing Sufacelof2 | FiPage ‘ |
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The 4-Up Head to Head layout should be used with jobs that have multiples of eight
pages, but it can be used with jobs that have any number of pages. Additional blank
pages will be added if necessary. Pages will be ordered so that when sheets are folded
with two folds at 90 degrees, trimmed, and stitched together into signatures, the pages
will be sequential. Note that although this layout requires two folds, the template
applies a fold mark on the spine fold only. For example:

¢ 8 pages
9 14 ¢ 9
8 1 2 7
Sheet 1, Sheet 1,
front side back side
* 16 pages
6 8 L | o1 | 9 ¢ |al
16 1 2 15 14 3 4 13
Sheet 1, Sheet 1, Sheet 2, Sheet 2,
front side back side front side back side

The 4-Up Head to Head is usually folded as shown in the following illustration.
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4-Up Z-Fold

The 4-Up Z-Fold layout allows many panels to be folded on top of one another
without stressing the folded spine. The most common example is a road map.

The following settings are applied for this layout:

* Duplex

e Printer’s Marks (fold marks, trim marks and job label only)
* Scale to Fit

* Gang Up Unique

Arithmetic.pdf

Builder

Finishing Suface1of2 | Fit Page 4] |
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The 4-Up Z-Fold layout is used only for jobs that have eight pages. If the job contains
more or less than eight pages, an error message appears. The pages will be ordered as

follows:

2 3 4 5 6 7 8 1
Sheet 1, Sheet 1,
front side back side

The 4-Up Z-Fold is usually folded as shown in the following illustration.

N







Appendix A:
Troubleshooting
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This appendix describes error messages you might see, and provides some
troubleshooting guidelines should a problem arise with the Fiery EX3535, Command
WorkStation LE, or Command WorkStation. If you are unable to resolve a problem

after referring to this chapter, contact your authorized service/support center.

Error messages

Error messages can result from problems with the job, the Fiery EX3535, Command
WorkStation, Command WorkStation LE, Fiery Spooler, or the copier. When an error
interferes with printing, you will see a message in the Activity Monitor of Command
WorkStation or Command Work$ LE. The status bar that displays the message
indicates the process in which the-error occurred.

An error message for the Fiery 535 sometimes remains displayed on Command
WorkStation or Command

might be a brief de

orkStation LE even after you resolve the error. There

while the Fiery EX3535 communicates the resolution of the
error to the app Printing will resume and the Command WorkStation or

plication.
Command "’7.' LE window will be updated after a short delay.

r a Fiery EX3535 message alerting you to check the power and cable,
there may be a problem with the copier power or cable connection. Check to make
sure the copier is turned on. Make sure the cable connection between the

Fiery EX3535 and the copier has not come loose. The Fiery EX3535 will resume
printing when the cable is securely connected to both the Fiery EX3535 and the
coplier.

For information on resolving copier-related errors, refer to the copier documentation.
You can cancel the pending print job while you attend to a given error condition.
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Troubleshooting

Before you call for service, follow the suggestions in this section. If you are unable to
resolve the problem, make a note of the error condition and contact your authorized
service/support center.

Command WorkStation or Command WorkStation LE does not
respond

If the Command WorkStation or Command WorkStation LE windows do not update,
log off and then quit Command WorkStation or Command WorkStation LE. Restart
Command WorkStation or Command WorkStation LE, or restart the computer. To
force an exit from Command WorkStation, press Ctrl-Alt-Delete, and use the Task

Manager to close Command Work%\g\n.

If the Command WorkStatio@%mgd WorkStation LE windows do not update,
. . \ .
or no jobs are displayed, and the mouse has no effect (you cannot select a job or a
m\\ﬁﬁnd, or select a menu item), the Fiery EX3535 is
tion has failed.

window, use a right motsé

down or network communict

At the Fiery EX3 sconnect and reconnect the network cable, and try printing a
ation page. If that fails, restart the server.

If the Fiery EX3535 Control Panel does not respond to the Menu button, turn off and
on the Fiery EX3535. When the Fiery EX3535 reaches Idle, restart your job
management application.
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Unexpected printing results

If this happens

This is the problem

The job settings are not

carried out as you expected.

If the user printed from Apple Mac OS, there may be two
conflicting print settings. You can check the job properties by
double-clicking the job. For a table of job properties and
conflicting properties, see the Printing Guide. Notify users of
these conflicts so they can avoid them in the future.

If you expected the settings you see in the Properties window,
be aware that the Copies field does not currently reflect user
settings, and that Page Range and Scale percent are All and
100%, respectively, unless they were changed after being sent

for prin%
A

The job does not print.

A

Some %t'n errors may be displayed in the Print status bar.
he job is in the Printed queue, jobs that had a

stScript.error are displayed in a light red job row.
ble-click anywhere in the row to see the error message.

There are font errors.

\\\é user-specified fonts that are not resident on the

iery EX3535 are not printing correctly in PostScript files
that are downloaded by users, request that they embed the
fonts in the PostScript file or print directly from their
application. If special fonts are not downloaded automatically
when users print from applications, the fonts should be
downloaded directly to the Fiery EX3535 with Fiery
Downloader. This can be done by the user or the operator,
provided the Direct connection is enabled. For information

about Fiery Downloader, see the Printing Guide.
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Clearing the server

Clearing the server is an Administrator option that can be used as a last resort if a job
persists in the system and prevents printing despite attempts to cancel or delete it.
Clear the server if all other troubleshooting methods have failed.

You can clear the server from the Control Panel (see the Configuration Guide) or by
using the Server> Clear Server command in Command WorkStation or the
Server> Clear Server command in Command WorkStation LE.

Users are unable to connect to the Fiery EX3535

If users are unable to connect to the Fiery EX3535, or are unable to find the
Fiery EX3535 from their workstatio e network administrator may need to

troubleshoot their network connections, and check settings on the servers they use for
printing. If settings have cha ay'be necessary to reconfigure the
Fiery EX3535. K

For example, if print servers‘or print queues on a Novell server are renamed or deleted,
issions are changed, the Fiery EX3535 administrator may have

to edit setti new settings in IPX (Novell) Setup to reflect the new

configuratien

If users cannot connect to the Fiery EX3535 with Fiery Downloader from a Windows
client computer, you may need to reconfigure the utility’s connection to the server. For
details, see the User Software Installation Guide.

Mac OS users may be unable to connect to the Fiery EX3535 if a network
administrator has assigned it to a different zone, or has added zones where previously

there were none.

If you have configured the Fiery EX3535 and set up client computers and network
servers according to guidelines in the Configuration Guide and the User Software
Installation Guide, try printing a Test Page (in Command WorkStation or Command
WorkStation LE, choose Print Pages from the Server menu).

If you can print the Test Page but still cannot print a document from a remote
computer, contact the system administrator to troubleshoot the network connection.
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If you are unable to connect, and you cannoz print the Test Page, check the copier’s

touch panel display.
If this happens Try this

The copier is not in The copier’s Automatic Power-Off function may have shut

Standby mode. down the copier.
Turn the copier on, and then try printing a Test Page again
when the copier has warmed up.

You still cannot print a Make a copy. If you can make a copy, restart the

Test Page. Fiery EX3535, and when you see Idle on the status line of the
Fiery EX3535 display, try printing a Test Page again. If the
Test Pagestill fails to print, contact your authorized service/
support € \ﬁt\:r.

( \ N\
A ) 4
Setup error messages ‘ \
For information on Set rtor\\\m\n\essages, see the Configuration Guide.

V

\

\

me \sagé%

ges can result from problems during the AutoCal procedure. If

AutoCal err
AutoCal™ r

i

you enc the errors listed in the following table, correct the condition
associated the error, and then retry the AutoCal procedure.
Fiery EX3 . . .
ery EX3535 Additional information
message
Error 5 The calibration file cannot be opened.
Error 6 The calibration file was not read correctly.
Error 8 The measurement page did not scan propetly, either because it is
crooked or the data is corrupted.
Error 11 The color strips on the measurement page are inconsistent.
Error 12 The copier model being used is not supported.
Error 20 The measurement page cannot be scanned because the dots per inch
(dpi) are incorrect.
Error 102 The grayscale strip is crooked or positioned incorrectly.
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Fiery EX3535 Additional information
message
Error 103 The grayscale strip is positioned too far to the left or right of the
measurement page.
Error 104 The grayscale strip is positioned too far above the measurement page.
Error 111 The grayscale strip could not be found; either reposition the strip
correctly or position it vertically.




A
Acrobat 6-21
Action buttons 2-12, 3-13
Active Jobs window 2-4, 3-6
job ticket information 3-8
printing job list 2-29
activity light
FieryBar 8-2
Activity monitor 2-8
All Servers view 2-9
Selected Server view 2-9
activity states, defined 2-11

Administrator password 3-5
aligning pages 6-12

aligning trays 2-32
applying templates 5-10
Archive command 2

archive log 2-29
Archive pan
Autologin

B
binder’s creep
adjusting 6-5
compensating for automatically 6-14
effects A-8
groups 6-15
sheet thickness 6-5
binding offset 6-26
binding options 6-14
binding styles
nested saddle 6-15, A-7
perfect 6-15, A-7
saddle stitch 6-14, A-7
bleeds A-5
setting 6-10

C

Cancel Printing command

from Command WorkStation 3-19

from Fiery WebSpooler 7-5
on FieryBar 8-3
Cancel Processing command 3-18

Cancel RIP command, on FieryBar 8-3

Cancel RIPping command
from Fiery WebSpooler 7-5
chapters, forcing 3-21
Clear command
archived jobs C-4
Clear Server command
on FieryBar 8-3
clipping icon 6-6, 6-12
clipping indicators
Layout mode 6-12
Preview mode 6-12
clipping views 6-12
collate and cut finishing 6-15
Color Charts 2-29
color preview 4-4
color profile 4-4
ColorWise Pro Tools command, on
FieryBar 8-2
columns
scaling 6-11
setting 6-6
command menus, see menus
Command WorkStation
command on FieryBar 8-2
layout styles 2-13
logging in 3-2
logging out 3-6
menus 2-15
overview 1-9
preferences 2-30
user interface, customizing 2-13
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user interface, explained 2-2, 2-3

windows 2-2, 2-3
Command WorkStation LE

logging in 3-2

logging out 3-6

menus 2-15

overview 1-9

preferences 2-31

troubleshooting C-2

user interface, explained 2-3

windows 2-3
communicating print requirements 1-5
Configuration page 2-29
context-sensitive menus 2-25
Control Panel

canceling jobs 3-19
Control Panel map 2-29
copiers/printers and duple ting\ A-3
Create Master option 3-22 t0\3+23
creep, see binder’s cree

custom template
limitati

D
date 6-8
Define Marks dialog box 6-8
Delete command 4-6, 7-15
Delete Job command (Fiery
WebSpooler) 7-5
Delete Template icon 6-26
Direct
connection 1-2, 2-34, 3-11, 3-12, C-3
Direct queue 1-2, 2-34, 3-11, 3-12
DocBuilder Pro 3-27
duplex printing
copiers/printers A-3
defined A-3
enabling 6-5
print options A-3
duplexing 6-5
Duplicate (page) command 4-6, 7-15

Duplicate Job command (Fiery
WebSpooler) 7-5

E
editing page content 6-21
Enable Animation preference 2-31
error messages
AutoCal C-5
during Setup C-5

F
Fiery Graphic Arts Package, see Graphic Arts
Package 4-4
Fiery Spooler for Mac OS
differences from Fiery WebSpooler 7-20
Fiery WebSpooler
Cancel Printing command 7-5
Cancel RIPping command 7-5
Delete Job(s) command 7-5
Hold command 7-5
Job menu 7-4
Operator password 7-1
Print and Hold command 7-5
Print command 7-5
Process Next command 7-5
raster data 7-5
Remove Raster command 7-6
Rename command 7-5
RIP and Hold command 7-5
RIPped jobs 7-3
status bars 7-3
Fiery WebTools 1-5
Fiery.1 password 8-5, 8-6
FieryBar
activity light 8-2
commands 8-2
status 8-1
files, temporary 6-26
Find command 3-28
search templates 3-30
templates folder 2-31
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Finishing settings 6-14 defined A-7
Binding 6-14 Guest access 3-5
Gang Up 6-15 gutters

Fit Page command 5-8 defined A-5

Fixed Page mode 5-6, 6-1, 6-11, 6-12 defining size 6-23

Fold Marks 6-8, A-5 location of 6-23

folding model perfect binding 6-23
creating A-2 saddle-stitched binding 6-23
defined A-4

Font Substitution Table 2-34 H

fonts held jobs 7-9
Adobe Type 1 2-34 Hide FieryBar command, on FieryBar 8-4
downloading C-3 Hold command 3-13, 7-5
managing 2-34 to 2-37 Hold queue 1-2, 3-10, 3-12

printer fonts on server 2-37

printing font list 2-29 I
TrueType 2-34 feons
clipping 6-6, 6-12

FreeForm

Delete Template 6-26
Print area 7-10
RIP area 7-9
Save Template 6-25
Spool area 7-8

Create Master option “3-22 to 3x23
creating masters—3-22 to 3-

overridi

printi data documents 3-22 ] TS
Use Mas tion 3-22 importing jobs 3-10

FreeForm panel“2-7 imposing jobs 5-3

FTP Log 2-29 imposition
data and temporary files 6-27

G page reordering 6-18

gang printing saving 6-27
enabling 6-15, 6-16 saving settings as template 6-25
Repeat option 6-16 settings 6-25
suggested uses 6-15 templates folder 2-31
Unique option 6-16 Imposition Template Path preference 2-31
Unique-Collate Cut option 6-17 imposition window

Gang Up Repeat A-9 clipping indicator 6-12

Gang Up Unique A-10 controls 6-3

General Setup option 8-5 Finishing settings 6-14

Go To Surface dialog box 5-10 Fixed Page mode 5-6

Graphic Arts Package 4-4 Layout mode 5-7

group Mixed Page mode 5-6
binder’s creep 6-15 navigating 5-5, 5-6
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opening 5-3
Orientation menu 6-5
preview mode 5-7
printer’s spread 5-4
reader’s spread 5-4
reordering pages 6-18
rows menu 6-6
Scale settings 6-11
size menu 6-4
template menu 5-10
view modes 5-7
inches, abbreviation and keyboard
shortcut 6-3
Insert blank page command 5-2
Instructions field 1-7, 3-14, 3-15

J
job

N

canceling 3-18
defined xiv

limit 7-10

monitoring 3-6

overrides 3-14, 7-6

previewing 4-1, 4-2, 4-5, 4-6, 7-12, 7-1
4,7-15

saving imposed 5-11

searching for 3-28

selecting 3-7

sorting 3-7

temporary files 2-31, 6-26

transferring to another server 3-18

job environment

defined 1-1

operator-controlled 1-2

job flow

communicating print requirements 1-5
diagram 1-4

monitoring 3-6
overview 1-2
status indicators 2-11
job icons
Fiery WebSpooler 7-3
Print area 7-10
RIP area 7-9
Spool area 7-8
Job label
date 6-8
defined 6-8, A-5
job name 6-8
sheet information 6-8
time 6-8
Job Log 2-29
displaying 7-18
exporting to a file 3-27
panel 2-8, 3-26
printing on local printer 3-27
using (from Fiery WebSpooler) 7-18
viewing printed jobs 7-4
Job menu commands 7-4
job name 6-8
Job Properties dialog box 3-23
Job status indicators 2-11
job ticket
definition 1-7
job ticket information
customizing 3-8
sorting by 3-7
Jobs window 2-6
job ticket information 3-8

L
layout
bleeds 6-10
defined 6-6, A-4
maximum number of pages 6-6
rows in 6-6
layout mode
characteristics 5-7
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clipping indicators 6-12

defined 5-7

reordering pages 6-18

Zoom tool disabled 5-8
Layout settings

Bleeds 6-10

Columns 6-6

Printer’s Marks 6-7

rows 6-6

layout style, in Command WorkStation 2-13

layout view 6-18

load balancing between servers 3-18

Log Off Windows command, on
FieryBar 8-3

logging in
to Command WorkStation 3-
to Command WorkStation LE\ 3-2

logging out

from Command Wor

from Command LE 3-6
Login Server 2-

removin &
Logon In assword 8-5, 8-6

M

Manage Fonts command 2-34
margins 6-24, A-5
measurement, setting units of 2-31

media type
mixed media 3-21
menus
Command WorkStation 2-15
Job 5-3
Orientation 6-5
Rows 6-6
Size 6-4
Template 5-10
View 5-7, 5-8

merging files 7-16
millimeters 6-3
mixed media 3-21

Mixed Page
mode 5-6, 6-1, 6-8, 6-10, 6-11, 6-12
monitoring jobs 3-6
monitoring servers 2-12
multiple servers
balancing load between 3-18
monitoring 2-12

working with 3-17

N

nested saddle 6-15, A-7
Network Setup option 8-5
newlink PrintPages 2-27

Notes fields 1-6, 1-7, 3-14, 3-15

0
offsetting pages 6-12

Operator password 3-5, 7-1

operator-controlled environment
setting up 1-2

orientation, setting 6-5

Override Print Settings command 7-6

overriding print settings 3-14

P

page
aligning on sheet 6-12
Fixed Page mode 6-1, 6-11, 6-12
maximum number in layout 6-6
Mixed Page

mode 6-1, 6-8, 6-10, 6-11, 6-12

numbers in layout view 6-18
reordering automatically A-8
reordering on sheet 6-18
rotating 6-22
viewing individual 5-8

page numbers 6-18

password 8-5, 8-6

passwords
Administrator 3-5

for Command WorkStation access 3-5
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for Command WorkStation LE Use Master option 3-22, 3-24
access 3-5 Printed Jobs panel 2-6, 3-6
Operator 3-5, 7-1 Printed queue 7-10
PCL (Printer Control Language) iv-xiv printer (job) icon 7-8
PCL font list 2-29 Printer Control Language (PCL) iv-xiv
PDF data xiv printer fonts, see fonts
perfect binding Printer Setup option 8-5
defined 6-15, A-7 printer’s marks
gutters 6-23 bleeds A-5
permissions 3-5, C-4 customizing 6-9
PitStop 6-21 date 6-8
points 6-3 defining 6-8
PostScript disabling 6-8, 6-9
defined xiv enabling 6-7
icon 7-8 Fold Marks 6-8, A-5
RIP xv gutters A-5
PostScript data xiv job label 6-8, A-5
PostScript font list 2-29 job name 6-8
preferences, for Comman margins A-5

WorkStation 2-30

A\

overview A-5

Preview comma

properties 6-9

preview modé sheet information 6-8

charaé¢ g 5- time 6-8
clippingicon_6-12 Trim Marks 6-8, A-5
defined 5- printer’s spread 5-4
Preview windows 2-12 printing
Delete command 4-6 Active Jobs list 2-29
editing options 4-6 archive log 2-29
previewing color 4-4 Color Charts 2-29
previewing jobs 4-1, 4-2, 4-5, 7-12, 7-14 Configuration page 2-29
Print and Hold command 1-5, 3-13, 7-5 Control Panel map 2-29
Print area 7-3, 7-10 defined xv
Print command 1-5, 3-13, 7-5 error 7-10
print options font list 2-29
mixed media 3-21 FTP Log 2-29
Print Pages command 2-27 in job flow 1-3
Print queue 1-2, 3-10, 3-12 Job Log 2-29
print requirements, communicating 1-5 queues list 2-29
print settings Test Page 2-29
Create Master option 3-22 to 3-23 printing duplex 6-5, A-3

overriding 3-14 problems, see troubleshooting



I-7 | Index

Process and Hold command 1-5, 3-13 layout setting 6-6
Process Next command 7-5 scaling 6-11
processing selecting number in layout 6-6
defined xv Rows menu 6-6
in job flow 1-3 Run Diagnostics command
proofing color 4-4 on FieryBar 8-3
Properties command 3-14, 3-23
PS Test Page 2-29 S
saddle
R defined 6-14, A-7
raster saddle stitch binding
data 7-5,7-9 characteristics of 6-14
icon 7-8 creep 6-5
raster files 1-3 defined A-7
archiving 3-26 groups A-7
editing 7-14 gutters 6-23
icon 3-6 Save As dialog box 5-11
previewing 7-11 Save Template icon 6-25
saving an edited docunfent \7-16,7-17 Scale settings 6-11
status on server_3-13 Alignment and Offsets 6-12
reader’s spread Apply To 6-11
Redo comm: 4 Scale Mode 6-12
remote us scaling selected pages 6-11
Remove Raster command 7-6 Search Template Path preference 2-31
Remove Raster Data command 3-13 searching for jobs 3-28
Rename command 7-5 selecting jobs 3-7
reordering pages Send to server command 3-18
automatically A-8 server
layout mode 6-18 aligning trays 2-32
Restart Fiery command, on FieryBar 8-3 clearing C-4
Resume Print command, on FieryBar 8-3 load balancing 3-18
Resume Printing command 3-19 logging in from Command
right-click menus, see context-sensitive WorkStation 3-2
menus logging in from Command WorkStation
RIP and Hold command 1-5, 7-5 LE 3-2
RIP area 7-9 logging out from Command
RIP, defined xv WorkStation 3-6
RIPped jobs 7-3 logging out from Command
rotating pages 6-22 WorkStation LE 3-6
rows managing multiple servers 3-17

clipping of content area 6-6 monitoring 2-12
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printing information pages 2-27 defined xv
RAM requirements 3-2 in job flow 1-3
restarting 8-5 starting the server 8-5
selecting 2-12 status bars
shutting down 8-6 Print 7-3
working with more than one 3-17 RIP 7-3
server fonts, see fonts Spool 7-3
Set Up Fiery command, on FieryBar 8-2 status indicators, defined 2-11
sheet status, FieryBar 8-1
defined 5-4, A-1 step-and-repeat printing 6-16
number of rows 6-6 surface
orientation 6-5 defined 5-4
reordering pages 6-18 navigating to selected 5-7
size 6-4 slot 6-11
slot 6-11 Surface menu 5-7
thickness 6-5 Suspend Print command, on FieryBar 8-3
viewing by number 5-10
viewing entire 5-8 T
sheet information 6-8 target file 7-14
Sheet settings 6-4 template
applying 5-10
defined 5-10

deleting 6-26
limitations 6-25

saving 6-25
shingling A-8 saving imposition settings 6-25
Show Animations preference 2-32 selecting 5-10
Show Import Options Dialog Template menu 5-10
preference 2-32 temporary files 6-26
signature A-2 temporary folder, for job files 2-31
simplex printing A-3 Temporary path preference 2-31
slot 6-11 Test Page 2-29
soft proofing 4-4 printing C-5
sorting jobs 3-7 problem printing C-4
source file 7-14 Thumbnail A
spine A-7 command 7-6
Spool area 7-8 Delete command 7-15
spooled jobs Duplicate command 7-15
displayed in Fiery WebSpooler 7-4 editing options 7-15
icons 7-8 page commands 7-14

spooling page display 7-12
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window 7-14

Thumbnail B 7-14
command 7-6

time 6-8

Tray Alignment command 2-32

Trim Marks 6-8, A-5

troubleshooting
Command WorkStation hangs C-2
Command WorkStation LE hangs C-2
general guidelines C-2
slow redraw 5-7
unexpected printing results C-3
users are unable to connect to the

printer C-4

U
Undo command 4-6, 7-15

undo, in editing thumbnai s 49, 7-17
Units preference 2-31

units, setting 2-31

Use Master optio

v
variable dat ting 3-22
View menu 5-%, 5-8
view modes

compared 5-7

layout 5-7

preview 5-7
view only (Guest) access 3-5

w
Windows NT
logon 8-5, 8-6

Z

Zoom tool 5-8






	Introduction
	About this manual
	Terminology


	Chapter 1: About�Job Management
	Job environments
	Levels of job control
	Setting up an operator-controlled environment

	Understanding job flow
	Spooling, processing, and printing
	Visualizing job flow

	Communicating with users
	What the operator should check

	Overview of the job management utilities
	Command WorkStation
	Command WorkStation LE
	Fiery Spooler


	Chapter 2: Introduction to�Command WorkStation and�Command WorkStation LE
	The graphical interface
	Active Jobs window
	Jobs window
	Activity Monitor
	Job status indicators
	Action buttons
	Preview windows

	Monitoring single or multiple Fiery�EX3535 servers*
	Customizing the graphical interface
	Using layout styles*
	Showing, hiding, and arranging components

	Using commands
	Menu bar
	Context-sensitive menus

	Preparing to work with Command WorkStation or Command�WorkStation LE
	Connecting to the Fiery�EX3535
	Printing Fiery�EX3535 information pages
	Setting preferences
	Correcting tray alignment*
	Managing Fiery�EX3535 fonts


	Chapter 3: Using Command WorkStation and�Command WorkStation LE
	Starting up and logging in
	Logging in to the Fiery�EX3535
	Access levels
	Logging out
	Removing the Fiery�EX3535 from the server list

	Monitoring jobs
	Selecting jobs
	Sorting job displays
	Customizing job ticket information

	Managing job flow
	Importing jobs
	Using job management commands
	Viewing and overriding print settings
	Reordering jobs*
	Managing jobs on multiple Fiery�EX3535 servers*
	Canceling jobs

	Defining Mixed Media settings*
	Printing Fiery FreeForm variable data documents
	Creating and monitoring FreeForm masters
	Using FreeForm masters with variable data jobs
	Tips for using Fiery FreeForm

	Archiving jobs
	Using the Job Log
	Searching for jobs

	Chapter 4: Previewing and Manipulating Jobs
	Previewing jobs
	Displaying thumbnail previews
	Preview window controls
	Displaying full�screen previews
	Viewing soft proofs

	Editing and merging jobs
	Editing jobs
	Merging jobs


	Chapter 5: Using DocBuilder�Pro
	Previewing, editing, and merging jobs
	Imposition window
	Job previews
	Navigating in the Imposition window
	Switching between page view and layout view
	Setting magnification levels
	Viewing the sheets

	Using templates
	Saving your work

	Chapter 6: Advanced Features of DocBuilder�Pro
	Mixed Page mode and Fixed Page mode
	Imposition settings
	Sheet settings
	Layout settings
	Scale settings
	Finishing settings

	Modifying the layout manually
	Reordering pages in Layout mode
	Adding, duplicating, and deleting sheets
	Editing page content
	Rotating pages
	Setting gutter sizes

	Managing templates
	Tips for using the Imposition feature of DocBuilder�Pro
	Page-level operations
	Saving imposed jobs


	Chapter 7: Fiery�Spooler
	Tracking and managing jobs with Fiery Spooler
	About the Fiery Spooler window
	Manipulating job options and job flow
	Overriding job option settings

	Job icons
	Spool area
	RIP area
	Print area

	Previewing, editing, and merging jobs
	Previewing raster jobs
	Displaying full�screen previews
	Editing and merging raster files
	Using the Job Log

	Connecting to a different Fiery�EX3535 from Fiery�Spooler

	Chapter 8: Using FieryBar
	Introduction to FieryBar
	Status
	Activity light
	Commands

	Starting and shutting down the Fiery�EX3535
	Restarting the Fiery�EX3535
	Shutting down the Fiery�EX3535


	Appendix A: Basics of Imposition
	Printing books with the Imposition feature of DocBuilder�Pro
	Basics of imposition layout
	Printer’s marks
	Additional sheets
	Binding methods
	Gang-Up printing


	Appendix B: Templates
	1-Up Full Bleed
	2-Up Perfect
	2-Up Saddle
	3-Up Trifold Brochure
	4-Up Gate Fold
	4-Up Head to Head
	4-Up Z-Fold

	Appendix A: Troubleshooting
	Error messages
	Troubleshooting
	Command WorkStation or Command WorkStation LE does not respond
	Unexpected printing results
	Clearing the server
	Users are unable to connect to the Fiery�EX3535
	Setup error messages
	AutoCal error messages


	Index

